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Adagio Invoices — License Agreement
The use of Adagio Invoices is governed by the following agreement. You demonstrate your
acceptance of the terms of this agreement by using Adagio Invoices and its associated materials.
You may terminate this agreement at any time by sending a letter to Softrak Systems Inc. stating
that all copies of the software have been destroyed. The letter must be signed by an officer of the
company.

Usage Rights
For the fee you have paid, Softrak Systems Inc. hereby grants to you and you accept a license to
use this application and the related materials on one computer system only. To use this
application on more than one computer system, you must either purchase a license for another
copy of Adagio Invoices or arrange for a multi-user license from Softrak Systems Inc. You may
not copy any of the materials received with Adagio Invoices, in whole or in part, except for
archival and backup purposes.

The license is not transferable.

Registration and Support
To receive technical support and notices of upgrades and announcements, your copy of Adagio
Invoices must be registered.

To register, install Adagio Invoices as you would any other Windows application. When you start
up Adagio Invoices for the first time, you will be presented with a screen that gives you the
option to register. Enter your company information and print the registration form to be mailed
or faxed to Softrak Systems Inc.

This software requires registration within 60 days of first use. It will cease to operate after 60
days have elapsed without a registration code.

Liability
You agree that regardless of the form of any claim, the liability of Softrak Systems Inc. for any
damages to you or to any other party shall not exceed the license fee paid for the materials
included in Adagio Invoices. Nothing in this agreement shall be construed as a product warranty
and all such warranties are explicitly and expressly denied.
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What is Adagio Invoices
Adagio Invoices is a powerful invoice entry and printing system. It allows you to
enter and process invoices more easily and more quickly than Adagio Receivables.
Unlike Receivables, Adagio Invoices allows you to print, fax and email invoices
(Receivables prints, faxes and emails statements and letters only).

It will also produce invoices in an almost unlimited variety of formats, with full
Windows formatting and graphics capabilities. Not only is it quick and simple to
operate, but Adagio Invoices also provides enough power and flexibility to meet
even the most demanding invoicing needs.

Adagio Invoices features
Adagio Invoices:

• provides a flexible framework for invoices — invoice style can change within a
single invoice,

• computes taxes for multiple jurisdictions, adjusting automatically for a variety
of exempt customers and items,

• automatically retrieves all customer information from customer maintenance
fields for smooth data entry,

• calculates fractional quantities,
• supports a variety of text enhancements,
• supports many design capabilities, such as the option to insert bitmaps on

invoice specifications or use numerous different fonts on the same
specification,

• retrieves transactions easily into the Adagio Ledger through Adagio
Receivables,
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• integrates with Adagio JobCost — revenue can be assigned to specific job
numbers and retainage can be processed,

• builds Adagio SalesAnalysis through Adagio Receivables posting — detailed
analysis of billing by territory and salesperson can be completed.

Adagio Invoices allows you to:

• print invoices and post the total to the customer’s account,
• archive and edit recurring entries to save time on regular monthly billing,
• view and print historical invoices,
• create credit notes from historical invoices, and
• print and purge historical invoice listings.

Other features:

• Subtotals and totals can be calculated and printed within the body of the
invoice.

• Header information can be detailed and varied.
• More than one invoice specification can be designed so that billing can be

produced in different formats.
• Sample invoice specifications are provided. You can use the samples or design

your own.

Connections with Adagio Receivables
Transactions can be entered in Adagio Invoices via normal entry at the keyboard, or
from a batch of archived transactions. Transactions may also be imported

In order to run Adagio Invoices, you must have Adagio Receivables. In addition,
you have the option to integrate Adagio Invoices with Adagio Ledger, JobCost,
Inventory, and SalesAnalysis. Adagio Invoices may also be integrated with Adagio
OrderEntry if no Inventory exists and Adagio BankRec via Adagio Receivables.

Adagio Invoices: The concept
Adagio Invoices uses information from several different sources to provide a flexible
method of formatting invoices.

Most invoicing packages allow you to print a header, some lines of narrative text, a
footer, and several items on each invoice. With these packages, however, all items
must be formatted in the same way and must contain the same types of information.

Adagio Invoices, on the other hand, allows you almost unlimited flexibility in the
types of invoices you can produce. You can have:

• different headers on the first and subsequent pages of the invoice,
• narrative text placed anywhere on the invoice,

What is Adagio Invoices
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• different footers on the last and the preceding pages of the invoice, and, most
importantly,

• many different types of invoice line items.

These features make it possible to produce an invoice which includes a variety of
goods and services, each line item formatted to meet your exact needs.

Reports
Adagio Invoices also allows you to print a number of informative reports. The
Company Profile report, for instance, provides detailed information about all of your
default settings. The Detailed Item Listing report supplies you with complete
information about your items, while the Text Report includes a list of all of your text
codes and their respective text blocks. For more information on printing these and
other reports, see Chapter 7.

What is Adagio Invoices
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Installing Adagio Invoices
Refer to the product release notes on our website or the Readme help file for a
detailed guide to installation.

Always ensure you have familiarized yourself with the Upgrading to this Version
and Compatibility topics prior to installing a program.

Starting Adagio Invoices
To run Adagio Invoices, click on the Adagio Invoices icon on your Windows desktop
or Start menu. when the program starts, the Open Adagio Invoices Data dialog will
automatically open.

Enter SYS for the UserID and SYS for the Password. This is the Adagio system
administrator's user name and password. This password should later be changed if
other users will have access to the system. Each user should have a unique username
and password. See the section on Security Setup, the online Invoices help
documentation and your Adagio Fundamentals manual for more information.

It is very important that you keep a record of the Adagio system administrator's
password.

Compatibility
Before installing Adagio Invoices, please ensure that the version you are installing is
compatible with other modules you are using. Please consult our website at
www.softrak.com under Support and Compatibility Info for up to date information
about products and versions that are compatible with the version you are wanting to
install. Information is also available regarding supported operating systems.

Upgrading from an Earlier Version of Adagio Invoices
Adagio Invoices 9.0 and later requires Adagio Receivables 9.0 or later. Adagio
Receivables converts the receivables data from earlier versions the first time it is
opened by Adagio Receivables. Adagio Invoices will then do the same with the
invoices data.

It is always recommended that, before installing the upgrade to Adagio Invoices 9.0
or later, you do a complete backup of your Adagio data and run a Data Integrity
Check. Please refer to your online Help documentation for more information on
doing backups and data integrity checks in Adagio.

Installing Adagio Invoices
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As Invoices 9.0 and later is not compatible with Adagio Ledger versions 8.1A and
earlier, you must also convert your Ledger data to Adagio Ledger 9.0 before you will
be able to open and convert your invoices data to Adagio Invoices 9.0.

The first time you open your existing Adagio Invoices data you will receive the
following message:

If you are ready to proceed, click on Yes; otherwise, click No.

Once the conversion process has begun, you should not interrupt
(cancel) it. If you do, you will need to restore from a backup and
redo the conversion again.

The following message will appear:

If you do not have a backup of your 'current' data, please select the Backup Now
button.

If you click the Backup Now button, the Adagio Backup window will display.
Clicking the Start button will back up your invoices data to the data directory
displayed on the screen.

If this is the first time you have used the Adagio File Backup feature or if the
specified backup folder (directory) does not exist, click Yes to create the folder.

Compatibility
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For more information on the Adagio Backup function, please refer
to your Adagio Fundamentals manual or the online Help
documentation within a module.

The Conversion to Adagio Invoices 9.0 window will display.

Normally, if you have already converted and chosen to Format Addresses in Adagio
Receivables, you would accept the default and leave both options turned on. Adagio
Invoices will format all addresses that it is able to use the City and State/Prov fields.

However, perhaps your organization has stored a substantial number of documents
in Invoices' history. If you rarely restore documents from history and prefer not to
format the addresses on documents in history, you could turn off the Format
Address in History. This way, only the addresses on documents in Open and
Archive batches will be formatted.

If your organization chooses not to format addresses at all, turn both options off.

Adagio Invoices has the ability to maintain separate Previously Opened dataset lists
by user. As such, when users log into Invoices, their Previously Opened window
will display only those companies/datasets they have accessed, which should speed
their search for a particular dataset. To facilitate this, during conversion if Historical
Access Lists were not previously set up while using an earlier version of Adagio
Invoices, you will receive the following prompt:

Select Yes to have invoices retain the original list of companies all users have
accessed in the Previously Opened window and then remember which subsequent
companies/datasets have been accessed by each user separately.

Compatibility
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Select No to begin with a blank Previously Opened window and have only the list of
datasets access by each user since the installation of invoices 9.0 display each the
Previously Opened window is opened by that user.

The first time each user accesses invoices data, they will receive the
same prompt asking if they would like their historical company
access list set up.

Your data will be converted to the Adagio Invoices 9.0 or later format and you are
ready to continue daily processing in Adagio Invoices 9.0A.

Compatibility
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Adagio Fundamentals
Other important information about Adagio Invoices is included in your Adagio
Fundamentals manual. Adagio Fundamentals covers information and functions that
are similar across all Adagio applications, such as data backup, security settings and
keyboard shortcuts for data entry. Be sure to read Adagio Fundamentals for
valuable information about working with Adagio Invoices.

About Adagio
Adagio Accounting is designed for organizations that manage over $1 million in
sales/revenue, with significant transaction volume and at least one person
responsible for managing those transactions. This modular accounting system
combines a batch interface that is easy to understand and control with online
processing in order entry and inventory control. Additionally, Adagio provides
dynamite-looking invoices, checks and statements on blank paper. All of this without
being forced to use a mouse during data entry or any of the other accounting
procedures. Simple procedures and built-in software make it a snap to email or fax
letters and customer statements.

About Softrak
For over 25 years, Softrak has created accounting and reporting software to make the
tasks required in the accounting department simple and straightforward, even in
high volume businesses. If you have any suggestions about how we can improve this
module, please visit our web site at www.softrak.com.

Adagio Fundamentals
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This chapter explains the following procedures:

• Starting Adagio Invoices
• Creating Data Files
• Workstation Options
• Setting currency Information
• Security Settings
• User Audit Settings
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Starting Adagio Invoices
1) Start Adagio Invoices from your program shortcut. The following screen will

appear:

2) This dialog box appears each time you start Adagio Invoices. You must enter a
user name and password in this dialog box, and verify the date, data path, and
extension before clicking OK.

Field Description

User ID /
Password

Each Adagio Invoices user should be assigned a user
identification code in File| User Setup. Once you
have set your users up, that individual’s identification
and password should be used each time (s)he enters
Adagio Invoices.

The default User ID is SYS; the default Password is
also SYS.

NOTE: We recommend that you change the Adagio
system administrator’s password once you have set
up your users. Please refer to your online Help
documentation or you Adagio Fundamentals manual
for more information.

Remember UserID /
Password

Turn one or both of these options on to have the
Adagio user name and/or password remembered
and authenticated by the Windows user. This allows
you to default your Adagio user name by logging into
Windows (on the same station).

Starting Adagio Invoices
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Field Description

Date This is the session date. It defaults to the current
system date. If you need to change the date, use the
calendar button to the right, or type in the desired
date.

NOTE: If you want to log in to Invoices using a session
date within the month and year that initially display in the
Date field, all you need do is type one or two numbers
representing the date you want to use. (Eg. If your last
session date was 02/12/2009 and you now want to log in
using 02/15/2009, all you need do is type 15 in the date
field. The month and year are will populate automatically.)

You are able to use the one or two-character date entry
method in any 'date' field within Adagio Invoices.

Last Session Date Adagio Invoices displays the session date used when
you last accessed or ran the program with the data
path that initially displays in the Data path.

Starting Adagio Invoices
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Field Description

Data path Enter the drive and data path for your company's
data by clicking once in this field and typing the
information in, or by clicking the Browse button and
selecting the correct drive and data path from the
Data Selection dialog box that appears.

There is another button to the far right of this field.
Click this 'multiple folder' button to view a list of
Previously Opened data sets. This feature is
especially helpful if you are maintaining multiple
data sets (e.g. Adagio Invoices data for multiple
companies). If you wish to use one of these
previously-opened data sets, click the desired
Company Name to select it and click Open.

NOTE: Adagio Invoices can remember what datasets have
been accessed by each Adagio user. The first time each user
logs in to Invoices, they will be prompted to respond
whether or not they want Adagio Invoices to also load a
default list of companies called the Historical Access
List.

Select Yes to have Invoices retain the original list of
companies all users have accessed and then remember
which subsequent companies/datasets have been accessed by
each user separately.

Select No to begin with a blank Previously Opened
window and have only the list of datasets accessed by each
user since the installation of Invoices 8.1B display each
time the Previously Opened window is opened by that
user.

Extension Enter the extension used by your company’s data
here. For example, to access the sample data you
would enter SAM here.

3) If you do not have any existing Invoices data or wish to create a brand new
dataset, click Create instead. See the following section on creating new Invoices
data or to your online Help documentation for more information.

Starting Adagio Invoices
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4) When you have entered or verified the information in these fields, click Open to
open the specified data set and begin using Adagio Invoices. Or, click Cancel to
exit Adagio Invoices at this time. If you need more information about this screen,
click Help.

Creating New Adagio Invoices Data
If you have never used Adagio Invoices before or you want to create another brand
new dataset, you will need to create the Adagio Invoices data. Please refer to your
online Help documentation or your Adagio Fundamentals manual for information on
creating new datasets.

Starting Adagio Invoices
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Workstation Options
There are a number of general program options available to you in the File |
Workstation Options function. These options affect how and where reports and
document specifications (eg. invoices, credit notes and retainage invoices) print.

For user specific options that can help speed up your data entry,
affect your screen display, report printing, etc., please refer to 'User
Preferences' in your online Help documentation .

Please refer to the Adagio Invoices online Help documentation for information on
setting User Preferences.

Default printers

The Report Printer and Invoice Printer sections allow you to specify the printer
driver you prefer to use for reports and invoices. You can use the same printer driver
for both, or select a different printer driver for each. This may be useful if you
always print invoices to a different printer than any of your other print jobs, for
example.

When you enable the Default radio button for either invoices or reports, Adagio
Invoices will print the specified documents to your default printer driver, as set up in
the Windows Control Panel.

If you don't want to print to the default printer, enable the Specific field becomes
active. You can choose the preferred printer by clicking the down arrow to the right
of this field and selecting an alternate printer driver from the drop-down list that
appears.

By selecting the proper printer drivers for both your reports and your invoices in
advance, you can save yourself a lot of time in the long-run, as you will not need to

Workstation Options
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change the printer driver each time you print a report or an invoice, except in
unusual circumstances (like printing directly to fax).

Workstation Options
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Security Settings
Adagio Invoices includes a User Setup function that allows the system to prevent
unauthorized users from entering the system and restricts users from accessing
certain areas of the system.

To do all this, you must first set up user groups, which define what parts of the
program the users within the group are allowed to access. For example, you can
allow only senior staff members to access functions such as the company profile,
purge history, user and group setup, and the data integrity check. Then you can set
up the individual users and assign them to the appropriate group level, depending
on the access privileges you want to grant them.

See Adagio Fundamentals for complete information on setting up user groups and
users.

User Audit Settings
Adagio Invoices maintains various invoice and credit note user statistics. These
include settings such as Date Last Edited, Time Last Edited and Last Edited by User.
Use the Column Editor to display this information in a batch invoice list window.
(Refer to your online Help documentation or Adagio Fundamentals manual for more
detailed information about using the Column Editor.)

As well, posting journals print both the Posted by User, Date and Time and the
Lasted edited by User and Date batch information.

Statistics regarding deleting invoices or credit notes by various means is reported in
the Deleted Invoices Audit List report. Please refer to Chapter 7 for more
information on reports.

Security Settings
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You will need to use several different functions to set up and maintain your data for
Adagio Invoices. These functions can be found in three different places: on the File
menu, on the Edit menu, and on the Maintenance menu:

• Company Profile
• Customers
• Text Maintenance
• Items
• Tax Tables and Tax Types
• Shipping Addresses
• Email Cover Sheets
• Specification Styles
• Historical Invoices
• Search Invoices
• Update Archive Batches
• Block Item Adjustments
• Purge History.

The following pages describe, in detail, each of these maintenance functions.

Please refer to your Invoice Designer online Help or your Adagio Fundamentals
manual for information regarding the Maintain Specifications feature.
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Company Profile
The Company Profile is a control panel that you use to direct many Adagio Invoices
operations. The Company Profile consists of several tabs:

• Company Data
• System options
• Batch Entry
• Optional fields
• Print / Post

Your settings in the Company Profile automatically control program operation from
that point forward. Should you wish to change any of the settings, you can do so by
selecting Company Profile from the Edit menu.

Editing the Company Profile
Select Company Profile from the Edit menu or click the Company Profile button.
Adagio Invoices takes you directly to the System options tab.

If you have open invoices, you will receive a warning indicating that the program
will not allow some of the Company Profile fields to be edited while you have open
batches. If you do have open batches, you will notice as you go through the fields in
the Company Profile that some are grayed out and are, therefore, inaccessible. You
will need to print and post any open batches before these options can be changed or
move them to archive.

A complete description of each field in the Company Profile follows.

Company Profile
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Company Data tab
This tab pulls your basic company information from Adagio Receivables. The
information on this tab is for your information only and cannot be edited in Adagio
Invoices. Edit the Company Profile in Adagio Receivables if changes are required.

Please refer to the online Adagio Receivables help for more detailed information
about each of the fields on the screenshot below.

Company Profile
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System options tab

Field Description

Next batch number When you create a new batch, Adagio Invoices
automatically assigns the batch number shown here,
unless this number is already in use. If the number is
already in use, Adagio Invoices will automatically
assign the next number, incrementally.

Next archived batch
number

When you create a new archive batch, Adagio
Invoices automatically assigns the archive batch
number shown here, unless this number is already in
use. If the number is already in use, Adagio Invoices
will automatically assign the next number,
incrementally.

Sort history
invoices by

This field allows you to change the default sort order
for your history invoices. You are given the option to
sort the history invoices by Customer, or by Invoice
(in either Ascending or Descending order).

Ask for invoice date
on restore

Select this box if you want to be asked for an invoice
date when restoring archived batches.
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Field Description

Quantity to extend Your selection here determines whether Adagio
Invoices extends the Quantity shipped or Quantity
ordered amount when preparing a document. The
extended amount is the total value of all units
shipped or ordered for each line item.

Include invoice
header text

If you want to able to place a block of text (separate
from the item descriptions) on your invoices, turn this
option on. Adagio Invoices can store and retrieve up
to 10 lines of text to be used on invoices.

You have the opportunity to supply unique text
blocks for individual invoices during the invoice
entry process if you turn this checkbox on.

If you will never use the text block, you can turn this
switch off.

Lines of text Enter the number of lines (0-10) you want available
for your invoice block of text.

Width of text Enter the width of your description text block, in
number of characters, from 0 to 75 characters.
Remember that the width of your printer, the font
you use, and the margins you set will affect the width
available for text and the number of characters that
will fit on a line.

Note that the font that the text block will appear in
when printed on invoices is determined by your
settings in the Invoice Designer.

Disallow delete on
history grid?

If this option is turned on, the Delete button on the
History Invoices window will be inactive preventing
users from deleting documents in history.
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Field Description

Calculate Tax after
Retainage

With this option turned off, Adagio Invoices
calculates taxes on the total invoice amount before
retainage is deducted.

With the option turned on, taxes are calculated on the
invoice amount after retainage is deducted.

NOTE: This option is only visible if Retainage is turned
on in Adagio Receivables.

Include misc
charges in discount
base

This option refers to the Miscellaneous Charges
defined on the Company Profile, Optional Fields tab
(see page 3-35).

Turn this option on to have these miscellaneous
charges included in the invoice discount base that
early payment discounts are to be calculated on.

Include tax in
discount base

Turn this option on to have tax amounts included in
the invoice discount base that early payment
discounts are to be calculated on.
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Field Description

Allow edit of
accounting date?

This option only appears if it is also selected in
Adagio Receivables. Enabling this option creates an
additional field (the Accounting date field) on
current and archive invoice Totals tabs. It provides
you the flexibility to store the actual document date in
the Invoice date field (which facilitates Receivables
aging), while entering the date the document is to be
posted to the General Ledger in the Accounting date
field.

It is especially useful if you have set the Validate
closed periods option (set in your Adagio
Receivables company profile) to either Warn only or
Disallow. It allows you to enter a date within an
'open' General Ledger accounting period in the
Accounting date field, rather than having to edit the
Invoice date. The document's original date will be
entered and preserved in the Invoice date field of the
Totals tab.

Enabling this option also means Adagio Receivables
batches can be retrieved into Adagio Ledger using
Ledger's Subledger period retrieval option.

Auto-backup after
DIC?

Turn this option on to ensure Adagio Invoices
automatically performs a backup of Invoices data
immediately after Data Integrity Check completes.

If integrity is clean, it appends _Clean to the end of
the backup file name.

In the event Data Integrity Check finds errors and
presents the Rebuild button, a backup is performed
prior to rebuilding errors in DIC. The backup will
have _Prebuild appended to the zip file name.

For more information about running Data Integrity
Checks, please refer to your online Help
documentation and Adagio Fundamentals manual.
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Field Description

Monospaced text in
item memo?

Turn this option on to indicate that invoice memo
fields only should use the Courier New monospaced
font. As the font is not proportionally spaced, this
facilitates positioning specific characters or words in a
particular character position on the form.

Turn the option off to use the standard proportional
fonts in the invoice text lines field..

Uppercase Invoices
Items?

Turn this option if you want all newly created Adagio
Invoices items to display in uppercase only.

Warn on change of
customer?

Turn this option on to have Adagio Invoices display a
warning whenever a user changes the Customer code
of a document. Changing the document customer
may change some of the customer information on the
document Header tab also.

Verify user groups While most Finder fields in Adagio Invoices are
verified automatically, the User Groups function is
verified separately. If you want to verify that the user
group assigned to a user is valid each time you work
with a user file, you must enable this option.

Edit Options

Display account
information

If you want Adagio Invoices to display
account/department information whenever you set
up a new line item, turn this checkbox on.

Please note that this option is for display only. If you
wish to edit the information once displayed, you
must turn the Edit account information checkbox on.

If you turn this checkbox off, Adagio Invoices
automatically disables the Edit account information
switch.

Edit account
information

If you want the option to edit account information
whenever you set up a new item, click this checkbox
on.
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Field Description

Delete canceled
invoices

This field allows you to permanently delete invoices
instead of merely canceling them.

If you wish to activate this option, click this checkbox
on. Adagio Invoices will now permanently delete all
of your invoices rather than just canceling them.

Accept payments This checkbox allows you to turn off the ability to
enter payments on invoices directly in Adagio
Invoices. By default, this option is turned on; but if
you wish to disallow payment entry, turn this option
off.

Warn if price below
cost

When you turn this option on, you will be given a
warning if you add an item to an invoice, and the
price is below cost (as given in the item file).

This warning applies to both IC and Invoices items.

Default options

Default tax group Enter the tax group that you want to apply
automatically to all invoices. You will have the
option of applying a different tax group to individual
invoices if needed.
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Field Description

Default ship code Enter the ship code you want to apply automatically
to all invoices. You only need to enter a ship code
once; from that point on, Adagio Invoices prints the
shipping address that matches that code for each
customer whenever you generate an invoice.

Adagio Invoices automatically designates the billing
address to be the shipping address unless you create
a ship to code. The program automatically assigns
DFT as the default ship to code in the Company
Profile. You may assign up to 6 characters to the
Default ship to code if you do not want to use DFT.

If you create a ship to code for the customer that
matches the Default ship to code in the Company
Profile, it will be picked up as the Ship to address
when a new invoice entry is created. Alternatively,
you can specify a Ship to code on the Customer
record, on the Invoicing page. The Customer’s Ship
to code will override the Default ship to code from
the Company Profile.

For more information on the default ship code, please
see the section below entitled Default Ship Code Notes.
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Field Description

Default text code Enter the text code, if any, that you want to apply
automatically to all invoices. You only need to enter a
text code one time; Adagio Invoices prints the
selected block of text in the header of each invoice
until you return to the Company Profile and change
the default code.

You can, if you wish, set up several blocks of text that
you want to use throughout the year (monthly
messages, seasonal reminders, etc.) and assign each of
them a unique text code. Then, before you do your
invoicing each month, return to the Company Profile
and change the default text code; Adagio Invoices
prints the text block of choice on the invoices for that
month.

If you delete the characters from this field and leave it
blank, Adagio Invoices disables the default function.

Text codes/blocks of text are set up via the Text
option on the Edit menu. For a listing of all available
text codes, click the Finder button next to the Default
text code field.

NOTE: If a Text code has been entered on the Customer's
Invoicing tab, it will override what is entered on the
invoice.

For information on creating text blocks, please see the
section on Text maintenance later in this chapter.

Default retainage
IN Item

Enter the Invoices item Retainage code, if any, you
want to apply automatically to all retainage invoices.

If retainage has been turned on, when you select to
create a Retainage Invoice, this invoice item will
automatically be created for each outstanding
retainage amount.
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Batch Entry tab
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A complete explanation of the series of fields on this tab follows:

Field Description

Increment If you want Adagio Invoices to automatically increase
the document number by one whenever you begin a
new document or copy an existing one, turn this
checkbox on. This is for your convenience only. You
will still have the opportunity to edit the
automatically assigned number (via the invoice
Totals tab) when you prepare the document, even if
you turn this option on (unless you turn the checkbox
that follows, Lock, off).

If you want Adagio Invoices to increment the
document number automatically, the number cannot
contain letters, only numbers.

If you turn the Increment switch off, Adagio Invoices
will not allow you to edit the Lock and Prefix fields.

Lock If you want to be able to edit the generated document
number when you prepare the document, make sure
this checkbox is turned off.

If you want the document number to be locked so
that you cannot edit it, turn this switch on. When you
lock the document number, Adagio Invoices assigns
the default number (the number entered in the Next
number field that follows).

Prefix Up to 8 alpha/numeric characters can be added as a
prefix to the document number. For example, to
differentiate between invoices and credit notes, you
may wish to use the prefix IN for invoices and CR for
credit notes.
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Field Description

Next number Enter the next document number to be used. This
resets the automatic counter to begin with the
number you enter here. You might want to make this
document number follow on from your manual
document numbers, or you may prefer to start a new
series of document numbers.

If you turn the Increment switch off, the number you
enter here does not change and is assigned to each
new document.

The number you enter here can be edited, if you
wish, via the Totals tab when you are editing an
invoice, unless you have turned the Lock checkbox
on.

Default Batch Description section

Invoice batch
description

Use this field to enter a default description, of up to
40 characters, for each new Invoice batch created.
You may also use three Invoices variables that will
automatically enter specific information in the
description.

� Enter %usr to automatically include the Adagio
UserID of the person who creates the batch.

� Enter %dat to automatically include the system
date the batch was created.

� Enter %tim to automatically include the system
time the batch was created.

NOTE: This affects batches created by Invoices only and
not batches retrieved from other applications or imported.

Batch description
date format

Select one of the following formats for the %dat
variable to use in the Batch description:

� Windows short - from Windows Regional settings
� Windows long - from Windows Regional settings
� Rpt. options (Hdr) - as specified in Reports |

Report Options
� Rpt. options (Det) - as specified in Reports |

Report Options.
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Field Description

Batch description
time format

Select to use either a 12-hour or 24-hour time format
for the %tim variable to use in the Batch description.

Duplicate invoice
handling

Tell Adagio Invoices what to do in the event a user
enters an invoice or credit note number that already
exists in history:

� Ignore - don't do anything. Allow the duplicate
number.

� Warn - display a warning; however, if the user
chooses, it will alowl them to continue and save
the document.

� Disallow - display an error message and don't
allow the user to tab out of the Document
number field or Close the document until the
number is changed to a non-duplicate number.

Initial tab for new
invoices

Select the tab you wish displayed when creating new
documents. Select from:

� Items
� Header
� BillTo
� ShipTo
� Text
� Opt. flds
� Totals

NOTE: Particularly if you are integrated with Adagio
JobCost and track jobs at the Job-Phase-Category level,
you will probably want to have the Invoice Header tab
display first when creating new invoices. This way, you
will assign the Job-Phase-Category to all items in the
invoice first. Then, if a specific item(s) should be assigned
to a different Phase-Category, you will be able to do this
when you first create the item.

Initial tab editing
invoices

Select the tab you wish displayed when editing
existing documents. Your choices are the same as
those above.
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Field Description

Default Ready to
Post Status

By default, this is turned on (checked) for Entered
and Imported batches.

The purpose of this feature to discourage posting
batches in error, eg. before they are ‘ready to post’.

If any of the settings are turned off, in order to post
that type of batch to Adagio Invoices, you will have
to manually set the Ready to Post status in the
Invoices or Archives Batches windows. A Ready to
Post button will be visible to do so.

IC Interface Options (also refer to Appendix B - IC Interface)

Link to IC If you have Inventory data and want Invoices to be
able to use items from it, click this checkbox on.

NOTE: If Adagio OrderEntry standalone (i.e. without
Adagio Inventory data) is used, the options in this section
will refer to OE Interface Options instead.

Prompt for Adagio
Invoices Items

This field is only valid and can only be edited if Link
to IC is turned on. By default, this field is turned on.

If this is turned on, an Item Selection box will prompt
the user to choose a Adagio Invoices item or an
Inventory item when entering a line item on an
invoice or archive invoice.

If it is turned off, only Inventory items can be entered
on invoices or archive invoices.
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Field Description

Include archive
quantity on
available

This field is only valid if the Link to IC checkbox has
been turned on.

Turn this option on if you want item quantities on
invoices and credit notes stored in archive to be
reflected in the quantity Available field in the
quantities grid that appears when the Location finder
is used. This grid always displays the item quantities
that are On Invoice, On Archive, On Hand and are
Available for each location.

If this option is off, those quantities reflected in the
On Archive field will not be included when the
Available quantity is calculated for this item at a
location.

Display Cost This field is only active if the Link to IC option has
been turned on.

If you turn this option off, IC costs will by default be
hidden from all users -- all cost fields will appear
blank. However, this is just the default setting. You
can override this default and hide or display costs for
each user group in the Group Setup feature. This
allows you to hide costs for personnel and display
costs for management or senior users.

If user groups are used, this field becomes the default
setting when adding a new user group. If there are no
user groups, this field itself controls the cost field.

Please refer to your online Help documentation or
Adagio Fundamentals manual for more information on
Group Security.
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Field Description

IC item style code This field is only active if the Link to IC option has
been turned on.

Adagio Invoices prints Inventory item numbers with
their proper Inventory formatting. In addition, there
are certain Invoice Designer information codes that
only apply to Inventory items. Because of these
special considerations, Inventory items can only be
printed using one style code. If the Inventory default
style code is changed after Inventory items are
entered on invoices or archived invoices, the
Inventory items will have to be deleted from the
invoices and then re-entered to print correctly.

For more information about style and information
codes, refer to the online Invoice Designer Help or
your Adagio Fundamentals manual.

Send to IC
shipments

This field is only active if Link to IC is turned on.

You have the option to send either the Invoices
Document Number or Reference data to the
Inventory Shipments Reference field.

NOTE: In Adagio OrderEntry standalone (i.e. without
Adagio Inventory data) is used, this option will always be
inactive.

Default item type Select the item type you will use most frequently -
items from Adagio Invoices or items from Adagio
Inventory. Only the first detail when
creating/editing an invoice is affected by this option.
Subsequent details default to the previously selected
item type until the invoice is closed.
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Optional Fields tab

Optional Fields section

Field Description

Number of optional
fields

Adagio Invoices has a fixed list of fields from which
you can construct your invoice headers. In addition to
the fields on that list, Adagio Invoices gives you the
option to create one or two additional fields to fit
your needs. You may, for instance, wish to include a
warehouse reference or an “order received” date as
part of your standard header. Optional fields can
contain up to ten characters, and they can be used for
anything you wish.

Number of Optional Fields Notes

The default for this field is 0 (no optional fields). If you wish to add optional fields,
type in the number of additional fields you need (1 or 2).
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When the Number of optional fields is anything other than 0, the Description and
Data type columns are active, allowing you to enter the name and type of the
optional field(s).

In the first Description field, type in the name you wish to use for the first field. In
the corresponding Data type field, click the down arrow to view a list of possible
data types for this new field. You can select Amount, Units, Text, or Date, bearing in
mind the following:

• Amount fields are for dollar values only. They automatically format the value
with two decimal places.

• Units fields are for numbers on which you may wish to perform arithmetic
(units year to date, number of units, etc.)

• Text fields are for letters and symbols. They are also for numbers on which
you would not expect to perform arithmetic (phone numbers, serial numbers,
part numbers, etc.).

• Date fields are for dates only.

Repeat this process for the second field, if you are setting up two optional fields.

You cannot edit the Number of optional fields or the Number of
charges fields while you have open batches.

Miscellaneous Charges section

Field Description

Number of charges Two miscellaneous charges can be included in the
invoice total.

Number of Charges Notes

To include 1 or 2 miscellaneous charges in the Invoice total, enter 1 or 2 in the
Number of charges field. Enter a Charge name, G/L account (Acct) and/or
department (Dept) for each charge.

Miscellaneous charges are entered on an invoice or archive invoice on the Totals tab.
For more information about entering and editing invoices, see Chapter 4. For more
information about archive invoices, refer to Chapter 5.

Before including miscellaneous charges on your invoices, please note the following
information:

• Miscellaneous charges are added to the “after tax total” of the invoice. TAX
CANNOT BE APPLIED TO THEM.

• If “Calculate retainage with tax included” in the Accounts Receivable
Company Profile is set to “EXCLUDE”, then Misc. Charges WILL NOT be
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included in the retainage calculation. If “Calculate retainage with tax
included” is set to “INCLUDE”, then Misc. Charges WILL be included in the
retainage calculation. The retainage amount on the Adagio Invoices Totals tab
can be manually edited to INCLUDE or EXCLUDE Misc. Charges if needed.

• Miscellaneous charges may be included in the Discount Base for an invoice if
the "Include misc charges in discount base" option in the Company Profile,
System Options tab (see page 3-20) is turned on.

• Misc. Charges must be printed in the header or the footer of the invoice.
• The number, description, or account/department of Misc. Charges cannot be

changed if there are open invoice batches in Adagio Invoices. The Misc.
Charge information can be changed if there are archived batches. When the
archived batches are restored after changing the Misc. Charge information,
Adagio Invoices will warn you that “Miscellaneous charges will be adjusted to
match the Company Profile”. A data integrity check and rebuilding of Adagio
Invoices’ data will also correct any inconsistencies between the archived
batches and the Company Profile.

Optional field titles section

Several optional fields are available on this tab.

The optional fields allow you to specify other fields that you wish to use for your
invoices. This gives you the flexibility of saving additional information about your
invoices, in ways that are specific to your company or industry. When you add a
field title for any of the optional fields here, it automatically appears in the invoice
entry function, under a separate Optional fields tab for each individual invoice you
enter.

Optional field data can be printed on invoices as well. See the Specification
Designer’s field list to add any optional field to your invoice specifications.

If the field names you assign these optional fields are exactly the
same as those used in the Batch Transaction Optional fields within
Adagio Receivables, the information entered during invoice entry
can be sent to Adagio Ledger using the User Defined Fields in the
Adagio Receivables Send to G/L Description fields. As well, the
fields can be viewed with the record in the Customer Transactions if
they have been added to the grid.
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Print / Post tab
If you are also using Adagio ePrint, you will have an Archive PDF customer copy?
option. Please refer to the Adagio Invoices online Help documentation for more
information.

Posting section

Field Description

Capture Adagio
SalesAnalysis

When turned on, this option allows you to capture
the information needed by the Adagio SalesAnalysis
program.

Post invoices
without printing

If you want to post the data in your invoice to the
appropriate accounts without having to print the
invoice itself, turn this checkbox on.

Company Profile

Page 3-38 Adagio Invoices



Field Description

Check credit limit If you select this option you will be prompted when
entering customer transactions if the account is over
the customer’s credit limit. Selecting this option does
not prevent you from entering an invoice.

Auto print posting
journal after post?

If you have this option turned on, the software will
automatically open the Print Posting Journal dialog
directly after a batch has been posted. This serves as a
good reminder to print a posting journal each time
you post batches.

NOTE: Even if this option is turned on, you can still
elect not to print a posting journal by clicking the
Close button on the Print Posting Journal window
when it appears.

Send tax to JC This option allows you to include taxes as part of an
Adagio JobCost billing, as other charges, or to exclude
them from being sent to the job at all. Select the
appropriate option from the dropdown.

This field can only be accessed if the Job Costing
interface is turned on in the Company Profile in
Accounts Receivable.

Send toAR
Reference

Indicate the document field you wish to pass through
to Adagio Receivables as the AR Reference when
invoices and credit notes are posted.

Send to AR
Description 1 and 2

Indicate the document field you wish to pass through
to Adagio Receivables as the AR Description when
documents are posted.
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Printing Section

Field Description

Text for zero
amount

Specify what you want Adagio Invoices to print on
your invoice when an invoice item amount is zero.
Some examples are:

[ No Charge]
[Free]
[ Exchange]
[0.00]

When you specify the text for printing zero amounts
on invoices, Adagio Invoices prints that text for the
following information codes:

� Invoice Detail information:
D17, Extended Item Cost
D18, Extended Item Price

� Invoice Header information:
E58, Invoice total
E61, Net Invoice total (less retainage)
E67, E61 + Optional field 1
E68, E61 + Optional field 2
E69, E61 + Optional fields 1 & 2
E82, Invoice total (before retainage) less

Misc. charges
E83, Net Invoice total (before retainage)

less Misc. charges
E84, Pretax amount including

miscellaneous charges
E85, Pretax amount including

miscellaneous charges less retainage
E86, Optional Field 1 + Optional Field 2
E87, Optional Field 1 - Optional Field 2
E88, Optional Field 2 - Optional Field 2
E90, Net IN Total + Current Balance
E91, Pretax amount + Tax jurisdiction 1
E92, Pretax amount + Tax jurisdiction 2
E93, Pretax amount + Tax jurisdiction 3
E94, Pretax amount + Tax jurisdiction 4
E95, Pretax amount + Tax jurisdiction 5
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Field Description

Mark faxed invoices
as printed

Turn this option on if you want all faxed invoices to
be considered ‘printed’. Invoices must be flagged as
having been printed before they can be posted.

NOTE: There is an additional option on this window
which allows you to post unprinted invoices.

Mark emailed
invoices as printed

Turn this option on if you want all emailed invoices
to be considered ‘printed’. Invoices must be flagged
as having been printed before they can be posted.

NOTE: There is an additional option on this window
which allows you to post unprinted invoices.

Mark printed to
screen as printed

Turn this option on if you want all invoices that have
been printed to a Destination Option of Screen to be
marked as ‘printed’. Invoices must be flagged as
having been printed before they can be posted. Using
the Preview button does not flag invoices as having
been printed.

NOTE: There is an additional option on this window
which allows you to post unprinted invoices.

Invoice export name
code

Enter the code that will define the filename used
when you print invoices to a Destination of File.
Choose the filename code you will use from the same
list of User Defined Codes available to send
information to the G/L Description field from Adagio
Receivables. For example, a code of IN%dno%cst
will make the filename of each bill the same as the
invoice number and customer code for the bill (eg. IN
5 ABL01).

Please refer to online Help for list of acceptable codes.

NOTE: If another file of the same name already exists in
the destination folder, Adagio Invoices will append a
sequential number (beginning with _001) to the end of the
duplicate filename being created.

NOTE: Adagio Invoices automatically inserts a space in
the filename between text and each code used.
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Invoice / Credit Note specification sections

Using the fields in this section of the window, you can specify defaults for the
printing, faxing, and emailing of invoices and credit notes, along with an Email
Cover Sheet. The specification form defaults are only used if:

• Specification option is Use current customer specification, and
• The Invoice/Credit note spec field is 'blank', and
• The customer does not have default specifications defined in their individual

customer record.

Field Description

Print credit notes
with negatives

This option applies to credit notes only.

If turned on, amounts on credit notes will print with a
leading negative sign (eg. -75.60). However, as some
amounts (such as customer balance outstanding and
unit cost) wouldn't make sense printed as negatives,
these amounts will always print with the stored sign.

Attachments
invoices / credit
notes folder

Specify the default folders you want additional
attachments to Invoices or Credit Notes to be selected
from. These will be attached to all Invoices or Credit
Notes referenced by the particular print request.
These are other attachments (i.e. n addition to the
invoice or credit note specification attachment.
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Customer Maintenance
The customer maintenance function allows you to add, edit, copy, and delete
customers stored in Adagio Receivables while in Adagio Invoices.

The Customers function is based on the Adagio Receivables Customers function; all
changes made to your customer file in Adagio Invoices will be reflected in the
Customer maintenance functions right in Adagio Receivables and vice versa.

In addition, the Customer maintenance function includes a customer transaction
inquiry screen, allowing you to view Receivables transaction information for the
selected customer, and a Notes tab which allows you to save dated notes about the
customer. As well, customer alerts may be created that pop up whenever the
customer is used during invoice entry. It is the same as the customers function
within Adagio Receivablesg.

Adding a New Customer
Select Customers from the Edit menu or click the Customers button on the Button
bar. A Customer List screen appears.

Assuming you have Microsoft Excel installed, you may also use the ExcelDirect
button in the lower right corner of this window to export all of the customers fields
in the grid to an Excel workbook.
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Click New or double-click anywhere in the blank area below the existing
customer(s). A blank Customer screen appears with the Customer tab selected.

The fields on each of the Customer file tabs are exactly the same as those found
within Adagio Receivable.

Please refer to your Adagio Receivables online Help documentation or manual for
detailed information.

To add a customer on the fly
New customers can also be added on the fly, as you are entering new transactions.
When you are asked for a customer number, simply enter a new customer code (one
that hasn’t been assigned to any other customer). Adagio Invoices will inform you
that the customer you entered was not found, and will ask you if you want to create
a new customer using this number. Click Yes.

You will be taken to a blank customer file. Simply enter the information for this new
customer and click OK.

Next, you will be returned to the new document dialog box. Click OK again and then
proceed with the creation of the document as usual.

Searching for a Customer
In the event you cannot locate a particular customer in the Customer List, you can
use the Find feature to search for them. To do this, click the Find button in the
Customer List window, or press F5. The window that appears allows you to conduct
a search for a particular customer on the basis of the customer code.

The following dialog box appears:
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There are four different ways to search for a customer -- by Customer number,
Customer name, Phone number or Document number (eg. invoice or credit note
document number if known).

To search for a customer, click the Finder button in the relevant field to select the
appropriate information or type it manually.

You can also tell Adagio Receivables what Action to take when it finds the customer.
It can highlight it in the Customer List or take you into View mode so you can review
the customer data but not edit the file.

If you cannot remember the code for the customer in question, you may need to use
the Smart Finder. To call up the Smart Finder, press F6 within any Finder field. (For
more information on using the Smart Finder, please refer to your online Help
documentation or your Adagio Fundamentals manual.)

Copying Customers
To copy a customer, select the customer from the list in the Edit Customer List grid
and click the Copy button.

The following screen will appear:

Enter the new Customer code you want to create and check each of the Additional
files to copy options you wish to copy to the new customer also. Selecting any of
these files will copy all of the these details to the appropriate tab within the new
customer record.
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Text Maintenance
On occasion, you may wish to place a block of text on your invoices, separate from
the text that is included in some line items. You can use the text to announce a new
capability or a big sale, to thank your customers for all their purchases throughout
the year, or to remind them when earlier invoices are past due.

The program allows you to create text blocks up to ten lines long with a maximum of
75 characters per line. While you can use only one block of text per invoice, Adagio
Invoices allows you to store several different blocks so you can have a selection to
choose from. You simply need to identify each block of text with a unique text code,
and then attach a text block to an invoice via the specification (see the Adagio
Fundamentals manual).

You set the length of the text blocks, and the length of each line in the text block, in
the Company Profile under the System options tab (see the Include invoice header
text, Lines of text, and Width of text fields). You would also choose whether or not
to turn on the Monospaced font in text memo? option in the Company Profile (see
page 3-20).

You create, edit, or delete the text itself using the Text function on the Edit menu.

Creating a New Text Block
The following steps apply whether you are creating your first text block or adding a
new block to an existing set.

1) Select Text from the Edit menu or click the Text Maintenance button.
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The following screen appears:

2) Click New or double-click anywhere in the blank area below the existing text
code(s). A blank Edit Text Entries form appears:

3) Edit the following fields:

Field Description

Text code Enter a code to identify the new text block. Your code
may include up to 10 characters (letters, numbers,
symbols and spaces). This code, along with the first
30 characters of the text you create, will appear on the
Finder Dictionary List.
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Field Description

Description Type the text block in the Description field, making
sure not to exceed your maximum number of lines or
characters per line, as set in the Lines of text and
Width of text fields in the Company Profile. For
example, if you accepted the default of 10 lines of
text, at 75 characters per line, you should not enter
more than 10 lines of text in this field. Also, each line
you enter should not exceed 75 characters.

Each line in the Description field is treated as a
separate unit in this function. A sentence longer than
a single field does not automatically wrap to the next
field. To create a block of text that contains multi-line
sentences, type as much of the sentence as you can
get on a line (without exceeding the Width of text
you set in the Company Profile) and press Enter.
When the highlight moves to the next field, continue
typing your sentence where you left off.

NOTE: If you have turned on the Monospaced font in
text memo? option in the Company Profile, System
Options tab, the text memo field will only use the Courier
New monospaced font. As the font is not proportionally
spaced, it facilitates positioning specific characters or words
in a particular character position on the form.

Adagio Invoices will not allow you to exceed the maximum number
of characters on a line or the maximum number of lines in a text
block; if you attempt to exceed these maximums, your cursor simply
will not move.

4) Click OK when finished to save your new text block. If you do not wish to save
the text block, click Cancel instead.

Repeat Steps 2-4 for each additional text block you wish to create.

Default Text Blocks
If you want to create a default text block, you can do so in the Company Profile. The
text block you select as the default will appear in the Ship To / Text section of each
invoice until you change it in the Company Profile. For information on selecting
default text blocks, see the Company Profile section, earlier in this chapter.
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Item Maintenance

Adagio Invoices Items
A line item (or item) is a unit of related information that you may wish to print on
your invoice.

The line item can be used for a number of things: To present the details of a product,
sale, of a service rendered, of a purchase or activity on which you are due a
commission, or of purchases on which you are entitled to reimbursement and a
markup.

The line item can also present a subtotal of values, a subheading, a block of text, or
any other kind of information that you might wish to include on an invoice.

In Adagio Invoices, you must build a database of items, complete with default
values. Then, when it comes time to build an invoice (under Edit | Open Invoice
Batches), you:

• select the items that meet your billing needs,
• change the default values if necessary, and
• print your invoice.

When you add an item to the item database, you create a template for that item. The
template indicates each field you want included, a default value (a number, some
text, etc.) for each field, and a style code. (These formatting instructions are set in
your specifications; see the Adagio Fundamentals manual for more information.)

The fields, default values, and style code you select will appear on-screen each time
you select that item for entry on an invoice.

The item templates you create play a large role in determining how efficient the
creation and editing of invoices will be. For example, you could create a single,
general template and then enter the description and price for each item when you
create the invoice. Or, to reduce work when creating invoices, you could create a
template for each type of item, complete with price and description. You could then
accept the template as is, when you insert that item on an invoice, or edit only those
fields that need changing.

You add, delete, or edit item templates using the Items function on the Edit menu.
There is no effective upper limit on the number of item templates you can create.
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When you select Items from the Edit menu or click the Item maintenance button, the
Item Maintenance screen appears.

The ExcelDirect button on the bottom right of this screen may be a
useful tool to export a list of all items in the window and the
various column of information also displayed. If you have access
to use the Column Editor, you may change which fields display in
this and other windows in Adagio. Refer to the online Help
documentation or your Adagio Fundamentals manual for more
information on using the Column Editor.

Before we look at the process of entering, editing, copying, or deleting items, an
explanation of item templates is necessary.

Creating an Item Template

1) Select Items from the Edit menu or click the Item maintenance button.

2) If you have open invoices, you will receive a warning. This warning means that
Adagio Invoices will allow you to create, delete, or edit line item templates, and
the changes you make will be reflected on invoices you create AFTER you make
the changes. None of your work will have any effect on invoices that are already
open.
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3) If you select No, Adagio Invoices returns you to the function you were in when
you selected the Edit | Items option. If you select Yes, you will remain on the
Edit Items window.

4) The Item list displays the item templates that have already been entered in the
item database. When you set Adagio Invoices up for the first time, the database
(and hence this list) will contain a default template that you can use immediately
if you wish.

The default template has the Item code “ITEM”, the Item name
“Sample item”, an item Cost of “$20.00” and an item Price of
“$100.00”.

To use the default template, follow the instructions for editing a
template later in this chapter.

Item tab

5) Click the New button to add a new item template. The following screen appears:
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6) Complete the following fields in this screen:

Field Description

Item code Enter a code for the item you wish to create in the
Item code field. The code you choose can be up to six
characters long, and it can contain letters, numbers, or
symbols.

Using descriptive codes to help you remember the
contents of each item template may speed up your
work. A template for printer ribbons, for example,
could be coded RIBBON.

Description Enter the description for the item code. This may be
up to 40 characters in length.

The item code and the description you assign here
will appear in the Item code Finder window
whenever you call it up.

Ordered Enter the default quantity ordered you want to use.
(If you typically sell this item one at a time, you might
wish to enter 1; if you typically sell the item by the
dozen, you might wish to enter 12; etc.)

Shipped Adagio Invoices automatically duplicates the
Ordered value in this field (assuming that in a typical
situation, you will ship what is ordered). Leave the
value as is. Or, if you wish some other default, for
example if you typically send a confirming document
before shipment when you book an order, type the
value you want in this field.

Backordered As a default, Adagio Invoices subtracts the number of
items Shipped from the number of items Ordered
and enters the difference in this field (for example,
Ordered = 3, Shipped = 3, Backordered calculated as
3-3=0).
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Field Description

Cost If you want a default item Cost in the line item
template, type the new value in this field.

NOTE: If you enter a value in this field, you should enter
it with the number of decimals you want to use in batch
entry. You are able to enter a value with a different
number of Decimals than those specified with the Home
Currency in the Company Profile.

Price If you want a default item Price in the line item
template, type the price in this field and press Tab. If
you don’t want an item price included in this
template, leave the field as is.

NOTE: If you enter a value in this field, you should enter
it with the number of decimals you want to use in batch
entry. You are able to enter a value with a different
number of Decimals than those specified with the Home
Currency in the Company Profile.

Acct/Dept In the first of the two fields, enter the default G/L
account you want to credit with item proceeds. You
can also select the default G/L account by clicking the
Finder button and selecting the appropriate account
from the G/L Account Data list that appears.

NOTE: You must supply a G/L account if you want your
invoices to post to the General Ledger properly.

If your company uses departments, enter the
corresponding department.

In batch entry, the department may be overridden if
there is a Department specified on the customer's
Territory or Shipto code.

Adjustment type Select Percentage, Amount or Multiplier from the
drop-down box that appears when you click the
down arrow beside this field.
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Field Description

Adjustment value Enter an appropriate number for Percentage,
Amount, or Multiplier.

The adjustment detailed in these two fields will affect
the line item when entered on an invoice. For
example, an Adjustment type of Multiplier with a
value of 2 will multiply the extended price of the
given item by 2 when it is entered on the invoice. If
no adjustment to item price is required, accept the
adjustment value default of 0.00.

Reference Enter a 12 character item reference, if desired.

This field is provided for any specific reference you
wish to make about this item. For example, if your
items are stored in several different warehouses, you
may wish to enter a warehouse code in this field.

Tax type The Tax Type Finder window lists the code and
description for each tax type you have entered using
the Edit | Tax Tables function. Click the tax type that
applies to the item in this template to select it.

Style code Select the style you wish to assign to this item
template. Its description also appears to the right of
this field.

If you have one or both optional fields turned on, they will appear after the
Style code field. See the Options tab information, below, for more
information on these optional fields.
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Field Description

Text lines /
Width

These fields refer to the allowable number of lines
and width of item text. A maximum of 10 lines of text
is allowed per item, while Width allows for a
maximum of 75 characters per line. Only the defined
number of lines and width of text can be entered on
the invoice item entry screen and will appear on the
printed invoice.

The text block can be entered in the large field at the
bottom of the tab. You may use F7 to spell check
what you've typed in the text block.

Adagio Invoices treats each line in the description as
a separate unit. A word or sentence that is
incomplete at the end of a line does not automatically
continue onto the next line.

To enter a multi-line description, type your first line,
press Enter, and then continue entering your
description where you left off when the cursor moves
to the next line.

If you've turned on the 'Monospaced font in text memo?' option in
the Company Profile, System Options tab (see page 3-20), the text
memo field will only use the Courier New monospaced font. As the
font is not proportionally spaced, it facilitates positioning specific
characters or words in a particular character position on the form.
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Options tab

7) This screen presents the following fields and options:

Field Description

Displayed Fields
section

This section gives you full control over which fields
will appear when you edit the item on an invoice. For
example, if you always ship the full order to avoid
having backorders, you may want to click the
Backordered field off here. If you do so, when you
are editing this item on an invoice, the Backordered
field will not appear. Not only will this be
time-efficient, but it will prevent you from
accidentally entering an incorrect value in this field.

You can leave all of these fields clicked on, so that
they all appear as you edit the item on the invoice;
you can turn any combination of them off, so that
only the fields you really need for this item appear;
or, in the case of a subtotal, you can turn them all off
so none of them display.
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Field Description

Clear Subtotals
section

This section relates only to subtotal templates and
will be discussed fully in the next section, To create a
subtotal template.

Optional Fields
section

Here, you can specify up to two additional fields that
you want to include for this item. You can set the
Data type for each extra field to contain dollar, unit,
text, or date information.

If you use one or both of these optional fields, you
will notice that they are added to the item edit screen,
where you edit an item on an invoice. They are also
added to the default fields under the Item tab. To set
default values for these fields, return to the Item tab
and enter the appropriate default values in each
optional field.

8) If the template you just created is satisfactory, select OK to save your work.
Otherwise, select Cancel to discard the new template.

Adagio Invoices returns you to the Item list.

To create a subtotal template

You create subtotal templates to hold instructions:

• for printing subtotal line items when they appear on your invoices, and
• for clearing (or not clearing) subtotal counters once the subtotal line item

prints.

To create the template:

1) Follow Steps 1-5 from the section entitled To create an item template earlier in this
chapter.

2) In the Style code field, select a subtotals style code (as assigned in Edit |
Specification Styles).
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3) Click the Options tab. The following screen appears:

4) In the Displayed Fields section, click each field that is not required on your
template off, so that no checkmark appears in its checkbox. You may want to
leave all of the fields off (unchecked), as the sole purpose of a subtotal template
is not to create item information, but to create a subtotal.

5) Move into the Clear Subtotals section now, and click all of the field(s) for which
you want subtotals cleared (zeroed out) following the appearance of this line
item.

6) Click OK when finished. Adagio Invoices will save your changes and return
you to the Item Maintenance screen.

7) Repeat Steps 1-6 for each additional subtotal line item you wish to create.

Block Item Adjustments
Adagio Invoices includes a facility for making block item adjustments. Block item
adjustments allow you to globally modify the default information in your item files.
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To make block item adjustments

1) Select Block Item Adjustments from the Maintenance menu. The following
window appears:

As some fields use variable decimals, be sure to type the number of decimals you
want used. For example, if 1650.00 is wanted, please type this rather than 1650.

2) On the left side of this window, Adagio Invoices displays a complete list of your
items. The list displays the item codes for all of your items in the first column,
the item description in the second, and the current information for the field you
have selected (in the Field to adjust field) in the third column.

From this list, you can select one or more items to adjust.

3) In the Field to adjust field on the right side of this window, select the field you
wish to change the default settings for. View a list of the fields you can adjust by
clicking the down arrow beside this field.

Notice that the field you select here appears as the third column of the item list
on the left side of this window, and lists the current information for that field, for
each item. And, after you have made your adjustment, you can look to this third
column to verify that the adjustment was made correctly.

4) The Item Adjustment section of this window gives you four different options;
each option will adjust the selected field differently. Your options are:
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Option Description

Replace with Replace a field with a new value. Example:

Replace Item cost with 10.00

To do this, select Item cost in the Field to adjust field,
click the Replace with option on, and then enter 10.00
in the Replace with field.

Search for / Replace
with

Replace a selected field with a new value if the field
currently contains a particular value. Examples:

Replace the Spec style code field with an “E”
if the current Spec style code is a “B”

To do this, select Spec style code in the Field to
adjust field, click the Search for option on, then enter
B in the Search for field and E in the Replace with
field.

If using Search and Replace on a text line, the
contents will be adjusted if the replaced text is of a
different length then the original text. If the new text
extends beyond the length of the line, it will be
truncated. Word wrapping to the next line will not
occur.

Adjust by amount Available only on number or dollar fields. Example:

Adjust Item cost by 1.00

If the old Item cost was $10.00, the result would be a
cost of $11.00.

To do this, select Item cost in the Field to adjust field,
click the Adjust by amount option on, and then enter
1.00 in the Adjust by amount field.

You can also adjust amounts using negative numbers.
For example, if you wanted to decrease an Item price
by $1.00, you would enter -1.00 in the Adjust by
amount field.
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Option Description

Adjust by percent Available only on a number or dollar field. Example:

Adjust Item price by 10.50%

If the old Item price was $ 10.00, the result of a 10.55%
adjustment would be $11.05.

To do this, select Item price in the Field to adjust
field, click the Adjust by percent option on, and then
enter 10.50 in the Adjust by percent field.

NOTE: Having Implied decimal entry turned on in the
Adagio user's preferences (see the online Help
documentation) has no affect on fields containing a %
symbol or the word percent. For example, typing a 10 and
tabbing out of the field will not make the value become
.10%. It will become 10.00%. If you would like the value
to be 1%, type either 1.00 or 1 in this field.

5) When you have finished making your selection, click Process to carry out the
block item adjustments. If you do not wish to proceed with the adjustments,
click Close instead.

If you select Process, Adagio Invoices will carry out the item adjustments as per
your specifications and then return you to the Block Item Adjustments window.
To confirm that your changes have been made correctly, review the third column
of the item list on this screen; it will reflect your changes.

As you may remember from the section entitled “To create an item
template” (step 22) earlier in this chapter, you can choose to turn
certain fields on or off for any given item. If a particular field is not
really relevant for the item, it will be disabled and will not appear
on the Item Template Screen when you add that item to an invoice.

In Block Item Adjustments, if you attempt to make a change to a
field that is NOT a displayed field for a given item, you will notice
in the third column of the item list that no adjustment is made for
that particular item. In the event that you make an adjustment
that does not appear to be reflected properly in the item list, your
best recourse is to return to Item maintenance and verify that the
field you selected for adjustment is, in fact, a displayed field for the
item in question.
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Inventory Items
If you are using Adagio Invoices in conjunction with Adagio Inventory, you can edit
your Adagio Inventory items right in Adagio Invoices. When you make a change to
the item list (adding a new item, or editing or deleting an existing one) in Adagio
Invoices, that change will appear in Adagio Inventory; and vice versa.

See your Adagio Inventory manual for complete details on creating and working
with Inventory items.

Discontinued Items
Adagio Invoices has a method of marking Adagio Inventory items as discontinued.
You can do this by changing the picking sequence of an item. Any item that has a
picking sequence of XXXX will be considered discontinued. Users will not be able to
add discontinued items to an invoice.

It is generally better to mark an item as discontinued rather than deleting it because
the item may appear in your history files, or in another third party program such as
Softrak’s Sales Analysis.

Adagio OrderEntry Items
Adagio OrderEntry users who are running OrderEntry without Inventory data
present can use OrderEntry items in Adagio Invoices. See your Adagio OrderEntry
manual for complete details on creating and working with OrderEntry Items.
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Tax Tables and Tax Types

Tax Tables: The Concept
When a company sells products or services, each sale is generally subject to taxes
from one or more taxing authority. Sales in a rural area may be subject to only a state
sales tax, whereas sales in a major city may have city sales taxes or special levies
added to the state tax. Sales in some areas are subject to value added taxes, goods
and services taxes, or federal excise taxes.

Calculating the taxes on each sale and then posting the taxes to the proper accounts
used to be a tedious business; Adagio Invoices now does the work for you
automatically.

Tax application
Adagio Invoices adheres to the two basic conventions when applying taxes to an
invoice:

• Tax is applied on the total of the invoice, rather than on the individual items.
• The tax table allows for a tax minimum per jurisdiction. Zero is considered

the lowest possible tax.

Applying tax to the invoice total

To minimize the problems caused by rounding errors, Adagio Invoices creates a tax
base for all of the items on the invoice, and then applies the specified taxes to each
tax base rather than each individual item.

For instance, if you have 10 items on an invoice and state tax applies to 6 of those
items, Adagio Invoices will add those 6 item totals to create a state tax base. Using
that tax base, it will then apply the tax. Then, assume that 7 of the items on your
invoice have a city tax applicable to them. Adagio Invoices will add those items and
create a city tax base, and multiply it by the city tax rate. Adagio Invoices will do this
for each jurisdiction, with each applicable tax.

Tax minimums

Adagio Invoices’s tax tables calculate a minimum tax per jurisdiction. For example, a
“City tax only” item applied to a “State tax only” customer will create zero tax.

When Adagio Invoices calculates taxes, it looks first at the item category and
calculates the tax on the item. Then it looks at the customer category and calculates
tax on the customer. It then compares the two calculations and takes the lower of the
two; or, in a situation such as a “City tax only” item applied to a “State tax only”
customer, it creates zero tax.
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Retainage calculations
The retainage amount calculated on an invoice is based on the Total before tax. If
you wish to deduct Retainage prior to calculating tax, modify the Adagio Receivables
Company Profile to disable the Calculate retainage with tax included option. Then,
modify the Adagio Invoices Company Profile (see page 3-20) to turn on the Calculate
Tax after Retainage? option.

Terminology Used in Discussing Taxes

Tax group
A tax group is the set of rules and rates used for taxing sales within a sales area. Each
sale that is subject to identical rules and rates from an identical set of jurisdictions,
with posting to identical accounts, is said to belong to a single tax group.

A sales area is an area in which all sales are taxed according to an identical set of
rules and rates by an identical set of jurisdictions (one or more).Sales to a rural area
may be subject to taxes only from the state while sales to a large city may be subject
to taxes from both the state and the city. Since sales to both areas are taxed
differently, each area is considered a separate sales area, and each area requires a
separate tax group.

For an example of tax groups, select Tax Tables from the Edit menu. On the screen
that appears, you will see that USA and CANADA have been defined as separate tax
groups; if you view each of these tax groups separately (by double-clicking on them),
you will notice that they have different tax rules and rates. This is why each must be
defined as a separate tax group.

Jurisdiction
A jurisdiction is a taxing authority, a governmental agency or department that levies
taxes; e.g., a state, a federal government, a city, etc. In Canada, for instance, the
Goods & Services tax is levied through one authority, so it is called the GST
jurisdiction. Likewise, the PST jurisdiction refers to the provincial tax rate levied by
each province and the HST jurisdiction refers to the harmonized tax rate.

Item category
An item category is a set of tax rates that applies to a specific group of items within a
jurisdiction. For example, some items are tax free, so they are placed in a
“Non-taxable Items” category, while items that are regularly taxed are considered to
be “Taxable Items”.
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Tax base
A tax base is the sum of item total for each jurisdiction. For example, Adagio Invoices
adds each State tax item on an invoice together to create a tax base. It then multiplies
the proper State tax rate to this tax base and applies the tax to the invoice.

Customer category
A customer category is a set of tax rates that applies to a specific group of customers
within a jurisdiction. Some customers are tax-exempt; for example, a non-profit
organization may be tax exempt, so it would be referred to as a “Non-taxable
Customer”. Most customers, however, would be regularly taxed, so they would be
considered “Taxable Customers”.

Tax Type
The Adagio Invoices function that you use to set up headings for your item and
customer tax statuses.

Tax Tables
The Adagio Invoices function that you use to set up tax groups.

How Tax Tables Work
When you create an invoice for a sale into a given sales area (such as a sales area with
sales taxes levied by two jurisdictions, a city and a state), Adagio Invoices calls up the
tax group assigned to that area. The tax group is a set of rules and rates used for
taxing the various categories of items and customers that may be included on your
invoice.

As you enter a line item on your invoice, Adagio Invoices does several things:

• it identifies the jurisdiction(s) that may levy taxes on the sale,
• it calculates the tax on the line item based on the rules and rates that apply

specifically to the customer you are invoicing,
• it calculates the tax on the line item based on the rules and rates that apply

specifically to the item you are invoicing,
• it compares the two taxes it has calculated, and
• it applies the lower of the two taxes calculated.

When you have more than one item on your invoice, Adagio
Invoices creates a tax base for each jurisdiction before it actually
applies the taxes. For more information on this, see the previous
section on “Tax application”.
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Here’s how it works:

Let’s assume you are selling a $100.00 taxable item to a non-profit organization that is
exempt from tax.

When you invoice the sale, Adagio Invoices calls up the relevant sales area’s tax
group. We’ll assume that the tax group says that all taxable items are taxed at a rate
of 6%.

When you assign the customer to the invoice, Adagio Invoices checks the customer
category and finds that the customer is a non-profit organization. According to the
rules you set for that sales area, all sales to non-profit organizations, regardless of the
items involved, are exempt from taxes.

When you enter the item as a line item on the invoice, Adagio Invoices checks the
item category and finds that the item is taxable.

• Adagio Invoices calculates the tax based on the rules and rates that apply for
the item category:

$100.00 x 6% = $6.00

• Adagio Invoices calculates the tax based on the rules and rates that apply for
the customer category:

$100.00 x 0% = 0.00

• It compares the two:

$6.00 versus $0.00

and it applies the lowest of the two taxes calculated, in this case:

$0.00

Thus, the final tax calculation for the item invoiced is this:

(item) + (calculated tax) = (invoice amount)

$100.00 + $0.00 = $100.00

Setting Up Tax Types
You use the Tax Type function to create a generic set of headings that will be used
with all tax groups you create. The headings themselves don’t affect the operation of
Adagio Invoices; they are used only to identify the various kinds of taxes that apply
throughout the areas you serve.
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1) Select Tax Type from the Edit menu or click the Edit tax types button. If you
have any open batches or you have not purged your tax summary report, a
warning will appear. Changes cannot be saved while there are open batches or
unpurged tax summary reports.

You must print a hard copy of your tax summary report or print the
report to a file before you can purge it.

2) When you enter the Edit Tax Types function, the following screen will appear:

This screen allows you to build two sets of headings:

Heading Description

Customer Tax
Types

These headings appear on the Customer Tax Table to
identify the tax rates that apply to specific groups of
customers within each jurisdiction.

Item Tax Types These headings appear on the Item Tax Table to
identify the tax rates that apply to specific groups of
items within each jurisdiction.

3) Name the item and customer categories that apply in the areas you serve if the
default category headings are not satisfactory.
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4) You will need a category for standard taxable items, and you will need an
additional category for each group of items taxed differently than standard
taxable items. You will also need a category for a standard customer, and you
will need an additional category for each group of customers taxed differently
than standard customers.

• If you serve a single area and all items are either taxable or non taxable, your
list might include the names “Taxable items” and “Non-taxable items”.

• If you serve an area in which there are subtle differences in the way taxes are
levied on items, you will probably need a longer list of categories. For
instance, if all food sales are exempt from tax in some jurisdictions, while some
food sales are taxed in other jurisdictions, you will need a category to fit each
of the variations. Your list might include “Taxable items”, “Food
(ready-to-eat)”, “Food (unprepared)”, “Non-taxable, not food”, etc.

• You must have a category for each kind of tax that is levied in one or more of
your sales areas. That is, for each jurisdiction there may be different ways of
classifying whether an item or customer is taxable. If services are non-taxable
in one jurisdiction, but only certain kinds of services are tax-exempt in
another, then you must have more than just a “Services - Non-taxable”
category. You must also add a “Services - Non-taxable” category. Your Tax
Types list must include every possibility.

To add a heading

1) Click once in an open heading field.

2) Type in the name of your new heading. If you want to add another heading in
the next field, press Tab to move the cursor into the next field.

3) Repeat steps 1-2 for each additional heading you wish to add.

4) When you have added all the headings you wish, click OK. Adagio Invoices will
exit the function and save your changes.

Now you can create your tax groups. As you do so, you will notice that the headings
you just created will be used.

Adding a New Tax Group
To add a tax group, follow these steps:

1) Select Tax Tables from the Edit menu or click the Edit tax groups button. If you
have any open batches or you have not purged your tax summary report you
will receive a warning.

While you have open batches or an unpurged tax summary report, you will be
able to add new tax groups and edit existing ones, but you will not be able to
copy or delete tax groups.
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You must print a hard copy of your tax summary report or print the
report to a file before you can purge it.

2) When you enter the Edit Tax Groups function, the tax group list will appear.
Click New to create a new tax group. The following screen appears:
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3) Complete the following fields in this screen:

Field Description

Tax group Enter a code for this tax group.

Note that the Finder is available in the Tax group
field, and can be used to view a list of existing tax
groups.

You must enter a tax group code. However, if you
use the same code as an existing tax group, when you
attempt to save this new tax group by clicking OK,
Adagio Invoices will tell you that the tax code already
exists. Click OK and change the tax group code.

Description Type in a description of this tax group (up to 25
characters, any combination of numbers, letters, and
symbols).

4) You will notice that there are three tabs for this new tax group on your screen.
On the Item Rates tab, you will set up your item tax tables for this tax group; on
the Customer Rates tab, the customer tax table information must be entered.
The third tab is blank right now, but this tab is used for the jurisdiction; this is
the tab we will use to enter the bulk of our information.
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Setting up jurisdictions

1) On the blank jurisdiction tab, the first section of the screen contains seven fields
for each jurisdiction. Complete each field.

Field Description

Jurisdiction The name of the jurisdiction (taxing authority). You
can enter up to five jurisdictions for each tax group.
You may find it easier to identify jurisdictions if you
use their official names (State, Federal, New
Hampshire, Phoenix, Chicago Transport, etc.) or some
other name that is descriptive.

Minimum Minimum tax that can be collected for this
jurisdiction. If the jurisdiction has such a minimum,
enter the actual minimum in dollars and cents (dd.cc)
notation, complete with a decimal point. (If you do
not enter a decimal point, Adagio Invoices will
assume the amount is a full dollar amount, e.g. if 10 is
entered here, Adagio Invoices will convert this to
$10.00.) When a minimum is applicable and a tax
calculated is less than this limit, no tax is applied.

Maximum Maximum tax that can be collected for this
jurisdiction. If the jurisdiction has such a maximum,
enter the actual maximum in dollars and cents (dd.cc)
notation, complete with a decimal point. (If you do
not enter a decimal point, Adagio Invoices will
assume the amount is a full dollar amount, e.g. if 10 is
entered here, Adagio Invoices will convert this to
$10.00.) When a maximum is applicable and a tax
calculated exceeds this limit, the maximum tax is
applied.

Tax Tables and Tax Types

Setup and Maintenance Functions Page 3-71



Field Description

Acct/Dept The General Ledger account and department (if your
company uses departments) to which you want to
post collected taxes.

Adagio Invoices requires that the account field
contain a General Ledger account number for each
item that includes an amount field and for each
jurisdiction. If any accounts are blank, an error occurs
during invoice posting, informing you that a blank
account exists either in the line item information or in
the tax table.

Note that the Finder is available in both the account
and department fields. Use the Finder to select from
a list of possible G/L accounts and departments, by
clicking the Finder button to the right of these fields.

Tax base The base on which taxes are calculated: Item Cost,
Item Price, or Units. Click the down arrow to the
right of this field to view a list of possible tax bases,
then select the desired tax base by clicking it once.
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Field Description

Taxable The taxes levied by one jurisdiction may themselves
be taxed by another jurisdiction. Clicking this
checkbox on means the taxes are taxable; turning this
checkbox off means they are not.

When calculating invoice totals for multiple
jurisdictions, one or more of which is taxable, Adagio
Invoices calculates taxes in the order in which the
jurisdictions occur. When it comes to a taxable
jurisdiction, it calculates the taxes for the jurisdiction
and adds them to the invoice amount to arrive at a
new tax base. Then it calculates the remaining taxes
on the new base and adds them in to arrive at the
invoice total.

For example, if a sale of $100 requires a 5% tax
applied by a jurisdiction that taxes the taxable
jurisdiction, Adagio Invoices calculates the total in
this manner:

$100 + (5% x $100) = $105.00 + (7% x $105) = $112.35

Invoice amount $100.00

+ taxable tax (5%) 5.00

New tax base $105.00

+ remaining tax (7%) 7.35

Invoice total $112.35

2) Next, you should enter this jurisdiction’s customer tax information in the
Customer Tax Rates section.

Here, you must enter the tax rates that apply to specific categories of customers
you may serve in the various jurisdictions. You will set up a tax rate that applies
to all regular customers when they purchase standard taxable items, and then
you will set up the tax rates for each category of customers that is taxed
differently from regular customers (customers buying for resale, non-profit
organizations, etc.). If no tax applies to a given category in a given jurisdiction,
leave 0 as the correct tax rate.

3) Click in the first customer category field and enter the tax rate that applies for
this customer category. Again, your tax rates are entered as percentages and can
have up to 4 decimal places. For a tax rate of 5 3/8%, enter 10.475 in the category
field.

4) Repeat step 3 for each additional customer category field in this jurisdiction.
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5) The next step is to enter the item tax rates for this jurisdiction. Enter the Item
Tax Rates section of this dialog box by clicking once in the first category field.

6) Your job at this point is to enter the tax rates that apply to specific categories of
items in this jurisdiction. If no tax applies to a given category in a given
jurisdiction, leave the tax rate as 0 for that category.

7) In the first category field, type in the applicable tax rate and move into the
second category field. Note that your tax rates can be up to four decimal places,
entered as percentages. If your tax rate is 7 ¼%, enter 7.25 in the category field.

8) Repeat step 8 for each item category displayed.

9) For each additional jurisdiction you wish to enter for this tax group, click the
New button, enter a name for the new jurisdiction in the Jurisdiction field, and
repeat steps 1 -9.

You can also copy jurisdictions.

10) When you have entered all of your jurisdictions, you may want to check your tax
rate information. First, click the Item Rates tab to view the tax rates you have
entered for all of your item categories in each jurisdiction.

11) This tab is useful when you want a collective view of all item tax rate
information, including the total taxes for each item category.
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If you find any errors in the tax rates you entered, you can correct the errors on
this tab, or on the applicable jurisdiction’s tab.

12) Next, click the Customer Rates tab to view the tax rates for each customer
category in each jurisdiction. Again, you may want to use this tab whenever you
need to view all of your customer tax information for all of your jurisdictions
collectively. It also includes the total taxes for each customer category.

As with the Item Rates tab, if you find any errors in the tax rates you see here,
you can either correct the errors right here, on this tab, or on the applicable
jurisdiction’s tab.
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Shipping Address Maintenance
Some customers receive shipments at several locations. Adagio Receivables allows
you to store and use multiple shipping addresses for such customers. These
shipping addresses may also be viewed, created and edited within Adagio Invoices.
Here is the process:

• When a customer has shipping addresses that differ from their billing address,
you create the various shipping addresses and assign each of them a unique
code.

• When you create an invoice, Adagio Invoices uses the default shipping
address you have specified on the customer's Invoicing tab in Adagio
Receivables. If you have not done this and they have a Ship To code that
matches the default code in the Company Profile (see page 3-20), its “ship to”
address will be used. Or, if you have not created any shipping addresses,
Adagio Invoices considers the billing address to be the “ship to” address.

• If you have created multiple shipping addresses for a customer, you can
assign a different shipping address simply by entering the appropriate ship
code on the Ship To tab in the invoice edit function.

You can define a Default ship code in the Adagio Invoices Company
Profile, to make working with default shipping addresses easier.
The Default ship code automatically defaults to DFT in the
Company Profile but you can change it to another up to 6-character
code. If multiple ship codes are required, you can specify a Ship to
code on each customer's record on the Invoicing tab. This code will
override the default ship code in the Company Profile.

Shipping addresses entered in Adagio Invoices will appear in the associated
customer record in Adagio Receivables.

ShipTo addresses entered in Adagio Receivables will appear in Adagio Invoices.

Salesperson and Territory information entered in a Shipto address will override that
same information as stored in the Receivables customer's master record. This also
applies to tax group, tax type, price list, location, FOB and ship via fields.
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Creating a New Shipping Address Template
Follow these steps to create a new shipping address template:

1) Select Shipping Addresses from the Edit menu or click the Edit shipping
addresses button. The following screen appears:

If you have been granted access, you may use the Column Editor to
change the fields that display in the grid. Please refer to the Adagio
Invoices online Help documentation or your Adagio Fundamentals
manual for more information on working with the Column Editor.

Double-click anywhere in the white space below the existing shipping addresses
or click New to create a new shipping address template.
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2) The Shipto Address Contact screen appears:

Field Description

Customer code Type in the number of the customer for whom you
wish to create a shipping address. Alternatively, you
can click the Finder button to call up a list of your
customers, and then make your selection from the list
that appears. Adagio Invoices displays the selected
customer number in the Customer code field.

Shipto/contact code Enter a unique code of up to six characters. This is a
required field.

NOTE: If you want this to be the default shipping address
for this customer, you will want to enter the default
shipping code you assigned in the Company Profile.

Shipto address? As this is a shipping address you are entering, this
option is automatically turned on for you.
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Field Description

Description Enter some descriptive text about the shipping
address that will help you to identify it easily; for
instance, you may want to enter the name of a
warehouse, or a street or city name. Each of the two
contact description lines can store up to 40 characters.

Format Address? By default this option is turned on.

When turned on, City, Prov/State, and Country fields
are available to be used as separate fields.

Street /
City, State / Prov /
Zip/Postal

Enter address information for this Shipto Address
here. the Street address lines will store up to 40
characters each.

NOTE: The city and State/Prov fields are only available
if you have chosen to Format address fields.

Contact Information Enter specific contact information for this contact such
as name, telephone and fax numbers, along with
email and web site addresses, etc..

When you enter an Office email address here and
then select this shipping address code on the invoice,
this email will appear on the invoice’s Ship To tab.
Then, when you are emailing invoices or credit notes,
you can opt to send the email either to the billing
address for the invoice, or to this shipping address or
to the address on the customer information tab.
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3) It is important that you click on the Shipto/Alerts tab and complete it next:

4)

Field Description

Territory The up to six-character territory code can be used to
identify geographical or sales territories and can be
used to sort analysis reports. A department specified
on a Territory in the Shipto code will override a
department specified on a Territory in batch entry or
in the customer Invoicing tab.

Price list If you use Adagio Order Entry or Inventory Control,
you may select from a previously defined price list.
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Field Description

Salesperson You can select the salesperson code from the Finder
list. This field is optional within Adagio Invoices.
However, it may be used to calculate commissions
and statistics based on salesperson activity.

NOTE: Adagio Receivables supports associating different
Salespersons with different Contact/Shipto locations within
a single customer record.

Location If Adagio OrderEntry or Inventory are in use, select
the Location from the Finder button.

Location is a required field if Adagio OrderEntry is
also being used.

G/L Dept If you want to departmentalize your revenue by the
Shipping Addresses used on the invoice, you would
enter the appropriate G/L Dept code for this shipping
address here.

A department entered and used on a Shipping
Address will override a department entered on a
Territory code, which would override a department
entered on an Adagio Inventory (if used) Location
code.

FOB Enter an FOB point. An FOB point is a place or
location where the item will be shipped to at no
charge to the customer. After that point, shipping
charges will apply; however, any applicable shipping
charges are not automatically calculated based on the
information in this field.

Ship via Enter the method by which goods are shipped to this
customer. This information appears when you are
working with transactions for this customer in
Adagio Invoices or OrderEntry.
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Field Description

Tax group This field is required. Click the Finder button to call
up a list of available tax groups. Select the
appropriate tax group for this customer, taking into
consideration the city and state/province you used
for the shipping address. It can be edited during
transactions entry on the Invoice Header tab (see
Chapter 4).

Tax type This field is required. It will default to zero if not set.
It can be edited during transaction entry on the
Invoice Header tab (see Chapter 4). Click the Finder
to select from a list of available tax status types.

DUNS number If this company uses Dun and Bradstreet numbers,
enter their appropriate 9-digit number here.

Credit cards
Payment

Enter an appropriate payment type for this credit
card. Payment types are set up on the Adagio
Receivables' Edit menu using the Payment Methods
function. They allow you to specify whether a
payment is being made by check, cash, or credit card.

If Adagio Receivables is integrated with Adagio
BankRec, this Payment Method also contains
important information on how specific payments
types are sent to BankRec batches and the G/L
clearing accounts to use.

Credit cards info Enter the credit card number, name and (using the
MM/YY format) credit card expiry date in these
fields. Credit card information is stored encrypted in
your database and conforms to the ‘PCI’ Standard.

Enable alerts? Turn this option on to enable the Alerts entered for
this customer Shipto Address. Turning the option off
will disable all existing Alerts.
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Field Description

Alerts This grid lists all the Alerts for this contact. The
Function List field indicates what module functions
the Alert is active for.

To edit an existing alert, double-click on it in the list.

NOTE: A new customer ShipTo record must be saved once
before an Alert may be created for it.

To create a new alert, double-click on the last, empty
record/line in the list. Alerts can also be deleted by
clicking on them once and then pressing Delete.

The New/Edit Alert fields are identical to Alerts
within the Customer Notes/Alerts tab within Adagio
Receivables.

Alerts may be a useful way to pop up important
reminders about a particular shipping address; for
example, if the customer prefers that certain items do
not get shipped to this address, you could enter an
alert so that every time this shipping address is
selected on an invoice, your customer service staff are
reminded of the shipping restrictions and can
evaluate the appropriateness of selecting this
shipping address.

Please refer to your Adagio Receivables online Help
documentation or manual for detailed information
about setting up Alerts.

5) When you are satisfied with the information on this screen, click OK. Your
changes will be saved and you will be returned to the list of shipping addresses.

If you enter a different tax group or tax type in the shipping address
template than the tax group or tax type indicated in the “Bill to”
section of the invoice, Adagio Invoices will override the billing
address tax group and tax type and will use the tax information
indicated for the shipping address instead.

6) Repeat Steps 2-4 for each new shipping address you wish to create.
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History Maintenance
When you post documents in Adagio Invoices, the program keeps a copy of the
invoices, retainage invoices and credit notes you have posted. These copies, which
are called historical invoices, can be accessed via the Historical Invoices function.
This feature allows you to view, reprint, purge, or restore posted invoices. You can
even export the list using the ExcelDirect button.

While you cannot make any changes to an invoice that has already been posted, you
may need to reprint, view, or restore historical invoices from time to time, so this
feature can be very useful.

If you want users to be able to view historical invoices without
allowing them to also delete or restore historical invoices, you can
use the File | Security Group Setup function to enable the
Historical Invoices function on the Inquiries menu and disable that
function on the Maintenance menu. Please refer to the online Help
documentation or your Adagio Fundamentals manual for more
information on working with Security Groups in Adagio.

Viewing Invoices
1) Select Historical Invoices from the Maintenance menu or click the Maintain

historical invoices button. The following screen appears:
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2) Double-click the invoice you want to view, or click it once to select it and then
click the View button. The invoice will appear on your screen, with the tab
specified in the Company Profile (see page 3-28) selected.
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3) The other tabs on this screen allow you to view the various components of the
invoice. If you wish to view a particular part of the invoice, click that tab. For
example, to view the invoice totals information, click the Totals tab. The totals
information will appear:

4) When you are finished viewing the screen(s), you have several options,
accessible by the column of buttons on the right side of the screen, or by the right
mouse button pop-up menu:

Button Description

View This button in only active from the History Invoices
window.

View allows you to view a document’s details.

While in the item detail window, there are Next and
Previous buttons which allow you to scroll through
the details one at a time.
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Button Description

Find Enter either the document (Invoice) number you wish
to locate in the Invoice number field and/or the
customer for whom you wish to search in the
Customer code field. If you do not know the
information, you can use the Finder or Smart Finder.
The Finder will allow you to view a list of documents
and customers; the Smart Finder can be used to
search for a the document and/or customer using
other fields of information.

Select the Type of document you want to locate as
well as the Action you want Adagio Invoices to take
when it is located.

NOTE: Retainage Invoice only appears if Retainage
has been enabled in the Adagio Receivables Company
Profile.

Restore Restore the invoice as an active invoice or credit note,
or as an archived invoice. Please refer to page 3-89
for more detailed information.

Print Print the historical invoice. Refer to page 3-88 for
more information.

Previous View the previous historical invoice on the Invoice
list.

Next View the next invoice on the list of historical invoices.

Help Obtain on-line Help documentation regarding this
function.

Close Exit this invoice and return to the Invoice list on the
History Invoices screen.

5) Select any of these options.

While in the View mode for any invoice, you can also use the Previous and Next
buttons to scroll forward and backward in the history list, to view other historical
invoices.
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Printing Invoices
1) Select Historical Invoices from the Maintenance menu or click the Maintain

historical invoices button. The History Invoices screen appears.

2) Select the invoice(s) you wish to print.

• To select just one invoice, click the invoice once.
• To select multiple successive invoices on the list, hold the Shift key down and

click the first invoice you wish to print. While still holding the Shift key
down, click the last invoice you wish to print. The two invoices you selected,
plus all of the invoices in between, will be selected.

• To select multiple non-successive invoices on the list, hold the Ctrl key down
while you click each invoice you wish to print in turn.

3) When you are ready, click the Print button. The following dialog box will
appear:

4) Verify that specification file names listed in the Invoice spec. and Credit note
spec. fields are the ones you want to use to print the invoice. If it is not, click the
down arrow beside this field and select another specification file name from the
drop-down list that appears.

5) Confirm that the print destination is correct. You can print the invoice(s) to your
Screen, or to a Printer, or to a File. To change the print destination, click the
down arrow to the right of this field and select the desired destination from the
drop-down list that appears.

If you are printing to a File, you may set a default file name using the invoice
export name code field in the Company Profile, see page 3-38.
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When you are ready, click Print. Adagio Invoices will print the selected
invoice(s).

See the section on Printing invoices in Chapter 4 as well as the section on Printing
options in the Adagio Fundamentals manual for more detailed information about
your print options.

Invoices can also be faxed and emailed, if you have turned those options on in the
File | Options function.

For information on using the fax and email features, please refer to the online Adagio
Invoices help file, or your Adagio Fundamentals manual.

Restoring the Invoice
Adagio Invoices allows you to restore historical invoices as current invoices. All
information on a restored historical document remains the same when the document
becomes current and active except the tax information, unless you select one of the
'revise' options in the restore window. When you choose to restore an historical
document, Adagio Invoices automatically updates the tax information for that
invoice according to your current tax tables.

To restore one or more historical invoices:

1) Select Historical invoices from the Maintenance menu or click the Maintain
historical invoices button. The History Invoices screen appears.

2) Select one or more invoices to restore.

• To select just one invoice, click the invoice once.
• To select multiple successive invoices on the list, click the first invoice you

wish to restore. Hold the Shift key down and click the last invoice you wish
to restore. The two invoices you selected, plus all of the invoices in between,
will be selected.

• To select multiple non-successive invoices on the list, hold the Ctrl key down
while you click each invoice you wish to restore in turn.
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3) When you are ready, click the Restore button. The following dialog box will
appear:

You are given several options in this dialog box:

Option Description

Increment
document number

Allows you to increment the document number for
the selected invoice(s) as if you were creating a new
invoice from scratch. Turn this option on to
increment the document number, or off to manually
assign the document number. By default, this option
is turned on.

History Maintenance

Page 3-90 Adagio Invoices



Option Description

Include payment You will only see this option if Accept payments? has
been enabled in the Company Profile (see page 3-20).
If payment information is stored with the invoice(s),
enabling this option causes the payment to
Auto-assign the new Invoice number as the Check
number on the new invoice's Payment Tab.

Assign check
number

This option is automatically enabled when the
Include payment option is enabled. For invoices that
have stored payment information, Adagio Invoices
will Auto-assign the Check number on the new
invoce so that it is the same as the new Invoice
number.

Create a credit note When turned on, this option allows you to restore
selected invoice(s) as credit note(s). By default, this
option is turned off.

Credit original
Invoice

If you select to Create a credit note, the Credit
original Invoice option will be automatically selected
for you. Leaving the option turned on will prefill the
Original invoice field on the restored document for
you.

However, you may turn this option off if you prefer
to use this document to credit some other document
or simply to create a credit note document. When
you do this, the Original invoice field on the restored
document will be left blank of the Invoice Totals tab
(see Chapter 4) and you can use it to enter another
document to be credited or leave it blank.

Revise date fields If turned on, date fields will be revised based on the
date entered in the Invoice date field (e.g. the current
date). By default, this checkbox is turned off.
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Option Description

Revise addresses Turning this option on will format the addresses of
the restored invoice to the format currently used
within the customer record. For example, if the BillTo
address of the document in History is formatted but
the customer record's address is currently
unformatted, turning this option on will 'unformat'
the address in the newly created document.

Unformatted addresses do not use the City and
State/Prov fields.

Revise all (addr.,
pricing, etc.)

Turning this option on will not only update the new
document addresses per the customer's record, but
will also update any changes made to their Invoicing
tab or ShipTo Addresses, as well as changes made to
Invoices or Inventory items.

It should be used when the document being restored
contains ShipTo codes / price lists.

Open batch /
Archive batch

These two buttons allow you to determine whether
the invoice(s) should be active, in an Open invoice
batch, or inactive in an Archive batch. Click either of
these options, according to your needs.

New batch /
Multiple new
batches / Existing
batch

These options allow you to restore the selected
document(s) to a New batch, to several new batches,
or to an existing batch. Click any one of these
options.

The Multiple new batches option will be available if
you've selected more than one document to restore. If
you select this option, each document selected will be
restored to its own new batch.

You can also restore the selected document(s) to an
Existing batch. If you choose this option, you must
specify the existing batch number in the space to the
right of this field. Click the Finder button to select
from a list of the possible existing batches. Or you
may type the existing batch number manually.
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4) When you have made your selections for each of these fields, click OK. Adagio
Invoices will restore the document(s).

You can also restore history invoices by dragging and dropping them into the
desired Batch List or Invoice Batch List. (This includes the Archive Batch List and
Archive Invoice Batch List.) To do so:

• Open the Batch List or Batch Invoice List to which you want to restore the
document(s). By opening a Batch List, you will restore the invoice(s) to an
entirely new batch. By opening a Batch Invoice List, you will restore the
invoice(s) to a specific batch.

• From the History Invoices screen, select one or more history invoices to
restore.

• While holding down your left mouse button, drag the selected invoices to the
white space at the bottom of the Batch List or Batch Invoice List and release
the left mouse button.

• Restore the invoice(s) as described in steps 3 and 4 using the Restore invoice
window. If you are certain that you have dragged the selected invoice(s) to
the correct Batch List or Batch Invoice List, you merely need to click OK as
Adagio Invoices will automatically enter the appropriate information in the
Restore Invoices options for you.
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Restoring History Invoices as Credit Notes
When you use the Restore feature to restore a history invoice as a credit note, Adagio
Invoices retains a record of the original document number.

If you want to view the original document number of the credit note, you can do so
by selecting the Totals tab in the invoice edit function. When you select a credit note
for editing, the Totals tab will appear as follows:

Purging History
The Purge History function on the Maintenance menu allows you to selectively clear
data from the history file whenever you wish.

History is cleared as of the date you specify; as well, Adagio Invoices allows you to
clear history by customer, document number, salesperson, and territory.

This function allows you to multiselect documents that meet the criteria you specify
and is particularly useful when you have thousands of documents stored in history.
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To use this function:

1) Select Purge History from the Maintenance menu. The following dialog
appears.

2) Enter the desired history clearing date. If desired, you can also further narrow
the purge criteria by setting values in the remaining fields in this window:

Field Description

Customer If you want to specify historical documents for a specific
range of customers, enter that range in the starting and
ending fields here.

To purge only historical documents for one particular
customer, enter that customer’s code in both the starting and
ending range fields.

Invoice/Credit # If you want to specify historical documents for a specific
range of document numbers, enter that range in the starting
and ending fields here.

To purge only one particular historical document, enter that
document number in both the starting and ending range
fields.
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Field Description

Salesperson If you want to specify historical documents for a specific
salesperson, enter that range in the starting and ending
fields here.

To purge only historical documents for one particular
salesperson, enter that salesperson code in both the starting
and ending range fields.

Territory If you want to specify historical documents for a specific
sales territory, enter that range in the starting and ending
fields here.

To purge only historical documents for one particular
territory, enter that territory in both the starting and ending
range fields.

3) When you’re ready, click OK. Adagio Invoices will confirm the date you selected
by asking:

4) If the date specified is correct, click Yes to proceed. After the history file has been
purged, Adagio Invoices will tell you:

5) Click OK.
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Invoice Search
Adagio Invoices includes an invoice search function which can be used to search for
any value in any field of an invoice in all current or archive invoice batches, or in
history. Documents that are selected in the search can be viewed, edited, or printed.

Additionally, you are able to export the result displayed in the grid to an Excel
workbook (if installed) using the ExcelDirect button.

Using the Search Function
1) Select Search Invoices from the Maintenance menu or click the Search button on

the Button Bar. The following window appears:

2) In the Where to search section of the dialog box (upper left-hand corner), click
one or more of the following checkboxes:

• Open batches
• Archive batches
• History

to include data stored in that location in the search.
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3) Indicate the details of the search in the What to search for section of the dialog
box, using these fields:

Field Description

Description Click the down arrow to display a list of previously
saved search criteria and results.

Field Select the field on which you want to conduct the
search from the drop-down list. For example, if you
want to search for a particular invoice number, you
would select Invoice number here.

NOTE: If you select an Adagio Inventory field such as IC
item code, Adagio Invoices will conduct the search on IC
items only; although documents in the search results
containing the IC item may also contain Adagio Invoices
items.

The last six fields in the Field list are Adagio
Inventory specific.
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Field Description

Operation Click the down arrow to the right of this field to
choose the preferred type of search operation. Your
options include:

� Containing, where the search will turn up all
records wholly consisting of or containing a
certain string in the selected field. To illustrate, if
you selected Invoice number as the Field on
which to search and entered 345 as the Value for
the search, the Containing operation might turn
up invoices 12345, 23456, or 34567.

� In the range of, where the search will turn up all
transactions that fall within a certain range of
values.

� Equal to, where the search will turn up only the
transactions in which the selected Field is exactly
equal to the indicated Value.

� Not equal to, where the search will result in any
transactions that do not contain the indicated
Value in the selected Field.

� Less than, where the search will turn up all
records in which the value in the selected Field is
less than the Value entered.

� Greater than, where the search will turn up all
records in which the value in the selected Field is
greater than the Value entered.

� Greater than or equal to, where the search will
turn up all records in which the value in the
selected Field is greater than, or the same as, the
Value entered.

� Less than or equal to, where the search will turn
up all records in which the value in the selected
Field is less than, or the same as, the Value
entered.

Value Enter the value to be searched. For example, if you
wanted to search for all transactions for a particular
customer, you would select Customer number as the
Field, Equal to as the Operation, and then you would
enter that customer’s number in the Value field.

If you selected In the range of as your search
Operation, two value fields will appear. In the first
field, enter the range’s starting value; in the last, enter
the range’s ending value.
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4) When you are ready, click the Search button. Adagio Invoices will search all of
the records on file for those that match your search criteria. When done, it will
tell you how many records were found.

5) Click OK. The search results will appear in the grid on the bottom half of the
Invoice Search window.

To view, print, or edit a document from the list, click the document to select it
and then click the View button or double-click the document.

6) When you have completed your invoice search, you can Save the search criteria
under a descriptive name, so that you can conduct the same search again
without having to re-enter the search criteria.

Click Close when you’re finished working with or reviewing the document.

Saving a Search
1) Enter the search criteria.

2) Click the Save button and enter a description in the dialog box that opens.

If you click Search before Save, you will save the current search
results also. This may or may not be desirable as whenever you
bring up these search criteria again, you will want to perform
another Search of the data anyway in order to update the results
grid.

3) Enter a name for this search criteria. The name you choose should describe the
criteria in some way, so that you know exactly what kind of results you will get
the next time you conduct this search.

4) Click OK. Adagio Invoices will save the search criteria under the name you just
specified.

Assuming you have Microsoft Excel installed, you can export the results displayed in
the grid to an Excel workbook by clicking the Excel Direct button in the lower right
corner of this window.

If you have access to the Column Editor, you can change the
columns/fields of information that display in the results grid.
Please refer to the online Help documentation or your Adagio
Fundamentals manual for more information on using the Column
Editor.

At any time, you may use the Clear button to remove the previously saved criteria
and results from the Description dropdown.
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Year End Processing
Running Year End is optional.

Year End should be run after posting all documents for the current fiscal year,
printing all posting journals and other pertinent reports.

Year End will reset all batch and (optionally) archive batch numbers and posting
sequences to '1'. You will access this function by selecting Maintenance and Year
End from the menu. The Year End window will appear:

What appears in this window is dependent on your company Profile settings and
whether you have current batches and posting journals. The posting journal files will
be automatically cleared/ purged when Year End is run. You should ensure you
have a printed hardcopy, stored PDF or both of your posting journals before
proceeding.

When you are ready, click Proceed.
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When you click Proceed, the following window appears:

You are reminded to make a backup of your data prior to running the Year End
function. The window also describes what will occur when you Proceed with Year
End.

Disable the Resequence archive batches? option if you do not want your existing
archive batches' numbers to be resequenced to begin at '1' and you want them to
remain with their current batch numbers.
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Once you have set up your Company Profile, your Tax Tables, your Line Item
database, and your formatting instructions (specifications), you are ready to create
invoices. (For more information on setting these items up, see Chapter 3.)

You create invoices using commands available in Adagio Invoices’s Open Invoice
Batches function. Access this function by selecting Open Invoice Batches from the
Edit menu, or by clicking the Edit invoices button on the Button Bar.

Once you have created an invoice, the Open Invoice Batches function allows you to:

• create batches of invoices
• edit
• copy
• cancel (delete)
• archive batches and invoices for later recall,
• print invoices for your customers or clients and print batch listings for

yourself, and
• post a batch(es) of invoices to update your customer records and statistics.
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Invoice Batches Function
Open Invoice Batches is a powerful function. It can draw information from a variety
of sources and transform that information, at your command, into customized
invoices. This function:

• pulls customer information from the A/R customer file,
• draws each line item you select - complete with default values - from the Line

Item database and/or from Inventory Control, if you have turned the Link to
IC on in the Company Profile,

• evaluates the customer and the line item and calculates sales taxes, when
appropriate, based on Tax Table rates,

• formats the information as per your instructions, and
• prints the invoice at your request.

The Open Invoice Batches function also allows you to:

• modify default values (for line items or headers) to fit the needs of the
individual invoice,

• assign ship-to addresses and custom blocks of text to an invoice,
• edit billing information,
• apply discounts,
• adjust payment terms and due dates,
• and more.

It does all of this, quickly and easily.

In order for Adagio Invoices to post invoices properly, it is necessary that you specify
a G/L account for posting in both the tax tables and the line item templates. Please be
certain that you have specified the appropriate accounts and have not left these fields
blank.
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Invoice Entry Options
Before you begin creating and editing invoices, let’s look briefly at your many invoice
entry options in Adagio Invoices.

Adagio Invoices provides you with a couple of options regarding batch and invoice
entry. Select User Preferences from the File menu to view these options.

On the General tab of this window, there are three checkboxes that directly relate to
invoice entry.

Checkbox Description

Edit new
documents

If you click this checkbox on, each time you add a
document to a batch, Adagio Invoices will
immediately open that new document for you, to
allow you to begin editing it right away. You will
likely find that it will speed up your work a great
deal.

If you do not generally edit an invoice immediately
upon creation of the invoice, do not turn this option
on.

Edit new items on
invoices

Similar to the Edit new documents option, when this
checkbox is activated, each time you add an item to
an document, Adagio Invoices opens the item
template to allow you to edit it immediately.

This field will not be available if the Auto add items
on documents feature has been turned 'on'.
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Checkbox Description

Auto-add items on
documents

If you click this checkbox on, each time you add new
items to the end of a document, Adagio Invoices will
call up the Insert item dialog box for the first item.
After you have selected an item and clicked OK, it
will add that item to the bottom of the list and then
call up the Insert item dialog box again, allowing you
to add the next item right away without clicking New
or double-clicking at the bottom of the Item list. This
speeds up the process of adding new items to
invoices considerably, especially if you do not often
need to edit each item.

NOTE: If this option is turned on, it will only be available
when you are adding items to the end of the Item list.
Therefore, you must either:

� click the blank bottom line of the Item list, then click the
New button,

� click the blank bottom line of the Item list, then press
Enter, or

� double-click the blank bottom line of the Item list in
order to begin the multi-item addition process. If you
click New or press Insert while the highlight is on any
other item on the list, this feature will not be active.

This option can only be accessed if the Edit new
items on documents checkbox has been turned 'off'.

For the purposes of this chapter, we will assume that you have turned these options
on.

For more information on setting the other Program Options, please refer to page 2-14.
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Creating a New Batch
1) Select Open Invoice Batches from the Edit menu to call up the Batch list screen.

Or, click the Edit invoices button on the Button Bar.

If you have been granted access, you may use the Column Editor to
change the fields that display in this grid. Please refer to your
online Help documentation or Adagio Fundamentals manual for
more information on using the Column Editor.

The Ready to Post button will only appear if you have turned off
any of the Ready to Post settings in the Company Profile , Batch
Entry window (see page 3-28).

2) In the Batch List, click New. The following dialog box appears:
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3) Type in the name you want to use to describe this batch (up to 40 characters).

A default batch description may be defined in the Company Profile,
Batch Entry tab (see page 3-28).

4) Adagio Invoices creates the new batch, assigning it the next batch number,
incrementally, according to the Next batch number field in the Company Profile.

Creating a New Invoice
If you have the Edit new documents option turned on in File | User
Preferences, General tab, as soon as you create a new batch, the following
dialog box will appear, prompting you to create a new invoice at this time. (If
this is an existing batch, click New on the Batch Invoice List window.)

1) Click the down arrow beside the Document type field to select Invoice or Credit
Note as your document type. You can also create a Ret. invoice (retainage invoice)
if you have retainage accounting turned on in Receivables.

In the Customer code field, enter the number of the customer you are preparing
the invoice for, or click the Finder button to call up a list of possible customers
and select a customer from the pop-up box that appears.

If you enter a customer that does not exist, you will receive a
warning message and be asked if you wish to create the new
customer. This allows you to create a customer 'on the fly'. Click
Yes to proceed with the creation of a new customer, or No to select
a different customer.

Alerts flagged for Adagio Invoices that are entered for customers in
Adagio Receivables (or in the Edit | Customers function of Adagio
Invoices as they are from the same data source) will pop up
whenever an invoice or credit note is entered for that customer. This
applies to both active and archive batches, as well as the Customer
Inquiry function. Multiple customer alerts may be flagged to popup
in selected or all modules.
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There are four different fields to search for an existing customer -- by
Customer code, Name, Phone number or A/R Document (eg. invoice or
credit note document number if known).

Adagio Invoices will return you to the New Invoice dialog box. If the information
in this dialog box is correct, click OK to accept it and proceed with the creation of
this new invoice.

If you have activated the Edit new documents option in the User Preferences,
General tab, Adagio Invoices will immediately open the new invoice, taking you
directly to the Invoice Header tab, Invoice Item List or whichever tab has been
specified within the Company Profile, Batch Entry tab (see page 3-28). If you
haven't activated the option, you will be taken to the Batch # Invoice List.
window below:

If you have been given access to use the Column Editor, you may
use it to add additional fields of information to this grid. For
example, if you are adding Payments with the invoices being
entered, you might add the Bank and the Check number fields to
provide at a glance confirmation that there is a payment included
with a particular invoice. Or, you might want to add the Job # ,
Phase and Category fields if you are integrating with Adagio
JobCost as visual confirmation that the invoice has been assigned
to the job. Please refer to your online Help documentation or
Adagio Fundamentals manual for more information on using the
Column Editor.
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Insert Invoices
You can also insert invoices in the middle of a batch using the Insert key on your
keyboard. This allows you to have invoices in a batch listed by customer.

If you have Allow insert of invoice in batch (New) in the user's
Group Security turned on, they will also be able to insert invoices
in the middle of a batch when clicking the New button. See the
online Help documentation or your Adagio Fundamentals manual
for more information on Group Security.

To insert an invoice in the middle of a batch:

First open the Invoice batches window by selecting Edit | Open Invoice Batches or
clicking the Invoices button on the toolbar.

If you want to insert an invoice between the current two invoices, select the invoice
above which you want to insert the new invoice. For example, if you want to add
invoice 30 between invoices 29 and 31, select invoice 31. Then, with your mouse then
hit the Insert key on you keyboard. The New Invoice window will open. Select a
customer and click OK. The new invoice will be inserted above the originally
selected invoice (in the above example, invoice 31).

Which invoice tab (eg. Item, Header, etc. displays first depends on
the 'Initial tab for new invoices' and 'Initial tab for editing
invoices' settings in the Company Profile, Batch Entry tab (see page
3-28).

Adding an Item to the Invoice
Click New to add a new item. Adagio Invoices will prompt you for the Item code:
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If you do not have Link to IC turned on in the Company Profile (see
page 3-27), this dialog box will display the Item code field only:

Enter the Item code if you know it, or click the Finder button to call up the Finder.
Click OK.

If you turned the Edit new items on documents option on in the Options function,
Adagio Invoices will add the item to your invoice and immediately call up the Item
Template Screen so you are ready to enter the next item:

This screen gives you the opportunity to accept the default values if they are correct
for this invoice, or to change the default values.

To change the default value in a given field, click once in the field, then type in the
new value. If the Finder is active in the field you wish to change, you can also select
your new value via the Finder window. The same holds true for the Calendar.

The G/L account and department that will be credited with the revenue from the sale
of this item are displayed in the upper right corner. They only appear only if you
turn the Display account information checkbox on in the Company Profile. You can
edit G/L Acct/Dept information only if you turn the Edit account information
option in the Company Profile, System Options tab (see page 3-20).

The department may be overridden if there is a department specified
on the customer's Territory or ShipTo code.
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If you use Adagio JobCost and have assigned a Job only or
Job-Phase-Category to this invoice on the Header tab, you will
always see this information on the item detail display in the upper
right corner. If you track jobs at the Job-Phase-Category level, you
will also be able to edit the Phase-Category (but not the job) within
an individual item if necessary. The Job field is never editable on
the item. (Integration with Adagio JobCost and the Job Tracking
Level are both defined in the Company Profile of Adagio
Receivables.)

Within the text memo field, Adagio Invoices will not allow you to exceed the
maximum number of characters on a line (70) or the maximum number of lines (10)
in a text block; if you attempt to exceed these maximums, your cursor simply will not
move. This prevents you from inadvertently exceeding your own preset maximums
in the Company Profile.

Also, if you have turned on the Monospaced font in text memo? option in the
Company Profile, System Options tab (see page 3-20), the text memo field will only
use the Courier New monospaced font. As the font is not proportionally spaced, it
facilitates positioning specific characters or words in a particular character position
on the form.

Make the necessary changes to this item. When you’re finished, click OK to save your
changes and return to the Invoice Item List.

Repeat steps 7-13 for each item you want to include on this invoice.
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Invoice Header Tab
Depending on the options chosen in the Company Profile for what tab to present first
when a document is created or edited, the Invoice Header tab displays automatically
or when you click on its tab. The fields that display are the same whether you are
doing invoice, credit note or retainage invoice (see page 4-146) entry:

The following table describes each field in this window:

Field Description

Description Enter some descriptive text about the document, job,
billing or shipping address that will help you to
identify it easily. There are two fields of 40 characters
each in which to do this.

Reference If you use references of any kind for your invoices,
you can enter a reference number of up to 12
characters or other information in this field.
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Field Description

PO number If your organization uses purchase orders, use this
field to store the purchase order number of up to 15
characters for this document.

NOTE: If the require PO? option has been enabled on
this customer's Invoicing tab in Adagio Receivables, you
will receive an error message that a PO number must be
entered in this field when you try to close the document.
Until a PO number is entered, you will not be able to close
the document.

Salesperson Click the Finder button to view a list of possible
salespeople and select the appropriate salesperson for
this customer.

NOTE: Salespersons are maintained within Adagio
Receivables.

Cust type This field defaults from the Customer type in the
customer record in Adagio Receivables. It can be
changed for this document if required.

Territory This field defaults from the Customer type in the
customer record in Adagio Receivables. It can be
changed for this document if required.
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Field Description

Location This field only appears if you are also using Adagio
Inventory.

Indicates the location from which the Inventory items
on this invoices will be shipped from. This field
normally defaults from the Location within a
customer Ship to address. If no Ship to address
exists, it comes from the customer Invoicing tab.
However, it may be changed here. You will receive a
prompt asking if you wish to apply the new location
to the invoice detail locations.

NOTE: If no GL department code has been set on the
customer's ShipTo or Territory and you change the
Location on the header tab, responding Yes to the prompt
will also change the GL department for all Invoices and
Inventory items on this invoice only to the GL department
stored on the new location code. Adagio looks to the GL
department on the ShipTo first, then to the GL department
on the Territory and after to the GL department stored
with the Location.

Price list The Price list is a (maximum) six-character code. It
represents the Inventory price list (if Inventory is
used with Invoices) or OrderEntry price list (if
OrderEntry standalone is used) you wish to use for
this customer. Select the price list for this customer
by clicking the Finder button and choosing a price list
code from the Finder window that appears.

NOTE: If neither Inventory nor OrderEntry data exists,
there will be no data to support this field.

Ship date Indicates the date the goods or services for which the
customer is being billed were shipped or provided.
You can change this date by clicking the Calendar
button and selecting a different date.

Ship via Displays the Ship via (shipper) information as
entered in the customer's Invoicing tab in Adagio
Receivables. You can edit these fields directly on this
screen.
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Field Description

Ship FOB Displays pertinent shipping information for this
shipping address. If no Ship code is selected in the
customer Invoicing tab, displays the Ship FOB
information as entered on the Invoicing tab. You can
edit the field directly on this screen.

Tax group This field is required.

Click the Finder button to call up a list of available
tax groups and select the appropriate tax group for
this customer, taking into consideration the city and
state/province you used for the shipping address.
The Tax group you select here governs the tax rates
and rules used for taxing sales within this customer's
sales area.

Tax groups are set up in Adagio Invoices, using the
Edit | Tax Tables function. (See page 3-85 for more
information.)

Tax type Displays the tax type that is applicable to this
document. The default for this field is set in the
relevant customer Invoicing tab in Adagio
Receivables or ShipTo address (see page 3-76 ) but
can be changed on this screen. The grayed out field
beside the Tax type displays the description for the
tax status. Click the Finder button to display a list of
possible tax types if you wish to change the default.

Tax types are set up in Adagio Invoices, in the Edit |
Tax Type function. (See page 3-83 for more
information)

Tax exempt 1 /
Tax exempt 2

The two Tax exempt fields allow you to record any
applicable tax-exemption numbers for this customer.
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Field Description

Job number This field only appears if you are also using Adagio
JobCost data.

Using the Finder, select the appropriate
Job-Phase-Category code to assign this invoice to.
Whether or not the Job only or Job-Phase-Category
field(s) display depends on how you selected to track
jobs in Adagio Receivables.

NOTE: If you are using Adagio JobCost 8.1B or later and
an Alert has been activated for the job you select, the Alert
will pop-up at this time.

NOTE: When you enter a job on the Header tab, a job (and
possibly a job-phase-category) field will also appear within
each item entry for this invoice. A job entered or
subsequently changed on the Header tab, will overwrite the
job entered on all items for the invoice. However, if you
track jobs at the Job-Phase-Category level, you will be
able to edit the Phase-Category only within an individual
item if necessary.

NOTE: If the customer for the job you are selecting is
different than the customer for this document, Adagio
Invoice will display a warning indicating the customer
code for the job you have selected.

NOTE: If User Defined codes are used in Adagio
Receivables , you can send the Job-Phase-Category to the
description of Adagio Ledger using %Job.

Invoice Entry Options

Invoicing Page 4-117



Click the Bill To tab to review the billing information for this invoice. The Bill To
screen appears:

The Bill To information is stored in the Customer Information tab in Adagio
Receivables. It may be changed as necessary on this screen.

Please refer to the online Help documentation within Adagio Receivables or the
manual for detailed information regarding customer records.
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Click the Ship To/Text tab from the menu bar, and the Ship To/Text screen appears:

This screen displays shipping information, shipping address and shipping email
information for the selected invoice.

Adagio Invoices draws the Default ship code from your selection in the Company
Profile (see page 3-20). If this customer does not have a shipping address
corresponding to the Default ship code, their billing address is used -- unless you
indicate that a different Shipto code be used by specifying this on the customer's
Invoicing tab. You may select another existing Ship code for the customer using the
Finder button.

If the Ship code on the customer's Invoicing tab is 'blank' and the
customer also has a 'blank' Contact/Shipto code set up, the
shipping address information from this 'blank' Ship code will be
used.

Make any necessary changes to the Ship To information, and then click the Text tab.
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If you turn the Include invoice header text checkbox 'on' in the Company Profile (see
page 3-20), Adagio Invoices activates the description text block for the selected
invoice; otherwise, the fields on the Text tab are inactive and may not be edited.

The Optional fields tab only appears if you have set up Optional fields in the
Company profile. It contains any fields that have been defined in the Company
Profile (see page 3-35 for more information). Enter any information or values for
these fields on this tab.
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Optional fields allow you to specify other fields that you wish to use for your
invoices. This gives you the flexibility of saving additional information about your
invoices, in ways that are specific to your company or industry. When you add a
field title for any of the optional fields here, it automatically appears in the invoice
entry function, under a separate Optional fields tab for each individual invoice you
enter.

Optional field data can be printed on invoices as well. Within the Specification
Designer, use the field list to add any optional field to your invoice specifications.
Please refer to the Specification Designer's own online Help documentation or your
Adagio Fundamentals manual for more information on using the Specification
Designer.

The Optional fields tab only displays if at least one of the fields have been defined in
the Company Profile.

If the field names assigned the optional fields in the Company
Profile are exactly the same as those used in the Batch transaction
Optional fields within Adagio Receivables, the information entered
during invoice entry can be sent to Adagio Ledger using the User
Defined Fields in Adagio Receivables Send to G/L Description
fields.

If equivalent optional fields are used for customers in Adagio
Receivables, the optional field values for the customer are used on
the invoices instead.
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After, click the Totals tab to review the invoice tax and totals information.

This screen allows you to set the Document type to either Invoice or Credit Note (or
Ret. Invoice, if you have activated retainage accounting in Adagio Receivables). If
you select Invoice or Ret. Invoice, the document total is applied as a positive value. If
you select Credit Note, the document total is applied as a negative value.

Adagio Invoices also displays the payment terms and calculates the discount rate (if
any); the invoice due date is calculated based on those terms. In the case of retainage
invoices, the due date is calculated as the invoice date plus the default number of
days set for the customer in the Adagio Receivables customer profile.

The Totals screen appears:

The following table explains each field displayed:

Field Description

Document type Set the document type for this document to one of the
following: Invoice, Credit Note, Ret. Invoice (if
retainage accounting is turned on in Receivables)

Document number Displays the document number for this document.
Refer to the Batch Entry tab in the Company Profile
(page 3-28) for more information about document
number defaults.
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Field Description

Invoice date Displays the invoice issue date, as per the payment
terms selected in the preceding field. To change the
issue date, click the Calendar button.

NOTE: If Allow edit of accounting date? is not turned
on in the Company Profile of both Adagio Receivables and
Adagio Invoices, this will also become the date the
invoice/credit note is posted to within Adagio Ledger.

Accounting date NOTE: This field only displays if Allow edit of
accounting date? is turned on in the Company Profile of
both Adagio Receivables and Adagio Invoices.

This field allows you to store the date of the
document in the Invoice/Credit Note Date field and
enter the date within an Adagio Ledger accounting
period the document should be posted to.

Terms Indicates the payment terms for this customer. Click
the Finder button beside this field if you wish to
modify the payment terms.

NOTE: Terms are created in Adagio Receivables and are
assigned to customers. The terms code used may allow you
to skip the credit check. Or, it might require that you enter
a partial or full payment with the invoice before you are
able to close it.

Invoice due date This is the date by which the customer will be
expected to pay the invoice. It is based on the terms
you set up for this customer; but you can be changed
if you needed.
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Field Description

Discount rate If a Terms code has been selected, the Discount rate
comes directly from the Terms code and this field
cannot be edited. This field is only editable if you
first delete the Terms code.

NOTE: Having Decimal entry turned on in the Adagio
user's record has no affect on fields containing a % symbol.
For example, typing 100 and tabbing out of the field will
not make the value become 1.00%. It will become
100.00%. If you would like the value to be 1%, type either
1.00 or 1 in this field.

Discount base The discount base is a calculated field and is always
net of retainage.

NOTE: There are options in the Company Profile for you
to set whether you want to Include misc changes in
discount base? or to Include tax in discount base? or
not. See page 3-20 for more information.

Ret. due date This field only appears if retainage accounting has
been turned on in Adagio Receivables. The date
defaults from the Default retention period set in the
Adagio Receivables Company Profile. You may enter
the date on which the retainage payment is due.

Retainage Retainage is the portion of the invoice that is left
unbilled until customer retainage conditions are
satisfied. Enter the retainage percent here and Adagio
Invoices will automatically calculate the Retainage
amount. This field only appears if retainage
accounting has been turned on in Receivables.

NOTE: Having Decimal entry turned on in the Adagio
user's record has no affect on fields containing a % symbol.
For example, typing 100 and tabbing out of the field will
not make the value become 1.00%. It will become
100.00%. If you would like the value to be 1%, type either
1.00 or 1 in this field.
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Field Description

Total before tax Adagio Invoices calculates the values automatically in
the Item tax, Total before tax and Total after tax fields
using the values you supply in the other fields and in
the Company Profile. These fields cannot be edited
directly.

Tax field(s) All applicable tax jurisdictions are listed, and the
amount of tax for each jurisdiction is displayed.
Because the tax information is automatically
calculated for you, all tax jurisdiction fields are
grayed out and cannot be edited.

NOTE: If you use Retainage, there is an option in the
Company Profile (see page 3-20) for you to set
whether Adagio Invoices should Calculate Tax after
Retainage? or not.

Total after tax Displays the total of the invoice after tax and shipping
and handling charges have been deducted. Because
this field is automatically calculated for you, it is
grayed out and cannot be edited.

Retainage amount The retainage amount is that part of an invoice (in
dollars) left unbilled until customer retainage
conditions are satisfied. If you entered a retainage
percentage in the Retainage field, Adagio Invoices
will automatically calculate the correct value for this
field. Or you can simply type the necessary amount in
this field manually. This field only appears if
retainage accounting has been turned on in Adagio
Receivables.

Net invoice amount Displays the net invoice amount due after tax and
retainage. Because this field is automatically
calculated for you, it is grayed out and cannot be
edited.

Less payment
Less payment disc

If there is payment information entered in the
Payments tab, the payment and any applicable
discount will be displayed in these fields.
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Field Description

Miscellaneous
charge(s)

If any miscellaneous charges have been defined in the
Company Profile, the fields for these amounts are
available for edit here.

Amount due Displays the total of the invoice after any payments
and payment discounts on the Invoice Payments tab
have been deducted. Because this field is
automatically calculated for you, it is grayed out and
cannot be edited.

Depending on which other modules are in use and the options set in your Company
Profile for both Adagio Receivables and Invoices, you may see other fields on this
tab. Please refer to your Adagio Invoices online Help documentation for more
information on the specific fields of this tab.

Change the defaults as needed. When finished, click Close to exit the invoice
components screens and save any changes. By doing so, your changes are saved and
you are returned to the Invoice Item List. (Refer to page 4-129 for information about
including Payments with an invoice.)

Adagio Invoices respects the Adagio Receivables' Company Profile
settings for Validate closed periods. If the setting has been set to
'Warn only' and the invoice accounting date falls within a closed
Adagio Ledger period, a warning message displays asking you if
you wish to continue. If the setting is to 'Disallow', an error will
display and you will be unable to close and accept the transaction
without first changing the invoice accounting date.

If Allow edit of accounting date? has been turned on in the
Company Profile of both Adagio Receivables and Adagio Invoices,
change the date (if necessary) in the Accounting date field on the
Invoice Totals tab. If the option hasn't been turned on, change the
date (if necessary) in the Invoice date field on the same tab as the
Accounting Date field will not be available.

For information on printing, copying, or archiving your invoices and/or batches, see
the following pages. If you want to edit this invoice, select the invoice from the Batch
Invoice List and click Edit again. Click on the tab you want to make the changes to.
When finished, click Close again to save the changes.
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Changing Invoice Price Lists
Adagio Invoices allows you to change the price list for a given invoice, with respect
to Inventory Control items. Although Adagio Invoices automatically defaults to the
price list assigned in the customer database, you can change the price list for a given
invoice via the Pricing button on the IC item template.

To change the price list for a specific invoice:

1) If you are not already in the Open Invoice Batches function, select Edit | Open
Invoice Batches or click the Open Invoice Batches button.

2) From the Batch List, click the batch you want to access once to select it, then click
Edit.

3) Adagio Invoices takes you to the Invoice List for the selected batch.

4) Click the invoice for which you want to change the price list and click Edit. The
Invoice Item List appears.

5) Click the Header tab. The following screen appears:
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6) In the Price list field, click the Finder button to view the Price Lists window.

7) Select the price list you wish to use by double-clicking it.

8) Click Close to save your change and return to the Invoice List.

Please see Appendix B for more information about IC items.
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Making Payments
If you have the Accept Payments option turned on in the Company Profile, System
Options tab (see page 3-20), a Payments tab will be included within your invoices.

This screen will not appear for Credit Notes.

The Payments function only applies to open, unposted invoices, or to archived
invoices.

To record a payment that a customer has made on an open, unposted invoice, open
the invoice through the Edit | Open Invoices Batches function. When you are in the
invoice edit window, you will see the Payment tab.

If the Send cash to BankRec option is turned on in the Adagio
Receivables' Company Profile, your payments can be sent directly
from Adagio Invoices to Adagio BankRec.
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Edit the fields on the Payments tab according to the following table:

Field Description

Payment method Payment methods are created in Adagio Receivables.

By default, this field uses the customer's default
payment method, as set in the Invoicing tab in the
customer file. You can change the payment method if
you wish, however.

If the Send cash to BankRec option is turned on in
Adagio Receivables' Company Profile, the payment
method selected can also specify the Adagio BankRec
bank the payment is to be sent to. Refer to your
Adagio Receivables online Help documentation or
manual for more information on setting up Payment
Methods.

If the Payment method code you enter matches one of
the customer’s credit cards, the credit card
information will automatically be filled in on the
Payment tab when applying a payment to an invoice.
Credit card information is read from the ShipTo
Address if one has been specified; otherwise, it is read
from the customer's Accounting tab.

Check number Enter the check number in this field. This is a
mandatory field.

If you enter AutoAssign, the Check number will be
set to the Invoice Document code when the Invoice is
posted.

NOTE: When restoring invoices from Archive or History,
choose Assign check number to update the Check
number on the restored invoice(s) to AutoAssign.

Or, enter another code used to reflect the type of
payment being made. For example, if this is a credit
card payment, you might put in the authorization
number or perhaps the receipt number or some
portion of it, such as the credit card batch and entry
number.

Payment Enter the amount of the check in this field.
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Discount This field displays the discount the customer receives,
based on the terms specified and the discount base. It
can be overwritten if necessary, however.

Account set By default, the Account set finder will display the
account set assigned to each Customer record.
However, if a Payment method is used, the Account
set will be inactive and the Acct/Dept information
will come from within the Payment method instead.

Acct/Dept If the Account set field is active and left blank, you
can manually enter the G/L account and department
to which this payment will be applied in these fields.
This should be the G/L account for your bank.

If you have entered a value in either the Account set
or Payment method field, these fields will be filled in
automatically, and will be inactive so they cannot be
edited. These fields will display the G/L bank
account and department numbers as set up in the
Control Account Set and Payment method function
within Adagio Receivables.

Credit card / Expiry
/ Name on card

If you entered a Payment method code at the top of
this tab, Adagio Invoices will automatically fill in any
applicable credit card information from that payment
method. Credit card information is read from the
ShipTo Address if one has been specified; otherwise,
it is read from the customer's Accounting tab. The
information can be changed for individual invoices,
however.

Depending on the Terms used for the invoice (as set up in Adagio
Receivables), you may be required to enter a partial or full payment
prior to being able to close the invoice.

Invoices containing payments may be copied or archived with the payment.

Once posted, payment amounts can be viewed on historical invoices through the
Maintenance | Historical Invoices feature.
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Printing Invoices
Adagio Invoices prints your invoices according to the formatting instructions you set
up in the specification. If you have not already created a specification and do not
wish to use the sample specification, you will have to create your own specification
prior to printing. See the Adagio Fundamentals manual for complete instructions.

You must print invoices before you can post invoice data unless you have the Post
invoices without printing option turned on in the Company Profile (see page 3-38).

Printing Batches of Invoices
1) If the Batch List window is not already open on your screen, select Open Invoice

Batches from the Edit menu, or click the Invoices button on the Button Bar.

2) Select one or more batches for printing.

3) When you are ready, click Print. The Print batch of invoices dialog box appears:
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The fields in this screen are as follows:

Field Description

Batch / Invoice Displays the batch number you intend to print, if you
will only be printing one batch. If you selected more
than one batch for printing, it displays Multiple
batches.

Displays the invoice number you intend to print if
printing an invoice from within a batch.

Reprint invoices Adagio Invoices will only print invoices that have not
previously been printed. If you want to print all of
the invoices in the selected batch(es), including those
that you have already printed before, turn this option
on.

Specification
option

This field allows you to indicate whether you want to:

� use one of the selected specifications in the fields
below,

� use the document specification, or
� use the current customer’s default specifications

(refer to your Adagio Receivables documentation)
that have been set up in their individual customer
record.

The document specification is used when a
document is created and defaults to the current
customer specification. If that is blank, it will use the
'last used' specification.
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Field Description

Invoice spec. Allows you to select the specification you want to use
for printing invoices. To select a specification other
than the one that appears in this field, click the down
arrow to the right of the field and select a different
specification name from the drop-down list that
appears.

For a new invoice, the field defaults to the document
specification which is normally the document
currently in the customer file. If the specification in
the customer file is blank, this will be the 'last used'
specification. If you 'blank' (delete) the specification
field, it will use the specification defined in the
Company Profile (see page 3-38).

NOTE: Within the Invoice Designer, you should set the
Specification type option within the File |
Specification options. Otherwise, all specifications will
show in the dropdown regardless of whether you make your
selection from the Invoice spec. or Credit note spec.
fields. Refer to your Invoice Designer online Help or the
Adagio Fundamentals manual for more information on
working with specifications.

Invoice Email cover If you are emailing an invoice, use this field to specify
the cover letter that should be used for the emailed
invoice.

This option is only available if you chose the Use
selected specification option in the Specification
option field above.
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Field Description

Credit note spec. Allows you to select the specification you want to use
for printing credit notes. To select a specification
other than the one that appears in this field, click the
down arrow to the right of the field and select a
different specification name from the drop-down list
that appears.

For a new credit note, the field defaults to the
document specification which is normally the
document currently in the customer file. If the
specification in the customer file is blank, this will be
the 'last used' specification. If you 'blank' (delete) the
specification field, it will use the specification defined
in the Company Profile (see page 3-38).

NOTE: Within the Invoice Designer, you should set the
Specification type option within the File |
Specification options. Otherwise, all specifications will
show in the dropdown regardless of whether you make your
selection from the Invoice spec. or Credit note spec.
fields. Refer to your Invoice Designer online Help or the
Adagio Fundamentals manual for more information on
working with specifications.

Credit Email cover If you are emailing a credit note, use this field to
specify the cover letter that should be used for the
emailed document.

This option is only available if you chose the Use
selected specification option in the Specification
option field above.

Additional PDF
attachment for
invoices (credit
notes) in ...

You select a document or file to be automatically
attached to all invoices in this print job. The default
folder the attachments are selected from is specified
within the Company Profile (see page 3-38).

Printing Invoices

Invoicing Page 4-135



Field Description

Match preferred
send method

This field appears when multiple invoices are selected
to print.

This option works with the Preferred send method
dropdown option you set on the customer's Invoicing
tab.

When enabled, only customers having the same
Preferred send method set in their record as the
button you use for this print run ( eg. Print, Email or
Fax button) will be sent the document.

When disabled, Invoices will create documents for
customers based on their Send method option
setting(s) on the customer's Invoicing tab.

Destination Lets you specify the print destination. Your options
are:

� Screen: Prints the invoice(s) in the batch(es) to the
screen.

� Printer: Prints the invoice(s) in the selected
batch(es) to the printer indicated in the line below
the Destination field. (You can change the printer
by clicking the Setup button.)

� File: You may set a default file name using the
Invoice export name code in the Company Profile
(see page 3-38).

If your print Destination is set to Printer, make sure that the correct paper is
loaded into your printer and that the printer is ready to print.

Note that, if you have used the Print Comments spec code on the selected
specification, you can use the Comment button to enter a Comment to print on
each invoice being printed. Each time you access the Print Invoices or print
Batch of Invoices window, you will need to enter a new comment if you want
one to print..

4) When you are ready to proceed with the printing of the invoice(s) in the selected
batch(es), click Print. Adagio Invoices prints the invoice(s) as requested.

5) You will then be asked if the invoice(s) printed OK. Check that the invoice(s)
printed properly. If so, click Yes. If not, click No and Adagio Invoices will not
mark those invoices as printed.
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Invoices can also be emailed or faxed, if you have turned those options on in the File
| Options function. For information on using the fax and email features, please see
the Adagio Invoices help file, or your Adagio Fundamentals manual.

Printing Invoices from a Batch
If you want to print only one invoice and not an entire batch, you can print the
invoice from within the Batch List window. Just select the batch that contains the
invoice and click the Edit button. Select the invoice(s) you want to print, then click
the Print button.

You can also print a specific invoice from any of the invoice component tabs within
the document. Click the Print button in any of these screens.

If you are printing a single invoice, the Print invoice window will include a line that
displays the customer’s invoicing preferences. This line indicates whether the
customer file is set up to allow printed, emailed, and faxed invoices.
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Sorting Invoices
A Sort button on the batch list windows in Adagio Invoices allows you to sort your
documents in an order that makes the most sense to you.

When you click this button, the following window appears:

Using the drop-down fields here, you can re-sort the documents in the batch window
above. By default, Adagio Invoices sorts documents by invoice number; but if you
want to re-sort those documents to find a particular invoice, for example, or to view
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all outstanding invoices in a particular territory, you can do so by choosing your sort
order in this window.

In the first field, enter the primary sort order, such as Territory. In the second field,
enter a secondary sort order, such as Salesperson. And so on, until you have defined
the sort order you wish to use. Then, click Proceed. You will be returned to the batch
list with all of the document in the list re-sorted according to your settings.

The next time you enter this batch, the sort order will be retained. It will be retained
until the batch is either re-sorted or posted.
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Copying Invoices

Copying Invoice Batches
1) Make sure you are at the Batch List. If not, select Open Invoice Batches from the

Edit menu, or click the Edit invoices button on the Button Bar.

2) Select one or more batches for copying.

3) When you are ready, click Copy. The Copy Batch dialog box appears:

Set your copy preferences according to the following table:

Option Description

Move document Copies the batch(es) to the location specified in the
remaining fields on this screen, then deletes the
original batch(es).

Increment
document number

Click this option on if you want the document
number(s) on the copied invoice(s) to be incremented
automatically, as per your settings in the Company
Profile.
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Option Description

Include payment You will only see this option if Accept payments? has
been enabled in the Company Profile (see page 3-20).
If payment information is stored with the invoice(s),
enabling this option causes the payment information
to be copied with the invoice to the new invoice's
Payment Tab.

Assign check
number

This option is automatically enabled when the
Include payment option is enabled. Use this option
to have Adagio Invoices assign a different Check
number for the new invoice than what was used on
the copied invoice. For invoices that have stored
payment information, Adagio Invoices will
Auto-assign the Check number on the new invoice
Payment Tab so that it is the same as the new Invoice
code.

Revise date fields When this option is turned on, you are given the
opportunity to change the original document date(s)
for the copied invoice(s). If you click this option on,
the New date field becomes active, defaulting to the
current date. Accept this as the date for your copied
invoice(s) or click the Calendar button to select a
different date for the copied invoice(s).

NOTE: This date does not affect any dates that may be on
the Invoice Optional fields tab.

Open batch /
Archive batch

If you want the copied batch(es) to be currently
active, click Open batch. If you prefer to copy the
batch(es) to the archive system, click the Archive
batch option.

Copying Invoices

Invoicing Page 4-141



Option Description

New batch /
Multiple new
batches / Existing
batch

Select New batch to place the copied batch(es) into an
entirely new batch. Use this option only when you
are copying one batch.

If you are copying multiple batches and you wish to
place each copied batch into its own new batch, click
the Multiple new batches option.

Click the Existing batch option to copy the batch(es)
into an existing batch.

If you select the Existing batch option, you must
enter a valid batch number in the field to the right of
this option.

By default, Adagio Invoices will copy the batch(es) to new, active batch(es), and
will increment the document number(s).

4) Click OK to proceed with the copy process.

Adagio Invoices copies the batch(es), assigns new batch numbers to the copies,
and adds them to the Batch List with the status Open. The copies can now be
manipulated (printed, archived, renamed, etc.) in the same way you would
manipulate any other batch on the list.

You may want to rename the copied batch(es) in order to
differentiate between the original and the copy. See the section on
“Renaming an invoice batch” later in this chapter for more
information.

The process for copying invoices is very similar.
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Renaming Invoice Batches

Renaming (Changing the Description for) Batches of
Invoices

Make sure you are at the Batch List. If not, select Open Invoice Batches from the Edit
menu, or click the Edit invoices button on the Button Bar:

1) Select one or more batches to rename.

2) Click the Rename button. The Batch Description dialog box appears:

If you utilize the default Invoice batch description in the Company
Profile, Batch Entry tab (see page 3-28, the description when you
create a new batch will be very similar to the one in the screenshot
above.

3) Type the new batch name over the existing name. Click OK when you are
finished.

Adagio Invoices changes the description on the Batch List to the name you just
entered and returns you to the Batch List. Once there you can review the new batch
description.
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Deleting Invoices

Deleting Invoice Batches
If you are not already at the Batch List, select Open Invoice Batches from the Edit
menu, or click the Edit invoices button on the Button Bar.

1) From the Batch List, select one or more batches for deletion.

2) Click the Delete button.

3) Adagio Invoices will ask you to confirm the deletion. Click Yes to confirm.

Adagio Invoices deletes the selected batches and removes them from the Batch List.

Deleting Invoices from a Single Batch
The process for deleting individual invoices is similar to deleting entire batches.

Deletion Notes
Canceled (deleted) invoices are not truly deleted. The program simply treats them as
inactive. They still appear on the Batch Invoice List with the status Canceled. When
you select a canceled invoice and then click Edit, Adagio Invoices asks you if you
want to reinstate the invoice or not. If you select Yes, Adagio Invoices reactivates the
invoice and changes its status to Open on the Batch Invoice List. It can then be
treated like any other open invoice.

If you do not want canceled invoices to appear on the Batch Invoice
List, you can choose to permanently delete them in the Company
Profile. To do so, go to the Entry options tab in the Company
Profile and click the Delete canceled invoices checkbox on.
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Printing Batch Listings
The Listing button that appears on all batch windows will take you directly to the
batch listing report window, allowing you to print Batch Listings directly from the
Open Batches functions.

For example, if you are in the Invoice Batch window, click the Listing button to go
directly to the Invoice batch listing report. It will use the selected batches as the batch
range for the report. Refer to page 7-185 for more information on each option.

If you multi-select batches on the batch window and click the
Listing button, the Listing report will automatically select the
range of batches you selected on the batch window. However, the
batches you select must be contiguous (1-5; not 1, 3 and 5).

To multi-select batches, hold down the Shift key while you select
the batches with your mouse.
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Creating Retainage Invoices
Retainage invoicing is a three-part process:

• First, you prepare a normal invoice for your customer. When you have set
Adagio Receivables for retainage accounting, Adagio Invoices includes the
necessary retainage fields in your initial invoice and performs the necessary
calculations and postings at that time.

• You will also have turned on or off the Calculate Tax after Retainage option
in the Adagio Invoices Company Profile, System Options tab (refer to page
3-20).

• When it comes time to invoice your customer for the retainage amount, you
prepare a separate, one-item invoice with a document type of Retainage
Invoice. On the Invoice Totals tab (see page 4-122), you must tie the
retainage invoice to the original invoice. Adagio Invoices supplies the correct
retainage amount for your retainage invoice.

Creating Your Initial Invoice — Retainage Accounting
1) To create your initial invoice, prepare the invoice as you would any other

invoice, following the instructions earlier in this chapter.

2) When your invoice is complete, click the Totals tab.
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3) Review the retainage fields (Ret. due date, Retainage, and Retainage amount)
and make any changes needed.

4) Print and post your invoice as you would any other invoice, following the
instructions earlier in this chapter.

To create a retainage invoice
When you create a retainage invoice, you are invoicing for the amount not billed on
the original invoice.

There are two ways to create retainage invoices. One way is to do it manually. The
other way is to use the Maintenance | Create Retainage Invoices function detailed
later in this section.

An important consideration in the preparation of the retainage invoice is that the
total amount billed on the retainage invoice must be equal to or less than the
retainage amount from the original invoice.

Manually create a retainage invoice

To create a retainage invoice:

1) Create an invoice as you would any other invoice, following the instructions
earlier in this chapter.

2) Before you add any line items, select the Totals tab.

3) If you did not select Ret. invoice as your document type when you created this
invoice, go to the Document type field, click the down arrow beside this field,
and select Ret. invoice from the drop-down menu that appears.

4) In the Original invoice field, select the document number of your original
invoice (the invoice from which the retainage amount you wish to bill was held
back) using the Finder button. Adagio Invoices draws the retainage due from
Adagio Receivables retainage files, enters the amount in the Retainage due field,
and calculates the invoice total.
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The screen looks similar to this:

5) Note the Retainage amount and the Retainage due amount.

6) Click the Items tab.

7) Add a single line item.

You can create a special retainage line item template that includes
all the information you want printed on every retainage invoice
(see Item maintenance in Chapter 3). Then, when you create a
retainage invoice, you call up this template, change the Extended
price amount to the exact amount of the Retainage amount (from
the Invoice Totals tab) and make all other necessary changes to
customize the line item for the current invoice.

If this retainage line item has been set as the Default retainage item
in the Company Profile (see page 3-20), it will always appear as the
new item on a Retainage invoice. You may select another item if
required.

Change the Item price to the exact Extended price amount of the Retainage
amount found on the Invoice Totals tab. Make any other changes you want to
customize the item for the current invoice. Click OK when finished to return to
the Invoice Item List.
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If you wish to add tax to your retainage invoice, it is not necessary to set the item
tax type to a non-taxable type. The Total before tax amount on a retainage
invoice must still be equal to or less than the retainage amount on the original
invoice.

If tax is added to a retainage invoice, the tax portions will correctly update the
tax G/L accounts, as specified in the tax tables. The Total before tax amount is
posted to the Accounts Receivable Control and Retainage Control accounts.

You can create a special retainage line item template that includes
all the information you want printed on every retainage invoice
(see Item maintenance in Chapter 3). Then, when you create a
retainage invoice, you call up this template, change the Extended
price amount to the exact amount of the Retainage amount (from
the Invoice Totals tab) and make all other necessary changes to
customize the line item for the current invoice.

8) Review the information in the Invoice Totals tab by clicking the Totals tab once
again.

9) At this point, you can review and edit the billing and shipping information by
clicking the Bill To and Ship To/Text tabs.

10) When you are satisfied with your invoice, print and post it as you would any
other invoice.
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Create Retainage Invoices function

This function enables you to create multiple retainage invoices at one time. Each
retainage invoice that is created must satisfy the criteria you specify and is
subsequently placed in a Invoice or Archive batch for you.

To access the function, select Maintenance | Create Retainage Invoices from the
main menu. The following screen appears:

Complete each field according to the following table:

Field Description

Customer /
Invoice # /
Invoice date /
Job number

Invoices selected must satisfy each of these four
criteria. The leftmost field always represents the
Starting value and the rightmost field represents the
Ending value. For Customer, Invoice # and Job
number fields, using a range of 'blank' through as
many z's as will fill the ending field indicates all or
any customers, invoice numbers and job numbers.
The Invoice date must have an Ending date entered.

You may type values into these fields or select them
using the Finder or Calendar buttons.
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Field Description

Batch Type Select whether you want the retainage invoices
placed in a Current or Archive batch.

Batch Indicate if you want the invoices placed in a New or
Existing batch.

Batch number This field is only active if you selected an Existing
batch. Select the batch you want the invoices placed
in from the Finder.

Retainage Invoice
date

Indicate the date for the retainage invoices created.
This becomes the Invoice date on the Invoice Totals
tab.

Results grid After Generate is clicked, this grid displays each
invoice that matches the criteria specified in the
Customer, Invoice #, Invoice date and Job number
fields.

NOTE: If you've been granted access to the Column
Editor, you may change the fields that display in this grid.
Please refer to the online Help documentation or your
Adagio Fundamentals manual for more information on
using the Column Editor.

After specifying the criteria you want the retainage invoices to match, click the
Generate button. Invoices with outstanding retainage that meet the criteria are
displayed in the results grid.

To create the retainage invoices in the specified batch, click the Create Invoices
button.

If there are no invoices displayed in the Results grid, this button in
inactive.
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Notes

Shipping Addresses
Some customers receive shipments at a variety of locations. To make your work with
these customers easier, Adagio Receivables allows you to store and use multiple
shipping addresses for those customers. Shipping addresses are also visible and may
be edited within Adagio Invoices. Here is the process:

• When a customer has shipping addresses that are different than its billing
address, you enter the various shipping addresses and assign each of them a
brief, unique code.

• To create multiple shipping addresses for a customer, select the Shipping
Addresses function from the Edit menu. For more information on this
function, see the section on Shipping Addresses in Chapter 3.

• You should refer to your Adagio Receivables online Help documentation or
manual for detailed steps in creating Contacts/Shipto Addresses in either
Receivables or Invoices.

• When you create an invoice, if the customer has a shipping address that
matches the code of the Default ship code specified in the Company Profile,
Adagio Invoices uses this as the shipping address. Otherwise, the billing
address is used.

• However, you can add or change the shipping address used on the invoice by
selecting the previously set up Ship code on the Invoice Ship To tab.
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Posting Invoices
This function updates your accounting files with the new invoices you have entered
and printed. Since it changes your files, we recommend you back up your data before
posting. That way, if needs be, it is possible to return your files to their previous
state. We also suggest you backup your Adagio related data files.

Before you can post invoices from a batch, all the invoices in that batch must have
been printed unless you have turned the Post invoices without printing option on in
the Company Profile.

When you post a batch of invoices, Adagio Invoices removes the batch from the
Batch List. You can no longer edit or delete any of the invoices in the batch. You can,
however, view the posted invoices via the Historical Invoices function.

Posting Menu
The Post menu gives you two options:

Option Description

Post Batches Updates your accounting files with the new invoices
you have entered and printed.

Print Invoice
Posting Journal

Prints a list of all invoices that have been posted and
provides key details about each invoice.

The following sections provide complete information on using these options.

Post Batches
The Post Batches function allows you to update your accounting files, such as
Adagio Receivables and Ledger, with the invoices you have entered and printed in
the Edit | Open Invoice Batches function.
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To post your invoices:

1) Select Post Batches from the Post menu or click the Post button on the Button
Bar. If you've chosen to post from the menu, the Post invoices dialog box
appears:

2) The Starting batch and Ending batch fields define the range of printed batches
that have yet to be posted.

Remember that Adagio Invoices will post the invoices in all of the batches
between the Starting and Ending batch numbers, as well as the starting and
ending batches themselves.

If you wish to post only a single batch, enter the same batch
number in both the starting and the ending fields.

3) To post the range of batches shown, click Post. Adagio Invoices will process the
posted invoices.

If the batch(es) you've selected to post do not have a Ready to Post
status, you will receive a 'No selected batches are ready to post'
message and the batch(es) will not post. Before posting, you will
need to select the batch(es) in the Batch List window and click the
Ready to Post button.

Adagio SalesAnalysis files (if you activated the Capture Adagio SalesAnalysis
checkbox in the Company Profile, see page 3-38) are also updated during the posting
process.

Possible posting errors

If the system encounters an invoice which contains an error (such as a duplicate
invoice number, a deleted customer code, etc.), that invoice will be placed in an error
batch and not posted. In the case of a blank G/L account number, posting will
continue.
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Clearing/printing the posting history file

Adagio Invoices captures a copy of each invoice posted. The invoices in this file can
be viewed and printed using the Historical Invoices function. They may also be
exported using the ExcelDirect button.

Because the file builds rapidly, particularly if you are creating many invoices, it may
be important to purge invoices from the file from time to time. However, please
ensure that you do not need these records any longer before deleting them.

For more information on clearing or printing the posting history file, see the section
on History maintenance in Chapter 3.

Print invoice posting journal
To print a list of invoices you have posted, follow these steps:

1) Select Print Invoice Posting Journal from the Posting menu. The following
screen appears:

2) The Posting sequence numbers are assigned to the batches you have posted,
incrementally. If you would like to change these numbers, type in a new value
over the default.
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3) Click the down arrow to the right of the Sort by field and select one option:

• Customer number
• Document date
• Document number

4) If you want to insert a page break after each posting sequence number, so that
each sequence number starts on its own page, turn the Page break on change of
post. seq. checkbox on.

If you have turned this option on, you can also use the Paging by posting
sequence option to set the page numbering up so that each new posting
sequence begins on a page 1.

5) To add a brief summary of the GL accounts affected by the posted documents to
the bottom of the report, turn the Print G/L distribution summary option on.

6) In the Destination field, click the down arrow to view a list of possible print
destinations. You can print to the Screen, to your Printer, or to a File.

Click Print when you are ready to begin printing the posting journal.

The posting journal files will be automatically cleared/ purged
when Year End is run (see page 3-101).

Adagio Invoices includes GL summary information about the posted documents at
the bottom of each posting journal report.
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Adagio Invoices’s archive module allows you to save a batch of invoices for later
recall and re-use. Here is a typical way you might use the module.

You have a number of customers or clients to whom you send identical invoices
monthly, changing only the date, invoice number and possibly text codes with each
billing. (Attorney retainers, club dues, and insurance premiums are just a few
examples of this kind of repetitive invoicing.)

You create a batch of original invoices for your first billing, and then archive the
batch before you post it. When it is time to send out these invoices again, you:

• restore the archived batch to current open batches,
• assign a new date based on the date entered in Adagio Invoices’s new date

field (e.g. the current date; the date you entered when you started Adagio
Invoices),

• print the invoices as if they were originals, and
• post the batch to update Adagio Receivables.

If you choose to restore an archived invoice, making it active again, you work with it
as you would any active invoice using the Open Invoice Batches function.
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Archive Invoice Batches
When you select Archive Invoice Batches from the Edit menu, the following screen
appears:

This function operates in the same way the Open Invoice Batches function does. If
you would like to create, edit, print, copy, or cancel any archive batches/invoices,
refer to Chapter 4, Invoicing, for complete instructions.

The only difference between this function and the Open Invoice Batches function is
that the Archive option which is available in the Open Invoice Batches function does
not exist in the Archive Invoice Batches function. Instead, the Restore option is
available. This option basically reverses the Archive action, making the batch(es)
and/or invoice(s) active again.

The following sections describe the Archive and Restore features in detail.
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Archiving Batches
The process for archiving invoices is much the same as that for copying batches or
invoices.

1) Select the batch in the Batch List window (Edit | Open Invoice Batches).

2) Click the Archive button. The Archive Batch dialog opens.

3) Click OK and the batch will be archived. The batch can now be seen on the
Archive batches list (Edit | Archive Invoice Batches)

You may archive invoices before or after printing.

You can also archive one or more invoices by selecting them on the active Batch
Invoice List and, while holding the left mouse button down, dragging your cursor
down to the white space below the last archive batch on the archive Batch List. Then,
release your left mouse button and follow the instructions above.

Restoring Archived Batches of Invoices
When you restore an archived batch of invoices, you recall a copy of the master batch
from archive storage.

The Restore function makes a copy of an archived batch and places it in the current
Open Batches window. The archived batch itself remains unchanged, ready to be
used again.

If you have updated any of your tax, text, and item information,
you MUST update your archive system prior to restoring archive
invoices in order for the restored invoices to reflect those changes.
For more information, see the following section entitled “Update
archive system”.
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1) Select Archive Invoice Batches from the Edit menu or click the Edit archived
invoices button. The Archive Batch List appears.

2) Select one or more batches to restore.
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3) Click Restore. The Restore Batch dialog box appears:

You are given several options in this dialog box:

Option Description

Move document Restores the batch(es) to the location specified in the
remaining fields on this screen, then deletes the
original batch(es).

Increment
document number

Click this option on if you want the document
numbers on the restored invoices to be incremented
automatically, as per your settings in the Company
Profile.

If you turn this option off, the restored invoices will
retain the same document numbers as the original
invoices.
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Option Description

Include payment You will only see this option if Accept payments? has
been enabled in the Company Profile (see page 3-20).

If payment information is stored with the invoice(s),
enabling this option causes the payment to
Auto-assign the new Invoice number as the Check
number on the new invoice's Payment tab.

Assign check
number

This option is automatically enabled when the
Include payment option is enabled. For invoices that
have stored payment information, Adagio Invoices
will Auto-assign the Check number on the new
invoice so that it is the same as the new Invoice code.

Revise date fields When this option is turned on, you are given the
opportunity to change the original document dates
for the restored invoices. If you click this option on,
the Invoice date field becomes active, defaulting to
the current date. Accept this as the date for your
restored invoices or click the Calendar button to select
a different date for the restored invoices.

NOTE: This date does not affect any dates that may be on
the Invoice Optional fields tab.

Open batch /
Archive batch

If you want to ensure that the restored batch will be
currently active, check that the Open batch option
has been clicked on. If you prefer to merely restore
this batch to the archive system (which is the same as
simply copying the batch, then), click the Archive
batch option.
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Option Description

New batch /
Multiple
new batches /
Existing batch

Select New batch to place the restored batch into an
entirely new batch. Use this option only when you
are restoring one batch.

If you are restoring multiple batches and you wish to
place each restored batch into its own new batch, click
the Multiple new batches option.

Click the Existing batch option to restore the batch
(or, specifically, the invoices in the batch) into an
existing batch.

If you select the Existing batch option, you must
enter a valid batch number in the field to the right of
this option. If you leave the batch number field
blank, Adagio Invoices will tell you that the batch
number is invalid. Click OK and enter a valid batch
number.

By default, Adagio Invoices will restore the selected batches to a new, active
batches, and will increment the document numbers.

4) Indicate your preferences for the restored batch(es) by editing the fields in this
dialog box.

5) Click OK to proceed with the restore process.

Adagio Invoices restores the selected batch(es), assigns a new batch number to
all restored batches, and adds the restored batch(es) to the Batch List with the
status Open. The batch(es) can now be manipulated (edited, printed, copied,
etc.) in the same way you would manipulate any other batch on the list.

You may want to rename the restored batches. See the section on
“Renaming an invoice batch” in Chapter 4 for more information.

You can also restore one or more batches by selecting them on the Archive Batch List
and, while holding the left mouse button down, dragging your cursor down to the
white space below the last batch on the active Batch List. Then, release your left
mouse button and follow the instructions indicated above.
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The selected date will not affect the dates in any optional fields you
may have created.

Restoring Invoices in an Archived Batch
1) Select Archive Invoice Batches from the Edit menu or click the Edit archived

invoices button. The Archived Batch List appears.

2) Select the batch that contains the invoice(s) you wish to restore and click Edit.
The Archived Batch Invoice List appears.

3) Select one or more invoices to restore.
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4) Click Restore. The following dialog box appears:

You are given several options in this dialog box:

Option Description

Move document Restores the invoice(s) to the location specified in the
remaining fields on this screen, then deletes the
original invoice(s).

Increment
document number

Click this option on if you want the document
number(s) on the restored invoice(s) to be
incremented automatically, as per your settings in the
Company Profile.

If you turn this option off, the restored invoice(s) will
retain the same document number(s) as the original
invoice(s).
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Option Description

Include payment You will only see this option if Accept payments? has
been turned on in the Company Profile (see page
3-20), you will see this option.

Turning this option on will cause any payment
information stored with the invoice(s) to be copied as
well.

Assign check
number

When you've turned Include payment on, above,
turn this option on to have Adagio Invoices enter a
different check number for the copied payment than
was used for the original payment.

The assigned check number will be the batch number,
followed by a hyphen, followed by the number of the
invoice within that batch. For example, if it’s the
second invoice in batch 20, the check number will
display as 20-2 unless/until you change it.

Revise date fields When this option is turned on, you are given the
opportunity to change the original document date(s)
for the restored invoice(s). If you click this option on,
the Invoice date field becomes active, defaulting to
the current date. Accept this as the date for your
restored invoice(s) or click the Calendar button to
select a different date for the restored invoice(s).

Open batch /
Archive batch

If you want to ensure that the restored invoice(s) will
be currently active, check that the Open batch option
has been clicked on. If you prefer to merely restore
the invoice(s) to the archive system (which is the
same as simply copying the invoice(s), then), click the
Archive batch option.
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Option Description

New batch /
Multiple
new batches /
Existing batch

Select New batch to place the restored invoice(s) into
an entirely new batch.

If you are restoring multiple invoices and you wish to
place each restored invoice into its own new batch,
click the Multiple new batches option.

Click the Existing batch option to restore the
invoice(s) into an existing batch.

If you select the Existing batch option, you must
enter a valid batch number in the field to the right of
this option. If you leave the batch number field
blank, Adagio Invoices will tell you that the batch
number is invalid. Click OK and enter a valid batch
number.

By default, Adagio Invoices will restore the invoices to new, active batch, and
will increment the document numbers.

5) Click OK when you are satisfied with the information in this dialog box. Adagio
Invoices restores the selected invoice(s).

You can also restore one or more batches by selecting them on the Archive Batch
Invoice List and, while holding the left mouse button down, dragging your cursor
down to the white space below the last batch on the active Batch List. Then, release
your left mouse button and follow the instructions indicated above.
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Update Archive Batches
This function allows you to update archive batches with the latest tax, text, and item
information.

If you have updated any of your tax, text, and item information, you MUST update
your archive system prior to restoring archive invoices in order for the restored
invoices to reflect those changes.

When using this function to affect the GL account-department of an
Inventory item (for example, the department of the Territory used in
the customer's ShipTo address code is to be used now), you must
ensure you also have the Category field checked in the Inventory
items fields box.

If a Department code is entered on the Territory record, it will
override any Department code that has been entered in the Location
record within Adagio Inventory. However, even if a Department
code is entered on the Territory record, it can be overridden by any
Department code within a ShipTo record being used.
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To use this function:

1) Select Update Archive Invoice Batches from the Maintenance menu. The
following window appears:
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2) First, you must enter the range of archive batches you wish to update.

Range Description

Starting batch
number / Ending
batch number

Enter the number of the first and last archive batch
numbers you want to update in these fields, or press
the Finder button to call up a list of possible batches
and select the starting and ending batches from the
Finder list that appears.

Remember that all batch numbers in between the starting and ending batches
will be updated, as well as the starting and ending batches themselves.

If you only want to update one batch, enter the desired batch
number in both the Starting and the Ending batch number fields.

3) This window has the following sections:

Section Description

Invoice fields The invoice header fields specified are updated
through the options in this section.

The ShipTo info field updates the ship-to
information from the Edit | Shipping Addresses
function if the shipping address code is not blank.

Customer fields You can also update several customer fields. When
you run this function, Adagio looks at the customer
file to see if any changes have been made to each
customer for whom an archive invoice exists. If so,
the archive invoice will be updated accordingly.

The Address checkbox updates not only the address
fields for the customer, but also the customer name,
phone, fax, and primary email address.

The ShipTo info checkbox updates the default
ship-to code from the customer file unless the ship-to
code is blank in the customer file. If the invoice
contains a ship-to code, but the default ship-to is
blank in the customer file, the existing invoice code
will not be replaced.
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Section Description

Item fields /
Inventory items
fields

You can update the specified fields for both Adagio
Invoice items and for Adagio Inventory items.

In the Invoice fields and Item fields sections of this
window, select all fields that you want to update.
These fields appear in the form of checkboxes; to
include a field in the update process, click the field
name once so that a checkmark appears in the box
beside the field. You can select any combination of
fields to be updated.

� If you only want to update one field, click only
that field on.

� If you want to update multiple fields, click each
field of interest to turn it on.

4) When you are ready, click Process. Adagio Invoices updates the batches using
the latest tax, text, item, and invoice information (pulling this information from
the relevant maintenance functions).

5) If the archive invoice totals will be affected by your selection. Adagio Invoices
will ask you to confirm the operation. Click Yes.

Adagio Invoices will update the requested field(s) and return you to the Update
Archive Invoice Batches screen.

Update Archive System’s effect on retainage fields

If retainage accounting has been activated in Adagio Receivables, the Invoice Totals
tab (see page 4-122) will display three additional fields which can be updated by the
Update Archive Invoice Batches function. They are:

• Ret. due date
• Retainage
• Retainage amount

Adagio Invoices follows these steps when updating these retainage fields in the
Update Archive Invoice Batches function:

1) First, Adagio Invoices looks at the default retention period and the default
retainage percent in your Adagio Receivables Company Profile.

2) Based on the information it finds in your Adagio Receivables Company Profile, it
calculates the above-mentioned retainage fields for your archived invoices.
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Please see the section on Retainage accounting information in Chapter 4 for more
information on how Adagio Invoices handles retainage accounting.
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Inquiries are read-only functions allowing you to quickly Find (using the Finder)
records, review information and scroll (using Previous and Next) from one record of
information to another. The ExcelDirect button is also available on most Inquiry
grids so you may quickly export to an Excel workbook (assuming Excel is installed)
all fields of information displayed on a particular inquiry grid. If you have access to
the Column Editor, you may change which fields of information display in the grid
(refer to the online Help documentation or your Adagio Fundamentals manual for
more information on working with the Column Editor).
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Historical Invoices
Adagio Invoices includes two ways to view historical invoices: from the Inquiries
menu and the Maintenance menu. The Inquiries function only allows you to view
the historical invoices without making any changes. The Maintenance menu allows
you to view the invoices, but also to restore and delete historical invoices.

If you want users to be able to view historical invoices without allowing them to also
delete or restore historical invoices, you can use the File | Security Group Setup
function to enable the Historical Invoices function on the Inquiries menu and
disable that function on the Maintenance menu. (Refer to the online Help
documentation or more information on security groups.)

Even if users have access to the Historical Invoices function, you
can still restrict all users from deleting historical invoices by
turning on the 'Disallow delete on history grid?' option in the
Company Profile (see page 3-20).

Selecting to Restore an invoice(s) displays a Restore Invoices window that functions
in the same way as Restore does from Archived Invoices (see page 5-161). However,
Restore from History Invoices provides two additional options:

• Revise addresses - Enabling this option will format the addresses of the
restored invoice to the format currently used within the customer record. for
example, if the BillTo address of the document in History is formatted but the
customer record's address is currently unformatted, enabling the option will
'unformat' the address in the newly created document. (Unformatted
addresses do not use the City and State/Prov fields.)

• Revise all - Enabling this option will not only update the new document
addressess per the customer's record, but will also update any changes made
to their Invoicing tab or ShipTo Addresses, as well as changes made to
Invoices or Inventory item prices. It should be used when the document being
restored contains ShipTo codes / price lists.
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Customers
This function gives you the ability to view customer information without editing
their records.

The Customer inquiry duplicates the screens in the Edit Customers function. Please
refer to your Adagio Receivables online Help documentation or manual for more
complete information.

Please note that, if you have been granted access in Adagio Receivables to Edit
customer notes but have not been granted access to edit customers within Adagio
Invoices, a special Edit Notes button will appear on the View Customer List
window. This button enables the user to create and edit notes only for the customer.
All other access is View only.

Please refer to your Adagio Receivables online Help documentation for detailed
information about this function

When highlighting a document within the Customer Transactions tab and you see a

button next to the Excel Direct button, it means that the document's
associated PDF file exists in the data's SOFTPDF folder. You may invoke the PDF
Viewer to see the document. Refer to the Adagio Invoices online Help
documentation for more information.

Customers
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I/C Items
The I/C Items and I/C Items with Sales and Cost functions are added to the
Inquiries menu when Inventory data having items exists.

These functions allow you to view information about Adagio Inventory items
without being able to edit the information. The Inquiry function gathers all
information about the selected items and places it in one window – on several tabs –
so that you can quickly find the information you need.

Selecting Inquiries | I/C Items displays all information about items except the cost
and sales data. Selecting Inquiries | I/C Items with Sales and Cost displays
information that is not available in the Edit Items function, including more tabs to
allow for the cost and sales data.

To view items without displaying the cost and sales totals, select I/C Items from the
Inquiries menu. The Items list opens. This window lists all items currently in your
database.

Select the item in the list that you want to view, then click the View button. The Item
Inquiry window opens.

You will notice that this window has Next and Previous buttons. Click the Next
button if you want to view data for the next item in the Item list. Click the Previous
button if you want to move backward in the Item list.

Remember that the fields in this window cannot be edited. The
Inquiry function is used only to view items. If you need to edit an
item, you must do so via the Edit I/C Items function.

Most of the information displayed in the Items Inquiry window was created when
you added the item to your inventory through Adagio Inventory or the Edit I/C
Items feature in Adagio Invoices. The Item Inquiry window has several tabs, which
are described below.

Tab Description

Profile The Profile tab displays general information about the
item, including the item number, category code, unit
weight, tax status and additional information. This tab is
used primarily for identifying the item.

I/C Items

Page 6-176 Adagio Invoices

Note



Tab Description

Units/Pricing The Units/Pricing tab displays information about
stocking units, pricing units, costing units and alternative
units.

It also includes the pricing system for the item, with
details on the item’s discount or markup pricing system.

Sales/Shipping The Sales/Shipping tab contains sales information
including pricing units, base price, previous price and
sale price.

It also includes shipping information, with last shipment
date, last receipt date, average shipping days and
average units shipped.

Quantities This tab displays all locations allowed for the selected
item, with quantity on hand, picking sequences and other
data, for each location. Grand totals for the item are
displayed at the bottom.

Vendors The Vendors tab displays the primary and secondary
vendors for the selected item.

Alt Prices Units This tab displays alternate units and alternate pricing for
the selected item.

Alt Items This tab displays all alternate items, which are shipped in
replacement of “out of stock” items.

Notes/Alerts This tab displays all notes that have been saved for this
item.

Optional If you have entered optional fields in the Adagio
Inventory Company Profile, this tab will appear,
displaying those optional fields as you entered them in
Adagio Inventory’s Company Profile.

Image This tab displays the image that has been assigned to this
item, if any.

I/C Items

Inquiries Page 6-177



Tab Description

Additional tabs for I/C Items with Sales and Cost inquiries only

Sales History This tab lists the sales history for the selected item,
including quantities sold, sales amounts and actual costs
for each financial period.

Costing The Costing tab gives details on costing for the selected
item, including costing unit, standard cost, recent cost
and costing method.

Reorder Data This tab lists all the reorder data for the selected item
including minimum and maximum levels, reorder
quantities and projected sales.

Alt Prices/Cost The Alt Prices/Cost tab gives alternate price list data,
including pricing and costing.

Purchase Orders This tab only displays if Adagio PurchaseOrders data
also exists. It allows you to view all types of purchasing
document transactions, sorted by document type and
code within type. The Current documents grid displays
all documents located in the current documents of
Purchase Orders. Those documents that have were
previously archived in Purchase Orders display in the
Archived documents grid. Both grids may be edited
using the Column Editor (see the online Help
documentation for more information on using the
Column Editor).

When highlighting a transaction within the CTransaction History tab and you see a

button next to the Excel Direct button, it means that the transaction's
associated PDF file exists in the data's SOFTPDF folder. You may invoke the PDF
Viewer to see the document. Refer to the Adagio Invoices online Help
documentation for more information.

I/C Items
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Batch Status Inquiry
Batch status inquiry functions give you batch information such the total number of
batches entered or imported and the total dollar amount of all batches; plus a
breakdown of batches by status (open, printed, posted); and more. There is one
inquiry function for each type of batch: Invoices and Archived Invoices.

To conduct a batch inquiry, go to the Inquiries menu, highlight the Batch Status
option, and select either Invoices or Archived Invoices, depending on the kind of
batches you wish to review. The inquiry screen appears:

The first set of information you’re given, in the upper, left-hand corner of the
window, is a list of batch information according to the type of batch (entered or
imported). This first grid tells you:

Column Description

Type The kinds of batches: Entered or Recurring

Batches The number of batches of each type

Entries The total number of entries in each batch type

Batch Total The total dollar value of all batches of each type

Batch Status Inquiry
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The second set of information you’re given appears in the upper, right-hand corner
of the window. This list is based on batch status.

Column Description

Status The batches by status: Open, Printed, or Posted

Batches The number of batches of each status

Entries The total number of entries for each batch status

Batch Total The total dollar value of all batches for each status

Finally, you’re given a third set of information, which appears in the lower portion of
the screen. This is a list of all batches in the database, and provides information on:

Column Description

Batch The batch number

Description The batch description

Entries The number of entries in the batch

Created The date the batch was created

Last accessed The date anyone last opened, edited, or viewed the batch

Status The status of the batch: open, printed, or posted

Batch Total The total dollar value of the entries in the batch

The batch inquiry feature is useful if you want a quick view of total dollar amounts,
numbers of batches being processed, and so on. It simply encapsulates some useful,
general information about the batches for a quick, on-screen overview.

Batch Status Inquiry
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Adagio GridView
Users of Adagio GridView and Adagio Invoices can add views to the Inquiry menu
in Invoices.

To use this feature, create a Workspace in GridView containing one or more Views
and save the Workspace (.gvs) and Views (.gv) it uses to \Softrak\Invoices\Views.

Adagio GridView
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Adagio Invoices provides you with a wide variety of reports that you can use for
monitoring and managing your invoicing activities. Most of the reports are available
from the Reports menu.

The Adagio Fundamentals manual includes general information on printing reports,
and describes the report printing options such as shading for headers and footers
found in User Preferences. This chapter outlines specifics about the reports included
in Adagio Invoices.

The following pages explain the purpose of each available report and how to print
each report. The reports include:

• Invoice Listing
• Tax Summary
• Tax Tracking
• History Listing
• Deleted Invoices Audit List
• General Reports - Batch Status
• General Reports - Company Profile
• General Reports - Tax Tables
• General Reports - Item Listing
• General Reports - Text Listing
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Preferences - Report Options
Adagio Invoices gives you control over the format of all reports. The Report Options
allow you to set date and time formats, toggle headers and footers, and add shading
to your reports.

To access the report options, select User Preferences and the Report Options tab
from the File menu. For more information about the report options, see your online
Help documentation or your Adagio Fundamentals manual which describe this feature
in detail.

Preferences - Report Options
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Invoice Listing
This report summarizes the contents of each invoice in an unposted batch/archive
batch (or range of batches). It details header information, line item listings, and
invoice and batch totals.

You can use this report to check the accuracy of all the invoices you have entered
before you print and post them, and to review the contents of archived invoices.

This report includes the following options:

Field Description

Report type Click the down arrow to the right of this field to view
your options.

� If you want to print a listing of your currently
active batches, select Batch listing.

� If you prefer to print a listing of your archived
batches, select Archive listing.

Starting batch
number / Ending
batch number

The Starting and Ending batch number fields allow
you to specify which batches you want to include in
the listing. To change the default values in these
fields, simply type the desired batch numbers in each
field. Or, click the Finder button and select the batch
numbers of interest from the lists that appear in each
field.

Sort by Customer Click the Sort by Customer option on if you want the
report to sort the invoices by customer and provide a
total for each customer. Otherwise, click this
checkbox off and the invoices will be printed in the
order they were entered. (By default, this option is
turned off.)

Page break on
change of batch

When this checkbox is turned on, the program will
insert a page break after each batch, so that each batch
starts on its own page.

Invoice Listing
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Field Description

Paging by batch
number

This checkbox allows you to set the page numbering
up so that the page numbering for each new batch
starts with page 1.

NOTE: This field is not available if the Page break on
change of batch field is not turned on, since pagination
can’t be restarted unless a page break occurs.

Print G/L dist.
summary

Enable this option to print a summary of the GL
distributions by account in this listing report. The GL
distribution summary by account is included at the
end of the report or, if Page break on change of batch
is also enabled, at the end of each batch listing in the
report.

Only the Batch Listings can be sorted by customer number, not the
batches themselves.

You can also print the batch listings from the Open Batches
windows directly. For more information on this, see “Printing
Batch Listings” on page 4-145.

Invoice Listing
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Tax Summary Report
This report details the taxes levied for each jurisdiction in each tax group for every
invoice posted. Taxes are broken down by item category and by customer category.

This report includes the following options:

• In the Starting tax group field, enter the first tax group you wish to include on
your report. If you want to view a complete list of possible tax groups, click
the Finder button to activate the Finder; select the Starting tax group from the
list that appears.

• In the Ending tax group field, enter the last tax group you wish to include on
your report. Again, you can use the Finder in this field to select the Ending
tax group from the Finder window.

• Turn the Exclude tax groups with zero tax option on to instruct Adagio
Invoices to omit printing those tax groups that haven't incurred any taxes.

If you printed a hard copy of your Tax summary report, or printed the report to a
file, Adagio Invoices will ask you if you want to clear the Tax summary. Select Yes to
clear the tax summary report or No to bypass this option and return to the menu bar.

The tax summary report must be cleared prior to editing your tax
tables and/or tax groups.

You will not be given the option to clear the tax summary report if
you printed the report to your screen.

Tax Summary Report
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Tax Tracking Report
This report prints tax information on invoices and credit notes. This report’s focus is
on tax data that would be used for tax reporting purposes.

Select Transaction Reports | Tax Tracking from the Reports menu to open this
report dialog. The following report dialog will appear. Click on any of the fields,
radio buttons, or other options in the screen image below for detailed information on
the options presented to you here.

Field Description

Report as of Enter a range of dates for the report or use the Calendar
button to select the Starting and Ending dates from. Tax
tracking data included on the report will be based on
invoices and credit notes on file having dates within the
range and including the dates selected.

Report format You can either print the report in a more comprehensive
Detail format, or in a more terse Summary format.

Sort by Select your sort preference in these fields. You can sort
the report by Tax group or Jurisdiction.

The Starting and Ending fields allow you to specify
which information you want to include in the report To
change the default values in these fields, either type the
information in each field or click the Finder button and
select the appropriate information from the values
displayed.

Include tax status
summary

Turn this checkbox on if you want a summary of the tax
amounts for each tax status printed at the end of the
report.

Once the report has printed using the Print button, you will be asked if you want to
clear the tax tracking data that was included on the report. If so, click Yes and the
data will be cleared, and you will receive a message advising you of that fact.

Tax Tracking Report
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History Listing
This report summarizes the contents of each historical document. It details header
information, line item listings, and document and batch totals for posted documents.

This report includes the following options:

Field Description

Starting Date /
Ending Date

These two fields allow you to determine the range of
invoices by document date. Type in the desired
starting and ending dates, or click the Calendar
button beside each of these fields to select the
preferred dates from the on-line Calendar.

Starting Customer /
Ending Customer

These fields allow you to specify the invoice range
according to customer number. Either type in the
desired starting and ending customers, or use the
Finder button to select the correct starting and ending
customer numbers from the Finder window.

If you want to include all of the customers on your
report, the Starting Customer field should be blank
and zzzzzz should appear in the Ending Customer
field. This is the default.

If you only want the report to display one Customer,
enter that customer’s code in both fields.

Starting Document
no. / Ending
Document no.

These fields allow you to narrow the invoice range by
document number. Enter the desired starting and
ending document numbers in these fields, or click the
Finder button and select the correct starting and
ending document numbers from the list that appears.

If you want to include all of the documents on your
report, the Starting Document no. field should be
blank and zzzzzzzzzzzz should appear in the Ending
Document no. field. This is the default.

If you only want the report to display one document
only, enter that document number in both fields.

History Listing
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Field Description

Transaction types Select whether the report should print All document
types that meet the selection criteria, only Invoices or
only Credit notes.

Sort by Adagio Invoices allows you to sort the invoices by
Customer number or Invoice number. This field
defaults to Customer. If you wish to change this
setting for this one time, click the down arrow to the
right of this field and select the preferred sort order
from the drop-down list that appears.

If you want to change the default sort order, do so in
the Sort history invoices by field in the Company
Profile.

History Listing
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Deleted Invoices Audit List
This report provides you with a printed copy of all invoices, retainage invoices and
credit notes that have been deleted within current invoice batches. It contains the
following information:

• document type
• document number
• customer code and name
• invoice date
• total
• batch number
• comment
• deleted by
• deleted date.

Statuses reported are:

• Deleted
• Doc type change (eg. an invoice documented is edited and its document type

is changed to credit note)
• Batch Deleted
• Batch Moved (if entire batch is moved to a new batch within current invoice

batches)
• Moved (if document is moved within the same batch and number is

incremented)
• Renumbered (if document number is changed).

Deleted Invoices Audit List
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Batch Status Report
This report is found in the Reports | General Reports menu. The Batch Status report
allows you to print batch logs for both invoices and archived invoices. It provides
key information on the contents and status of each invoice (or archived invoice)
batch. This report includes the following options:

Field Description

Batch type Click the down arrow to the right of this field to view
your options. Select Current batches if you want your
report to contain active batch information. Select
Archived batches to include only archived batch
information.

Starting batch
number / Ending
batch number

The Starting and Ending batch number fields allow you
to specify which batches you want to include in the
listing. To change the default values in these fields,
simply type the desired batch numbers in each field. Or,
click the Finder button and select the batch numbers of
interest from the lists that appear below each field.

After printing, If your report included posted or canceled batches, and if you printed
your report to a printer or to a file, Adagio Invoices will ask if you want to purge the
selected completed batch information. Select Yes to purge those batches or No to
retain them in the file.

You cannot purge batches from this report if you merely print the
report to your screen. You must print the batches to your printer or
to a file before they can be purged.

Company Profile Report
This report is found in the Reports | General Reports menu. It provides you with a
printed copy of the information stored in your Adagio Invoices Company Profile. It
includes details on how your invoice numbers and text blocks are set up, whether or
not you are using continuous forms, whether or not your footers are fixed, what text
will be printed for zero detail amounts, and what names have been assigned to your
item styles. It also shows the fields you have activated to display on both your Item
List and your Invoice List.

Batch Status Report
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Tax Tables Report
This report is found in the Reports | General Reports menu. It prints the Adagio
Invoices tax tables. For each tax group it shows jurisdiction information, and it also
shows item and customer tax rates for each jurisdiction.

You can set the following options for this report:

• In the Starting tax group field, enter the first tax group you wish to include on
your report here. If you want to view a complete list of possible tax groups,
click the Finder button to activate the Finder and select the Starting tax group
from the list that appears.

• In the Ending tax group field, enter the last tax group you wish to include on
your report. Again, you can click the Finder button to activate the Finder and
select the Ending tax group from the list that appears.

Item Listing
This report is found in the Reports | General Reports menu. It provides you with a
detailed listing of the information stored for each item in your line item database. It
shows the item code, name, and style assigned to each line item. It also shows the
fields and default values you have entered, and the Clear Subtotals settings for each
line item in the database.

This report includes the following options:

Field Description

Report type Click the down arrow beside this field to view your
options.

� Summarized: Prints a concise summary of all of
the items. This report provides most of the
information found in the detailed item listing, but
the information is abbreviated and appears in a
table format. It shows the fields included for each
code, the G/L account number and department,
and any Clear Subtotals settings.

� Detailed: Prints complete, detailed information
about your items.

Select the level of detail you prefer by clicking it once.

Tax Tables Report
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Field Description

Starting item code /
Ending item code

The Item codes fields allow you to specify which
items you want to include on your report. Enter the
first and last item codes you want to include on your
report in these fields. Alternatively, you can click the
Finder button beside each item codes field to call up
the Finder and select the desired item from the list
that appears.

Text Listing
This report is found in the Reports | General Reports menu. It prints the text blocks
you set up using the Edit | Text function. For each text block, the report shows the
text code assigned and the individual lines of text included in the block. The report
also lists the default text code that came with the program.

In the Print Options section, you can edit the Starting and Ending text code fields.
These fields allow you to specify which text blocks you want to include on your
report. Enter the first and last text codes you want to include on your report in these
fields. Alternatively, you can click the Finder button beside each text codes field to
call up the Finder and select the desired codes from the list that appears.

Posting Journal
This report is found in the Post menu. The posting journal provides you with a list of
the invoices you have posted. If you would like to print or purge the posting journal,
you will be given these options:

Option Description

Starting posting
sequence / Ending
posting sequence

These numbers are assigned to the batches you have
posted, incrementally. To change these numbers,
enter a new value of the default in each field.

Text Listing
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Option Description

Sort by Click the down arrow beside this field to view your
sort options:

Customer number
Document date
Document number

Select the preferred sort order by clicking it once.

Page break on
change of post. seq.

If you want to insert a page break after each posting
sequence number, so that each sequence number
starts on its own page, turn this checkbox on.

Paging by posting
sequence

Then, if you have turned the above option on, you
can also use the Paging by posting sequence option
to set the page numbering up so that the page
numbering for each new posting sequence starts with
page 1, if you wish.

Print G/L
distribution
summary

To add a brief summary of the GL accounts affected
by the posted documents to the bottom of the report,
turn this option on.

Posting Journal
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Custom Reports
Users of Crystal Reports 2011 and higher can create custom reports and have them
appear on the Reports menu in Adagio Invoices. This allows users to print, preview
and export custom reports without needing to run Crystal Reports. This saves you
from having to start Crystal Reports, find the desired report, and use the Set Location
or Verify database functions if the report is printed for multiple companies.

This feature requires that the site have a copy of SAP's Crystal
Reports 2011 or higher installed in order to access the designer and
write the custom report.

Run-time parameters can be used for ranges and dates. They are usually required
because in most cases you want to select data rather than print all information in the
file. You will be prompted for the parameters when you print a custom report that
uses Run-time parameters.

Custom reports do not have to be limited to reports for Adagio Invoices. They can be
for any Adagio application, although you may want to separate your custom reports
by application.

Security Groups in Adagio are supported, allowing you to restrict certain users from
printing custom reports.

Refer to the online Help documentation for more detailed information.

Custom Reports
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Adagio Invoices allows you to import and export items as well as invoices, credit
notes and retainage invoices through the Import and Export functions on the File
menu.

Certain format requirements must be met for importing invoices and items. If these
requirements are not met, Adagio Invoices will not accept the invoice or item. The
following section, Import format requirements, will discuss these requirements fully. It
should be noted that the export of invoices and items follows these same
conventions.
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Using Templates
At the top of all import and export windows, you will see a Template field, followed
by several related buttons.

Templates are used to save certain import settings, so that if you regularly import
files using the same settings, you can save those settings in one template and just call
up that template each time you have a file to import, rather than selecting the
appropriate settings each time around.

For items, there is one default template. For invoices, there are seven default
templates.

One possible reason to modify the default template and save it
under a new name would be to include cash payment information
along with the invoice. There are a number of fields that would be

Using Templates
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added to your template to accommodate payment fields in the
import file.

The last template you used or saved is the default template that is initially selected
on entering this function. If you have other templates on file, you can click the down
arrow in the Template field to select a different template, or you can create a new
one. Information on modifying the import options for new templates can be found in
the following sections.

Use the buttons to the right of the Template field to work with templates. Your
options are:

Button Description

Save Allows you to save any changes you make to the settings for
the current template, as displayed in the Template field.

NOTE: You cannot modify a default template and save changes to
it. If you need a modified template, create a new one instead.

Delete Allows you to delete a template from the list of available
templates.

NOTE: You cannot delete a default template.

Save As Allows you to save the settings of the current template as a
template with a different name, for example, to save changes
to a default template.

New Allows you to create a new template with no previously
selected import fields in it. You will be prompted to enter a
name for the template. After you select the import fields,
you will want to save the template.

Templates can be printed, allowing you to save a hard copy of your import settings
or to check the settings with the import file. To print a template, simply click the
Print button in the lower, right-hand corner of the window.

Using Templates
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Importing
If you have already created items or invoices, credit notes and/or retainage invoices
in other programs and wish to import them into Adagio Invoices, you can do so via
the Import feature on the File menu.

Whether you're importing invoices or items, the import function works in essentially
the same way. As described earlier in the Templates section, you can choose an
existing template or create a new one. Then you will move on to the fields in the File
Information tab.

When using the Import | Invoices function, after clicking the Import button, you
will be prompted for whether you want to import to an Open or Archive batch.

We recommend you make a backup of your Adagio Invoices data
prior to performing any imports of data to Invoices. Refer to your
online Help documentation or Adagio Fundamentals manual for
detailed information on using the Backup function.

Import File Information Tab
The screen images in this and related topics will explain the import windows, and
will use the Import Items function as the primary example. Many of the fields in the
exporting function are also the same as those found in the Import function.

Importing
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This tab allows you to select the file type and file name to be imported, and to set
certain import options. Not all options appear on all imports.

Use the information in the table below to work with the options on this tab:

Field Description

File format Select the format of the file you are importing (or
exporting to) from the drop-down list that appears.

File name Enter the path (drive and directories) and file name of
the customer files to be imported. You can click the
folder button to browse to and select the file.

Header included? Check this box if the first line of the Import file
should be ignored (because it's a list of column titles).

Overwrite records? Turn this option on if you intend to overwrite Adagio
Invoices records with the imported data.

Add new records? Select this option if you want to add new records that
are contained in the import field in addition to (or
instead of) updating existing ones.

Validate before
importing?

Turn this option on if you wish to perform a validity
check of all imported records. If selected, the system
checks for existing records, checks the validity of all
coded values, and checks that all imported data is
valid (dates, numbers in ranges, etc.). If any errors
are found in the import file, the import process will
be halted, and you will have a chance to fix the
problems before importing the files.

If you don’t select this checkbox, a check for valid
codes is still carried out, but it occurs during the
import process. When invalid entries are found, the
import process is stopped and you are asked if you
want to continue. Validating records prior to
importing is a safer and easier way to conduct the
import process.

NOTE: If you select to perform validity checks the import
process will be slower as you will be required to respond to
prompts.

Importing
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Field Description

Separator Specify the CSV (comma separated value) symbol to
use. The default is a comma.

Use extended
character set?

If your import file contains characters in the extended
character set, such as the French accented characters,
be sure to turn this option on. When this option is
activated, those characters will be imported properly.
When the option is turned off, the imported record
will simply be halted or skipped, depending on the
whether you have turned the Validate before
importing? option on or not

Delete import file
on success?

Turning this option on will automatically delete the
file after it is successfully imported. If left off, the
import file will remain in tact and may be used again.

NOTE: It's a good idea to turn this option on if you also
turn on the Auto-import on startup option. This
prevents files from accidentally being imported multiple
times.

Auto-import on
startup

To successfully use this feature, you must:

� create an Import Template that has the feature
turned on, and

� turn on the On Start up … Process Imports
feature in the Company Profile, System Options
tab (see page 3-20 for more information).

Import to archive
batches?

When importing invoices, you may import to Open
batches or to Archive batches.

Enable this option to import invoices to a new
Archive batch.

Importing

Page 8-203 Adagio Invoices



Import Field Selection Tab
This tab allows you to select the fields you wish to import.

The fields listed on the left side of the screen are the fields which you can include in
the import; the fields listed on the right side are already selected and will be included
in the import.

To use this window:

• Select a field that is included in the import file from the Available fields list
by clicking on it.

• Click the single right arrow button to move it into the Selected fields list. You
can remove a field from the Selected fields list back to the Available fields
list by clicking on it and then clicking the single left arrow button.

• Continue moving fields until all desired fields are listed in the Selected fields
list. You can use the double right arrow to move all fields at once into the
Selected fields section, or the double left arrow button to remove all fields
from the Selected fields section.

• In cases where the import file contains fields you do not wish to import, click
the Filler button to add a filler for that field.

Importing

Importing and Exporting Page 8-204



• You must order the fields in the Selected fields list to the order they appear in
the import file. Sort the fields (first on top, last on bottom) by selecting a field
and then moving it up one position in the list by clicking the up arrow button,
or moving it down one position in the list by clicking the down arrow button.

The properties for the fields to be imported are indicated at the bottom of the screen.
The properties are described in the following table:

Field Description

Name Displays the name of the selected field. This field is
for your information only and cannot be edited.

Type Displays the type of the field - either a string of
characters, a date or a number. On the Import and
Export Field Selection tabs, some field types (eg.
Date field types) allow you to select the Type
specifics from the dropdown.

Width Displays the default width of the selected field.
Depending on the field selected, this may be edited.

Field number Indicates the field number according to its order in
the selected fields.

Field offset Enter the position of the character at which the
reading of this field is to begin. This allows
importing of only certain characters within a field.

Importing
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Import Field Defaults Tab
This tab allows you to set default values for any fields that are not contained in the
import file itself. Values you enter here will be set for every record that is imported.

To set a default for a field, select the field from the Fields not imported list by
clicking on it. Move it to the Default Fields list by clicking the right arrow. (It can
also be removed from the Default Fields list by clicking the left arrow.)

Continue moving fields to the Default Fields list until all desired fields are listed in
that section of the window.

For each field in the list, you can change the properties. To do so, click on the field in
the Default Fields list, and then move to the fields at the bottom of the window.
They are:

Field Description

Name The name of the field for which you will be providing a
default value. This field is for your information only, and
cannot be edited.

Importing
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Field Description

Type The type of field: either a string of characters, a date, or a
number. This field is for your information only, and
cannot be edited. You will want to note the field type
when entering the default value.

Value Depending on the type of field selected, you will either
enter a default value for the field here or select the value
from a dropdown or calendar. This value will be used for
all records imported.

Width The maximum number of characters in the field. For
example, a invoice number contains 12 characters. This
field is for your information only, and cannot be edited.

You can click the Print button to print and save a hard copy of your import (or
export) template settings or to check the settings with the import (or export) file.

Running the Import
When you are finished editing the tabs in the Import window as necessary, and have
saved the template, click Import to proceed. The records will be imported as per your
specifications.

When using the Import | Invoices function, after clicking the Import button, you
will be prompted for whether you want to import to an Open or Archive batch.

Detailed information regarding Import and Export File Format
Requirements can be found in the Adagio Invoices online Help
documentation.

Importing
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Exporting Invoices or Items
If you have already created Adagio Invoices items or invoice batches and wish to
export them from Adagio Invoices, you can do so via the Export function on the File
menu. This can be a useful way to get the information into other Adagio datasets or
programs.

The export process is essentially the same whether you are exporting items or
invoices.

From the File menu, select Export | Invoices. The following window appears.

the top of this window displays a Template option. This template allows you to save
the export options you select into a template file for use another time. Once you have
selected the Export options you want, click the New or Save As button and enter a
template name. Future exports can then be performed by selecting the export
template, saving you the time of re-entering configuration information. Please refer
to page 8-199 for more information about templates.

Templates can also be deleted or saved under other names via the buttons to the
right of the Template field.

Exporting Invoices or Items
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In the File Information tab displayed above, you have the following options to
export customers:

Field Details

File type Adagio Invoices records can be exported and
read by other programs. The following file
formats are the export menu options:

� Excel
� ASCII CSV (Delimited)
� ASCII Fixed Length
� PSV delimited file

File Name Select the default location or indicate a new
location for the file.

� For exporting, this is the file the exported
records will be written to.

Header included? Select this option if you want to export the
field names.

Overwrite existing
file?

Select this option if a previously exported to
file is to be overwritten.

CSV Separator The default is a comma which means data can
be read correctly by, for example, text
programs or Excel. You would enter the
separator required to separate fields for the
software you intend to use to read the data.

Exporting Invoices or Items
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After you have completed the File Information tab, click the Field Selections tab:

On this screen you can select the fields you want included in the export by clicking
on the right arrow button. You can also remove fields via the left arrow button.
Double-headed arrows allow you to add or remove all fields at once.

Fields can be reordered by the up and down arrows to the right of the Export fields
box.

You may enter the width of the field by entering an amount in the Width field. This
may be useful if you know that the program you are exporting to requires a certain
field length.

As well, you can indicate the type of data you are exporting for each field, using the
Type field. Adagio Invoices will select a data type for you, by default, but this can be
changed for some fields if necessary.
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After you have made your export selections, you can print the export template using
the Print button. You can also click on the Save button to save your choices. Then
click on the Export button to export the data.

Depending on the type of export you are performing you will taken to an Export
window as follows:

Exporting Items

Specify the Starting and Ending item code (or select from the Finder) for the range of
Invoices item codes you want to export. Then, click the Export button to begin the
export.

Exporting Invoices

The following options appear when exporting invoices:

Field Description

Open batches /
Archive batches

Click the radio button that indicates the type
of batch to be exported.

Invoices starting /
ending batch

Use the Finder button to select the starting
and ending range of batches to be exported.

To export all batches, leave the starting field
blank and enter zzzzz in the ending field.

Exporting Invoices or Items
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Field Description

Include invoice
nos.

Turn this option on if you wish to include the
invoice numbers in the export file.

If you leave the option off and subsequently
import the exported invoices into another
data set, new invoice numbers will be
assigned on import.

Customer
information

Turn this option on if you wish to include the
customer information in the export file.

Text information If you want to include the text information in
the export file, turn this option on.

Detail information Turn this option on to include the invoice
detail line information in the export file.

To export an invoice in its entirety, ensure that all four of the 'checkbox' options are
turned on. This is the default.

Click the Export button when you are ready to proceed.

Exporting Invoices or Items
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In this tutorial, we will cover a typical tax scenario. We will assume that you are
opening a store in one sales area. As your sales grow, you decide to open another
store in another sales area. Each store collects taxes for different jurisdictions.

We will begin by setting up a tax group for the first store. That tax group includes
two jurisdictions that levy taxes.

Then, we will set up a tax group for the second store. That tax group again includes
two jurisdictions, but this time the jurisdictions are different.

When you have completed this part of the tutorial, you should feel comfortable with
the basic concepts involved in setting up your own tax tables.
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Single Retail Outlet
You have a small retail gift shop located in a major city. You sell products, and most
items you sell are taxable by two jurisdictions:

• the state levies a sales tax of 5%
• the city levies a sales tax of 1%

Along with the gifts you sell, which are all taxable, you sell coffee beans. Coffee
beans are considered a food item by both jurisdictions and, therefore, are not subject
to sales taxes by either jurisdiction.

All sales other than coffee beans are taxable unless your customer is exempt from
paying some or all taxes.

There are only three classes of customers who are tax-exempt in your store:

• those who purchase a product for out-of-state delivery,
• those who have their own sales tax licenses and are purchasing from you for

resale, and
• churches and other non-profit agencies that hold a general exemption.

As a general rule, then, all sales that you make are taxed under a single group of
taxes unless they are exempt from taxes because of:

• a special item tax status (coffee beans), or
• a special customer sales tax status (out-of-state, resale, and non-profit).

To set up Adagio Invoices tax tables for this gift shop, you will define:

• a single tax group that levies taxes for two jurisdictions:

• 5% for the state, and
• 1% for the city tax. For the purposes of this example, we’ll use the

name of the default U.S. tax group provided with Adagio Invoices,
tax group USA.

• two Item Tax Types:

• Taxable Item, a category for regular, taxable items, and
• Non-taxable Item, a category for coffee beans and other tax exempt

items.

• four different Customer Tax Types:

• Regular, a category for regular, taxable customers,

Single Retail Outlet
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• Out-of-state, a category for those customers purchasing for
out-of-state delivery,

• Resale, a category for those customers purchasing for resale, and
• Non-profit, a category for exempt non-profit organizations.

With this scenario in mind, follow these steps to set up your first gift shop’s tax
tables.

Developing a Tax Table Prototype on Paper
1) List the names of the item and customer tax categories you plan to use:

Item Tax Types: Taxable
Non-taxable

Customer Tax
Types:

Taxable
Out-of-state
Resale
Non-profit

2) List the sales areas your company services:

One sales area: Local

3) List the taxing jurisdictions that levy taxes on your sales in the first sales area:

Two jurisdictions: City
State

4) Define the tax rules and rates that apply to the various categories of items you
may sell in the first jurisdiction, the City:

Item categories: The tax rules are straightforward. Food items are exempt from
tax. All other item sales are taxed at 1%.

Taxable: 1%

Coffee beans are considered food; food is non-taxable.

Nontaxable: 0%

Single Retail Outlet
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5) Define the tax rules and rates that apply to the various categories of customers
you may do business with in the first jurisdiction.

Customer categories: The tax rules are straightforward. Customers who fall into
one of the three exempt classes are not taxed. All others are taxed on sales at 1%.

Regular customers: 1%

Out-of-state: 0%

Resale: 0%

Non-profit: 0%

6) Repeat Steps 4-5 for the next jurisdiction.

For the second jurisdiction, the State:

Item categories: The tax rules are identical to the City rules; only the rates are
different. Food items are exempt from tax. All other item sales are taxed at 5%.

Taxable : 5%

Coffee beans are considered food; food is non-taxable.

Nontaxable : 0%

7) Define the tax rules and rates that apply to the various categories of customers
you may do business with in the first jurisdiction.

Customer categories: The tax rules are identical to the City rules; only the rates
are different. Customers who fall into one of the three exempt classes are not
taxed. All others are taxed on sales at 5%.

Regular customers: 5%

Out-of-state: 0%

Resale: 0%

Non-profit: 0%
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Step 7 doesn’t apply to this situation because all sales for the store
are in a single sales area.

Armed with this information, we can set up the tax tables.

Setting Up the Adagio Invoices Tax Tables

Defining your jurisdictions
1) Select Tax Type from the Edit menu or click the Tax Type button on the Button

Bar.

If you have open batches or have not purged your tax summary report, the
following warning will appear.
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Select No to exit this function and post your batches and/or purge the tax
summary report. Then return to this function. The warning will no longer
appear. Instead, the following screen will appear:

You will use this screen to list the various customer and item category headings
(from Step #1) that Adagio Invoices will display on the tax tables. The default
headings are satisfactory for the item tax categories, but you will need to set up
different headings for the customer tax categories.

2) In the first field (Field 0) of the Customer Tax Types column, type Taxable
Customer. Press Tab to move to the next field.

3) Type Out-of-state in Field 1, Resale in Field 2, and Non-profit in Field 3. Press
Tab after you type in each category heading, to move into the next field.
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4) Your screen should look like this when you finish:

5) Click OK to save your changes and exit this function.

6) Select Tax Tables from the Edit menu or click the Tax Tables button on the
Button Bar. The following screen appears, listing the existing tax groups:

Single Retail Outlet
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7) There are two tax groups on the Tax Group list, the default groups STATE and
CANADA. Double-click STATE to select it. The following screen appears:

8) Check the Description to make sure it is satisfactory. For the purposes of this
tutorial, we will not change this description, but when necessary, you can enter a
different description. This field is particularly helpful if you have many tax
groups and you need a more detailed description to tell one from another on a
list of groups.

9) Click the City tab to edit the first default jurisdiction (taxing authority) that
belongs to this Tax group.

10) Check the values in the Minimum and Maximum fields. Since there is no
minimum or maximum tax in this state (for the purposes of this tutorial), leave
these default values as is; taxes will be calculated for the entire range of possible
sales.

11) In the GL Acct field, enter 2400 to indicate the taxes will be posted to Account
#2400, County sales tax payable. You can also click the Finder button in this field
and choose the appropriate GL account from the list that appears.

You must enter an account number; the program will not be able to
post properly without one.

Since your store does not use departments, leave the GL Dept field blank.

12) Click the down arrow to the right of the Tax base field to view your options for
this field.
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13) Click Item price from the drop-down list that appears, to select it, because taxes
are based on the selling price of an item. Adagio Invoices enters your selection in
the Tax base field.

14) Since taxes levied by the state aren’t taxable by any other authority, leave the
Taxable checkbox off.

15) In the Customer Tax Rates section of this screen, click the first field to edit the
tax rate for a Taxable Customer.

According to our tax table prototype, the tax rate for a Taxable Customer should
be 1%, so enter 1 in this field. Press Tab to move to the next field.

16) The tax rate is 0% for each of the remaining three categories of customers. In the
Out-of-state, Resale, and Non-profit fields, type 0.

17) Now move down to the Item Tax Rates section of this screen and click the first
field to edit the tax rate for a Taxable Item.

As we indicated earlier when we sketched our tax table prototype out, taxable
items have a tax rate of 1%. So type 1 in this field and press Tab to move into the
next field.

18) In the Non-taxable Item field, enter 0 as the tax rate. Your screen should look
like this when you are finished:

19) Click the State tab, then repeat Steps 10-16 for your second jurisdiction.

• In the Acct field, type in the number 2410.
• In the Taxable Customer field, enter 5 for the tax rate.
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• In the Taxable Item field, enter 5 for the tax rate.
• All other fields are identical to those in Jurisdiction #1, City.

Your screen should look like this when you are finished:

Since you had only two jurisdictions to set up, you are finished with defining the
jurisdictions for this tax group.

20) If you would like to double-check the tax rates you assigned for your item
categories, click the Item Rates tab.
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This screen is basically a series of rows and columns at the bottom part of the
screen. Note that the names of the two jurisdictions in your tax group (City,
State) now appear as column headings for the two tax rate columns on the
screen.

You will notice that this screen contains the same item tax rate information as
you enter previously in the Item Tax Rates sections of both the City and State
jurisdictions.

21) You can change any of the item tax rate information in this screen and your
changes will be reflected in each individual jurisdiction’s screen. But for the
purposes of this tutorial, we will leave the information displayed here as is, since
it is correct.

22) Now click the Customer Rates tab to confirm that the tax rates you assigned for
your customer categories are correct.

This table looks similar to the Item Rates screen. Note that the row headings are
the customer category headings you assigned in Steps 2 and 3. Again, you will
see that this screen contains the same customer tax rate information as you enter
previously in the Customer Tax Rates sections of both the City and State
jurisdictions.

23) Since this information is correct, do not make any changes to this screen.
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Opening Your Second Shop
Some time later you expand your business and open a shop in another city just across
a state line. In Tax Table terminology, you are establishing a new sales area, and
because of that, you need to establish an additional tax group.

Your new tax group will have two jurisdictions just like the first group. The first
jurisdiction, the city in which your new shop is located, levies a .5% sales tax on
taxable items. The second jurisdiction, the state, levies a 7% tax.

The new city and state both follow the same taxing rules as the two jurisdictions in
your existing tax group; the existing item and tax categories will work for the new
tax group as well as the first. Since the item and customer tax categories don’t need
to be changed, it won’t be necessary to use the Tax types option to set up the new
group. All of your work will be done using the Tax tables option.

Defining Your New Jurisdictions
1) Select Tax Tables from the Edit menu or click the Tax Tables button on the

Button Bar. The Edit Tax Groups screen appears:
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2) Click New to add your new group. Adagio Invoices opens up a new tax table
and selects the first (blank) jurisdiction tab for you:

3) Type GROUP2 in the Tax group field and press Tab to name your new group.
The highlight moves to the Description field.

4) Type Tax Group 2 in the Description field.

5) Click once in the Jurisdiction field to assign a name to your first jurisdiction for
this tax group. Type City 2 in this field.

6) Since we want to accept the default Minimum and Maximum values, you do not
need to edit these fields.

7) In the GL Acct field, type 2400. Since your shops do not use departments, leave
the GL Dept field blank.

8) Click the down arrow to the right of the Tax base field, and select Item Price
from the drop-down list that appears.

9) Leave the Taxable checkbox off.

10) In the Customer Tax Rates section of this screen, click once in the Taxable
Customer field and enter .5 as the tax rate for the Taxable Customer.

11) In the Item Tax Rates section of this screen, enter .5 as the tax rate for a Taxable
Item.
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Your screen should look like this when you are finished:

12) Click New to add your second jurisdiction.

Repeat Steps 5-10 for your second jurisdiction.

• In the Jurisdiction field, enter State 2.
• In the Acct field, type in the number 2410.
• In the Taxable Customer field, enter 7 for the tax rate.
• In the Taxable Item field, enter 7 for the tax rate.
• All other fields are identical to those in your first jurisdiction in this group,

City 2.
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Your screen should look like this when you are finished:

Since you had only two jurisdictions in this group, you are finished with the
jurisdictions section of the tax tables.

13) As we did before, you can check the Item and Customer tax rate information by
clicking these tabs. However, since we know the information is correct, we will
not view these screens.

14) Click OK to save your changes. Your new tax group will be saved and Adagio
Invoices will return you to the Edit Tax Groups screen. Click Close to exit this
function.

This completes the tax tables tutorial. However, if you want more detailed
information on tax tables, tax types, and how Adagio Invoices calculates taxes, see
the Adagio Fundamentals manual.
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Before Adagio Invoices assigns document numbers to regular or archived
documents, it checks the Increment options set on the Invoices / IC tab of the Adagio
Invoices Company Profile. Based on those settings, it assigns numbers according to
the following rules:

Increment Active Invoices checkbox turned on

• Has no affect on invoices archived to the archive system
• Has no affect on invoices copied within the archive system
• Assigns last # + 1 to invoices created in the Open Invoice Batches function
• Assigns last # + 1 to invoices copied in the Open Invoice Batches function
• Assigns last # + 1 to invoices restored from archive system

Increment Active Invoices checkbox turned off

• Has no affect on invoices archived to archive system
• Has no affect on invoices copied within archive system
• Assigns Default # to invoices created in the Open Invoice Batches function
• Assigns Default # to invoices copied in the Open Invoice Batches function
• Retains archived invoice number on invoices restored from archive system
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Increment Archived Invoices checkbox turned on

• Has no affect on invoices in the Open Invoice Batches function
• Has no affect on invoices copied within the archive system
• Assigns last archive # + 1 to invoices created in the archive system
• Assigns last archive # + 1 to invoices copied within archive system
• Assigns last archive # + 1 to invoices archived from the Open Invoice Batches

function

Increment Archived Invoices checkbox turned off

• Has no affect on invoices in the Open Invoice Batches function
• Has no affect on invoices copied in the Open Invoice Batches function
• Assigns Default # to invoices created in the archive system
• Assigns Default # to invoices copied within archive system
• Retains invoice number on invoices archived from the Open Invoice Batches

function

Notes

• You can reset invoice start number/invoice default number via the Next
number field under the Invoice numbers tab in the Company Profile.

• You can reset the archive invoice start number/archive invoice default
number via the Next number field under the Invoice numbers tab in the
Company Profile.

• You can edit an invoice number (generated or default) in the Totals Screen of
an invoice unless the Lock checkbox is turned on in the Company Profile.

• You can edit archive invoice number (generated or default) in the Totals
Screen of an invoice unless the Lock checkbox is turned on in the Company
Profile.



Interfacing with Adagio Inventory
Adagio Invoices interfaces with Adagio Inventory. Invoices and archive invoices can
be entered with both IC items and Adagio Invoices items or with only one or the
other. Quantities in Adagio Inventory are adjusted via the Import Shipments
function in IC.

If Adagio OrderEntry standalone (i.e. without Adagio Inventory
data) is used, this section in the Adagio Invoices Company Profile
will refer to OE Interface Options instead. As well, the 'Send to IC
Shipments' field becomes inactive.
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Interfacing with Inventory
There are fields on the Batch Entry tab of the Adagio Invoices Company Profile (see
page 3-28) that relate to Adagio Inventory.

If Adagio OrderEntry standalone (i.e. without Adagio Inventory data) is used, this
section in the Adagio Invoices Company Profile will refer to OE Interface Options
instead.

Field Description

Link to IC Turned off by default.

Prompt for Adagio
Invoices items

Turned on by default.

Include archive
quantity on
available

Turned on by default

Display Cost? The Display cost field allows the system
administrator to display or hide costs from users. If
you turn this option off, the Item cost field will not be
displayed in the invoice detail screen for Adagio
Inventory Items.

IC item style code Set to style code A by default.

Send to IC
shipments

Set to Reference by default. However, Document
number may be selected instead.

NOTE: If Adagio OrderEntry standalone (i.e. without
Adagio Inventory data) is used, this field will always be
inactive.

Default item type Set to Invoices by default.
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Please note the following:

• If IC data files are not present in the same directory with the same extension as
Adagio Invoices data files:

• The IC link cannot be turned on.
• Posting will not update the shipments.
• You will not be able to enter more IC items.

• When the IC link is turned off, the remaining fields in the IC Interface Options
section of the Adagio Invoices Company Profile will display their values but
cannot be edited. They are part of the parameters that Adagio Invoices needs
to print and post invoices containing IC items when there is no access to the
Inventory database.

Prompt for Adagio Invoices items

This field is only valid and can only be edited if the IC link is turned on. By default,
this field is turned on.

If Prompt for Adagio Invoices items is turned on, an Item Selection box will prompt
the user to choose a Adagio Invoices item or an Inventory Control item when
entering a line on an invoice or archive invoice.

• If Adagio Invoices item is selected, the Finder window accesses the Adagio
Invoices item list and displays only valid Adagio Invoices items.

• If Inventory Control item is selected, the Finder window accesses the IC item
list and displays only valid IC items.

If Prompt for Adagio Invoices items is turned off, only Adagio Inventory items can
be entered on an invoice or archive invoice. Invoices or archive invoices that were
entered with Adagio Invoices items before Prompt for Adagio Invoices items was
turned off can still be edited, printed and posted. New Adagio Invoices item lines
cannot be added.

Include archive quantity on available

This field is only valid and can only be edited if the IC link is turned on. By default,
this field is turned on.

When entering a location code for an IC item on an invoice or archive invoice,
Adagio Invoices displays the available quantity for that location.

If Include archive on available quantity? is turned on in the Company Profile (see
page 3-20), the Finder window for the Location field on the Invoice Item Template
screen will display the quantity On Invoice, the quantity On Archive, the quantity
On Hand and the quantity Available.
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Inventory Interface Page B-233



• On Invoice is calculated from all unposted invoices.
• On Archive is calculated from all archived invoices.
• On Hand is read from the Location file in Inventory Control.
• Available is calculated by subtracting On Invoice and On Archive from On

Hand.

If Include archive quantity on available is turned off, On Archive WILL be
displayed in the location scroll box but WON’T be included in the Available
calculation.

IC item style code

This field is only valid and can only be edited if the IC link has been turned on. The
default value for this field is style code A.

Adagio Invoices prints IC item numbers with their proper Inventory Control
formatting. In addition, there are certain information codes that only apply to IC
items. Because of these special considerations, IC items can only be printed using
one style code. If the Inventory Control default style code is changed after IC items
are entered on invoices or archived invoices, the IC items will have to be deleted
from the invoices and then re-entered to print correctly.

For more information about information and style codes, see the Adagio
Fundamentals manual.
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Entering IC Items on Invoices
To enter an IC item on an invoice or archive invoice, make sure the Link to IC has
been turned on in the Adagio Invoices Company Profile.

See Chapter 4 for detailed information about creating batches and
documents.

If the Prompt for Adagio Invoices items checkbox has been clicked on in the
Company Profile, when you attempt to add an item to an invoice a box will appear
with Adagio Invoices item and Inventory Control item as choices. Select Inventory
Control item from the box.

Alt+A and Alt+I can be used to quickly change the item code
between an Adagio Invoices item and an IC item, instead of using
the mouse.

Click the Finder button to select a valid item from the Finder window, or type in a
valid IC item number.

If the Prompt for Adagio Invoices items is turned off, no box will appear. Click the
Finder button to select an item from the Finder window, or type in a valid IC item
number.

Entering IC Items on Invoices
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The Active item flag in Adagio Inventory (versions 8.1B and higher)
is supported in Adagio Invoices. This means that you will be given
a warning if you enter an inactive item on an invoice or credit note
in Adagio Invoices.

Alerts entered for items in Adagio Inventory (or in the Edit | I/C
Items function of Adagio Invoices, as they are from the same data
source) will pop up whenever that item is added to an invoice or
credit note in Adagio Invoices.

When an IC item is entered, it is placed in the document with the following default
information:

Field Source of Default Value Overwrite

Item code *
Item description
Category
Location *
Items ordered
Unit of measure
Items shipped
Items backordered
Item date
Reference
Tax type
Acct/Dept *
Item cost *
Item price *

Extended price *
Price Adjustment
Total before tax
Item tax *

Total after tax
10 item text lines

Item code from IC
Item description from IC
Category code from IC
First valid location in IC
Adagio Invoices default is 1
Stocking Unit from IC
Adagio Invoices default is 1
Adagio Invoices default is 0
Adagio Invoices system date
Blank
Category default tax status in IC
Category Sales rev acct/dept in IC
Most recent cost in IC
Price from IC x Unit of measure conversion

rate
Items shipped x Item price
0.00 (always a percentage)
Extended price + Price adjustment
Based on the tax group, item and customer

tax type
Total before tax + Item tax
Item additional information from IC

N
N
Y
Y
Y
Y
Y
Y
Y
Y
Y
Y/N
Y
Y

Y
Y
Y
N

N
Y
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An example of an IC item template follows:

*Item code

• Adagio Invoices does not access the Alternate Item Number List in Inventory
Control.

*Location

• Allow inventory levels to be less than zero? flag

Adagio Invoices does not recognize the Allow inventory levels to be less than
zero? flag in Inventory Control’s Company Profile.

Although invoices can be posted and the I/C shipments import batch will be
updated, Inventory won't allow the batch to be imported if the flag is set to N
and if the imported quantities will cause a negative quantity on hand.

• If an item with no active location is selected, a message will appear to indicate
that the item is not available at the requested location and/or at any location.

IC items must be active in at least one location unless “Allow items at all
locations” has been turned on in the IC Company Profile.

Also, the location code on the invoice cannot be blank.
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*Acct/Dept

• The G/L Acct/Dept is taken from the Category Control Account Set revenue
account in Inventory Control.

• The G/L Acct/Dept can only be edited if the Display account information
and Edit account information checkboxes have been turned on in the Adagio
Invoices Company Profile. For more information about the Company Profile
settings, see Chapter 3.

*Item Cost

• The purpose of the item cost field is to display the item cost at the time the
invoice is entered and as a number that can be posted to Adagio Invoices’s
Historical Invoices function. It is not intended to be used for editing costs
that will be posted to IC, unless the item uses the user-defined costing method.

• Any adjustments or receipts made in IC after the invoice is entered but before
it is posted will not be reflected in the item cost when it is posted to Adagio
Invoices’s Historical Invoices function. The item cost must be checked and
edited if:

• Item price is based on Item cost.
• Item cost is printed on invoices.

• Adagio Invoices uses Most recent cost from Inventory Control as a default
except for items that have a standard costing method. For standard costing,
Adagio Invoices uses Standard cost as a default.

Regardless of what cost is entered or over written on the invoice and posted to
the IC Import shipments batch, Inventory Control uses the following costs
(determined by IC costing method) when posting shipments:

Average costing method - IC posts the Average cost

Standard costing method - IC posts the Standard cost

LIFO costing method - IC posts the Last in unit cost

FIFO costing method - IC posts the First in unit cost

USER DEFINED method - IC posts the cost in the Import
shipments batch

• The only time Inventory Control updates the most recent cost field with a cost
from the Import shipments batch is when the item uses the user-defined
costing method.
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*Item price

The item price is the selected Price from IC x Unit of measure conversion rate.
To print the Pricing unit price on the invoice, use the D47 information code.

• The Item price will default to the following:

• If the Invoice date is within the Item sale date range in Inventory
Control, the Sale price will be the default. If the Item date is to be
within the range but the Invoice date is not, place the item on the
Invoice, modify the date in the Item date field. Re-edit the item and
the Sale price will appear in the scroll box of available prices.

• The Sale price is only available in the scroll box if the Item or Invoice
date are within the Sale date range as set up for the item in IC.

• If the Sale date is not applicable and the pricing method for the item is
Quantity purchased, the default price will be based on the Items
shipped. If the pricing method is Customer (A to E), the default price
will be based on the customer type set up in Accounts Receivable.

• If the above are not applicable, the Base price will be used.
• Adagio Invoices allows the user to overwrite any price.
• When an item on an invoice is being re-edited, Adagio Invoices

checks the list of available prices. If the Item price is not on the list,
the cursor will default to Override. If Override is selected, the Item
price that is currently on the invoice will not be overwritten.

• Adagio Invoices does NOT access the Alternate Price List in Inventory
Control.

• Click the Pricing button on the IC item template to override the pricing or
select an alternate Price Level. When you do so, a dialog box similar to the
following appears:
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Select the Price Level you want by clicking it once and then clicking OK, or
select Override in the same manner if you want to override the existing IC
price information.

Adagio Invoices, does not include the ability to change the price
based on quantity ordered. For example, many businesses offer
discounts to customers who order large quantities of an item;
however, Adagio Invoices does not recalculate prices automatically
when quantity changes. It is important that you click the Pricing
button and set the price level manually if you use pricing by
quantity purchased; otherwise, the base price will be used.

*Extended price

• If Quantity to extend in the Adagio Invoices Company Profile is set to
Quantity shipped, then Extended price will default to Item shipped x Item
price.

• If Quantity to extend in the Adagio Invoices Company Profile is set to
Quantity ordered, then Extended price will default to Items ordered x Item
price.

• For more information about the Company Profile settings, see Chapter 3.

*Item tax

• The Item tax is calculated according to the Tax group in the invoice Bill To
screen. The tax will always be calculated using the lower of the Customer Tax
Type rate and the Item Tax Type rate.

• For more information about Tax tables and tax calculations, see the Tax tables
& Tax types section in Chapter 3.
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Document Printing
Adagio Invoices can print Adagio Invoices items and IC items on the same
document.

Each Adagio Invoices item can be assigned a different style code for various print
formats on the same document. All IC items must have the same style code as set up
in the Adagio Invoices Company Profile.

For more information about style codes and formatting documents, refer to the
online Help documentation within the Invoice Designer or the Adagio Fundamentals
manual.

When editing a specification to include Adagio Invoices items and Adagio Inventory
items on the same document, please note that the Adagio Invoices item code is six
characters wide and the Inventory Control item code up to 21 characters wide
(including formatting). Make sure that you accommodate these differences when
you are inserting IC items on a specification.

For more information about style codes, information codes, and formatting
documents, see the Adagio Fundamentals manual.

Posting to Accounts Receivable
Adagio Invoices posts Adagio Inventory item invoices, credit notes and retainage
invoices directly into Adagio Receivables the same way it posts Adagio Invoices item
documents. Batches do not have to be retrieved or imported. For more information
about posting Adagio Invoices invoices, see Chapter 4.

Posting Journal
Adagio Invoices puts the Adagio Inventory item Category code in the Distribution
code column of the Adagio Invoices Posting Journal. The Category code is read from
the invoice. The revenue Accounts/ Departments are also read from the invoice.
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Inventory Interface Page B-241



Posting to Adagio Inventory
Adagio Invoices updates Inventory Control using the Import shipments batch
(ICSBATCH) in Comma Separated Values (Delimited) format. The ICSBATCH file
will continue to be appended until it is imported into IC and purged.

The IC Transaction History report will also be updated from the ICSBATCH file if
Retain Transaction History? is set to Y in the Inventory Control Company Profile.
For more information about importing shipments batches and retaining transaction
history in Inventory Control, see the Inventory Control manual.

The ICSBATCH format does not allow invoices and credit notes in
the same document. Therefore, you must not include credit lines
(negative quantities) on invoices that contain IC items.

This file pertains to Adagio Inventory only and does not exist when
Adagio OrderEntry standalone is used.

Reference Field:
The invoice header reference field is posted to the ICSBATCH and will update the
Shipments audit list and the IC Transaction History report.

Item Cost:
As noted earlier, item costs are not posted to Inventory Control from Adagio
Invoices. Costs in Inventory Control are determined by receipts and costing
methods, not by shipments. The Item cost is written to the ICSBATCH file, but that
number is not imported by Inventory Control EXCEPT in the case of items using
user-defined costing.

Extended Price:
The Extended price (Item price x Quantity) is posted to the ICSBATCH file.
Although this amount is printed on the Shipments Audit List and the Transaction
History Report, it does not update any price fields in Inventory Control.

Quantity Shipped/Ordered and Unit of Measure:
Adagio Invoices writes the invoice Unit of measure and Quantity shipped to the
ICSBATCH file unless Quantity to extend in the Adagio Invoices Company Profile
is set to Quantity ordered. If the setting is Quantity ordered, then Adagio Invoices
writes Quantity ordered to the ICSBATCH file.
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The Quantities in the Inventory Control location file are not updated until the
Shipments batch is imported into IC and posted, and the Shipments Audit List is
printed and purged. The location is then updated with the quantity in the Stocking
unit of measure.

Inventory Control will reject the ICSBATCH file if:

• the location has been deleted,
• any IC Company Profile flags have been changed to make the location invalid

for an IC Item after an invoice has been entered or posted in Adagio Invoices
and before it has been imported into IC, or

• any item on any invoice causes the quantity on hand for the item to go below
zero when the “Allow inventory levels to be less than zero” flag is set to No in
the IC Company Profile.

Location:
Adagio Invoices writes the Location code as entered on an invoice to the ICSBATCH
file.
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Posting to History
Adagio Invoices posts all IC Item fields in the Invoice Item List screen to the Adagio
Invoices Historical Invoices function.

The item cost on the invoice is posted to Historical Invoices. This means the cost
stored in Historical Invoices and the COGS (Cost of Goods Sold) amounts in
Inventory Control are unlikely to match. This is a consideration if Crystal Reports for
Adagio or GridView are being used to report on the Item cost field in Adagio
Invoices Historical Invoices and the numbers are being compared to the costs in
Inventory Control.
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Creating Invoices

How can I access the department field when I try to edit an item on an invoice?

The department field is made available if the option for departments is selected in
the General Ledger and Accounts Receivable. You must also have turned the Edit
account information option on in the Adagio Invoices Company Profile.

How can I have subtotals on my invoice?

You would have to set up a subtotal template (under Edit | Items) by creating a line
item which is defined to print and clear subtotals every time it is inserted on the
invoice. The subtotal template (line item) would consist of a style code and some
description lines. To turn off the other item fields you would click the Options tab,
and in the Displayed Fields section of this screen, turn off all fields except for
Description. In the Clear Subtotals section of this screen, you would also select the
fields to clear after the subtotal by clicking all of the checkboxes in this section on.

How can I record a sales discount for an item on the invoice?

If you would like the discount to show for each item you sell, then you would edit
the item Adjustment type and Adjustment value fields for the percentage and
amount (under Items on the Edit menu). You would enter the amount as negative,
i.e. -33.33.

If you wish the change only for the invoice you are producing now, you would edit
the Price Adjustment field on the item you are inserting on the invoice. To have this
information print on the invoice, you would use the D19, Price adjustment (in
percent) and/or D20, Price adjustment (in dollars) information codes on your
specification.
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How can I add shaded column title bars to my specification?

Adagio Invoices has several tools which allow you to create a shaded title bar with a
columnar effect, like the following example:

To create this kind of effect, follow these steps:

1) Place the desired information codes on your specification page.

2) Add the necessary labels.

3) Make all codes and labels transparent by selecting each one, clicking the right
mouse button, selecting Size & Colors from the pop-up menu, and then clicking
the Transparent checkbox on.

4) Using the Shape button, insert a rectangle around all of the labels. Click the
rectangle to select it, then choose the Size & Colors option from the right mouse
button pop-up menu. In the dialog box that appears:

• Click the Transparent checkbox on.
• Select grey as your Foreground color.
• Enter the desired Border width and Color in the Border section.

Creating Invoices
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5) Repeat Step 4 again, this time inserting a rectangle that surrounds all of the
information codes. Make this rectangle transparent also, but select white as the
Foreground color. Use the same Border width and Color as in Step 4. You may
need to use the Arrow keys to ensure that the second rectangle correctly lines up
with the first.

6) Insert vertical lines to separate each “column” (the label on the first row, and the
information code on the second) of information.
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Posting Invoices

When I went into Accounts Receivable to retrieve the invoices I posted in Adagio Invoices, I
received the message, “There are no batches to retrieve in the given path.”

Adagio Invoices does not send a batch to Accounts Receivable. When you post a
batch of invoices in Adagio Invoices, it automatically updates the various Customer
accounts in Accounts Receivable.

What Description field and Reference field are sent to Adagio Receivable when posting?

You may choose from multiple fields which ones you want sent to the Adagio
Receivables' Description fields and Reference field. Make your selection in the
Adagio Invoices Company Profile.

How do you attach Adagio Invoices to Adagio JobCost?

The actual connection is in the Adagio Receivable Company Profile. If you have the
option Integrate with Job Costing (Y/N) set to Y in Adagio Receivables, you will be
see a box for the job number to be entered on the Header tab in the Adagio Invoices
document).
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Maintaining Archived Batches

How can I update my archived documents with some new information?

Select Items from the Edit menu, select the item you wish to update and modify the
necessary fields. Then, go to Update Archive Batches (on the Maintenance menu),
select the batch to be updated, and select the modified fields from the update list.
The last step is to click Process.

How can I restore only a few documents out of a large archived batch?

You can either restore each invoice individually or multi-select the invoices you want
restored using the Shift or Ctrl/click keys, rather than restoring the entire batch.

Printing Invoices

Why does Adagio Invoices print information on the wrong invoice?  The information is going to
the next invoice number.

You have placed a detail code in the header section of an invoice specification. It
should be in a detail section.

Why does each invoice that I print on my laser printer move down the page approximately .5
inch?

Laser printers normally leave a .5 inch margin at the edges of a page, so you may
need to edit the page size of the specification. In the Invoice Designer, select
Specification Options from the File menu and enter the desired page size in the
Paper type section of the Edit invoice options dialog box.

Maintaining Archived Batches
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Printing Reports

I printed the tax summary report and believe the information to be incorrect.

The tax summary report reports taxable amounts based on the following rules:

• If the Item and Customer are both taxable, then the taxable dollar amounts are
reported under the category of Taxes by Item, e.g. Taxes by Item - Status 0
(Taxable Item).

• If the Item and Customer are both non-taxable, then the taxable dollar
amounts are reported under the category of Taxes by Customer, e.g. Taxes by
Customer - Status 1 (Non-Taxable Customer).

• For all other combinations, the tax dollar amount is reported under the
category of the lower of the two, Item or Customer.

Printing Reports
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